### SIEMENS

**COMOS**

**Process 3D Integration Operation**

Operating Manual

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Trademarks</td>
</tr>
<tr>
<td>2</td>
<td>Plant Modeler</td>
</tr>
<tr>
<td>3</td>
<td>COMOS PDMS Integration</td>
</tr>
<tr>
<td>4</td>
<td>COMOS 3D viewing</td>
</tr>
<tr>
<td>5</td>
<td>COMOS NX - Routing Mechanical interface</td>
</tr>
<tr>
<td>6</td>
<td>References</td>
</tr>
</tbody>
</table>

11/2011
A5E03640097-02
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

**CAUTION**
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**NOTICE**
indicates that an unintended result or situation can occur if the relevant information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions.
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by © are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
ditions.
# Table of contents

1 Trademarks ......................................................................................................................................... 9

2 Plant Modeler .................................................................................................................................... 11
   2.1 Microstation publisher .................................................................................................................. 11
   2.2 Introduction .................................................................................................................................... 11
   2.3 Starting and shutting down Plant Modeler .................................................................................... 12
      2.3.1 Starting Plant Modeler in COMOS ........................................................................................ 12
      2.3.2 Starting Plant Modeler manually .......................................................................................... 12
      2.3.3 Shutting down Plant Modeler .................................................................................................. 14
   2.4 Structure of the user interface ........................................................................................................ 14
      2.4.1 Plant Modeler menus in MicroStation ..................................................................................... 14
      2.4.2 Plant Modeler toolbars in MicroStation .................................................................................. 15
   2.5 Connecting ..................................................................................................................................... 15
      2.5.1 Connecting Plant Modeler to COMOS .................................................................................... 15
      2.5.2 Disconnecting Plant Modeler from COMOS .......................................................................... 16
   2.6 Switching between the menus "Plant Modeler" and "Microstation" .............................................. 16
   2.7 Status help for user guidance .......................................................................................................... 17
   2.8 Placing equipment in Plant Modeler ............................................................................................... 17
   2.9 Assigning....................................................................................................................................... 18
      2.9.1 Assigning COMOS object to a cell ............................................................................................ 18
      2.9.2 Unassigning COMOS objects from cells ................................................................................. 19
   2.10 Navigating.................................................................................................................................... 20
      2.10.1 Navigating from cells to COMOS objects .............................................................................. 20
      2.10.2 Navigating from COMOS objects to cells .......................................................................... 21
   2.11 Pipe routing................................................................................................................................ 21
      2.11.1 Overview ............................................................................................................................... 21
      2.11.2 Manual routing ....................................................................................................................... 22
         2.11.2.1 Overview .......................................................................................................................... 22
         2.11.2.2 Manually routing a pipe branch ........................................................................................ 23
         2.11.2.3 Defining slopes for pipes ................................................................................................. 26
      2.11.3 Placing implementations ........................................................................................................ 27
         2.11.3.1 Overview .......................................................................................................................... 27
         2.11.3.2 Automatically implementing inline components .............................................................. 27
         2.11.3.3 Placing implemented objects subsequently ..................................................................... 28
         2.11.3.4 Implementing 3D components subsequently ................................................................... 28
      2.11.4 Automatic routing .................................................................................................................. 29
         2.11.4.1 Overview .......................................................................................................................... 29
         2.11.4.2 Automatically routing pipe branches .............................................................................. 30
      2.11.5 Routing without P&ID information .......................................................................................... 30
   2.12 Placing pipe hangers ..................................................................................................................... 31

3D Integration Operation
Operating Manual, 11/2011, A5E03640097-02
## Table of contents

2.13 Using a user-defined cell as a marker for hangers .......................................................... 32
2.14 Placing components from the "Placeable objects" toolbar ........................................... 33
2.15 Placing a pipe as a branch ............................................................................................... 34
2.16 Carrying out routing with HVAC components .................................................................. 35
2.17 Place HVAC component ................................................................................................. 35
2.18 Status comparison and update .......................................................................................... 36
2.18.1 Status comparison ......................................................................................................... 36
2.18.2 Performing a status check in COMOS ......................................................................... 38
2.18.3 Displaying the status in Plant Modeler ......................................................................... 39
2.18.4 Eliminating inconsistencies ............................................................................................ 39
2.18.5 Updating the labelling .................................................................................................... 40
2.19 More possible actions in the "Change/Information" toolbar ........................................... 41
2.19.1 Retrieving object information ....................................................................................... 41
2.19.2 Selecting multiple cells in the same pipe branch ......................................................... 41
2.19.3 Resetting components .................................................................................................... 42
2.19.4 Moving components ...................................................................................................... 43
2.19.5 Splitting pipe routes ...................................................................................................... 44
2.19.6 Closing gaps between pipes .......................................................................................... 45
2.19.7 Connecting components ............................................................................................... 46
2.19.8 Dissolving connections between components ............................................................... 46
2.20 Files referenced ................................................................................................................ 47
2.20.1 Moving cells into the referenced file ............................................................................ 47
2.20.2 Deleting a referenced file .............................................................................................. 47
2.20.3 Processing referenced cells ........................................................................................... 48
2.21 Insulation .......................................................................................................................... 48
2.21.1 Creating insulation ........................................................................................................ 48
2.21.2 Changing insulation ....................................................................................................... 49
2.21.3 Disconnecting insulation ............................................................................................. 50
2.21.4 Deleting insulation ....................................................................................................... 50
2.21.5 Moving insulation ........................................................................................................ 51
2.21.6 Stretching insulation .................................................................................................... 51
2.22 Change management ......................................................................................................... 52
2.22.1 Changing PipeSpec or nominal diameter ................................................................... 52
2.22.2 Calculate status .............................................................................................................. 54
2.23 Cell management .............................................................................................................. 54
2.23.1 "Cell library" and "Cell" toolbars ................................................................................ 54
2.23.2 Settings for attribute information and connectors ..................................................... 54
2.23.3 Creating attribute information in the cell library ....................................................... 55
2.23.4 Creating attribute information for placed cells ......................................................... 56
2.23.5 Creating connectors for cells ........................................................................................ 57
2.23.6 Calling connector information of a cell ...................................................................... 58
2.23.7 Changing the properties of a connector ....................................................................... 58
2.23.8 Deleting the connectors of a cell .................................................................................. 60
2.23.9 Special case: Mapping connectors in COMOS ............................................................. 61
2.24 Accessing tools via keyboard inputs ................................................................................ 62
2.25 Deleting and restoring ...................................................................................................... 64
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.26 Automatic generation of isometric drawings</td>
<td>64</td>
</tr>
<tr>
<td>2.26.1 Automatically generating interactive reports for isometric drawings</td>
<td>64</td>
</tr>
<tr>
<td>2.26.2 Drive display</td>
<td>65</td>
</tr>
<tr>
<td>2.27 Locking objects</td>
<td>65</td>
</tr>
<tr>
<td>2.27.1 Basics</td>
<td>65</td>
</tr>
<tr>
<td>2.27.2 Locking objects for processing</td>
<td>65</td>
</tr>
<tr>
<td>2.28 Document management in the Plant Modeler</td>
<td>66</td>
</tr>
<tr>
<td>2.28.1 Basics about document management in the Plant Modeler</td>
<td>66</td>
</tr>
<tr>
<td>2.28.2 Displaying the &quot;Document management&quot; window</td>
<td>67</td>
</tr>
<tr>
<td>2.28.3 Status of the documents</td>
<td>67</td>
</tr>
<tr>
<td>2.28.4 Checking out a document</td>
<td>68</td>
</tr>
<tr>
<td>2.28.5 Displaying documents</td>
<td>68</td>
</tr>
<tr>
<td>2.28.6 Activating a document for editing</td>
<td>69</td>
</tr>
<tr>
<td>2.28.7 Checking in a document</td>
<td>70</td>
</tr>
<tr>
<td>2.28.8 Saving the view of the &quot;Document management&quot; window</td>
<td>71</td>
</tr>
<tr>
<td>2.28.9 Loading the view of the &quot;Document management&quot; window</td>
<td>71</td>
</tr>
<tr>
<td>2.28.10 Ending document management</td>
<td>72</td>
</tr>
<tr>
<td>3 COMOS PDMS Integration</td>
<td>73</td>
</tr>
<tr>
<td>3.1 General</td>
<td>73</td>
</tr>
<tr>
<td>3.2 Requirements</td>
<td>74</td>
</tr>
<tr>
<td>3.3 Activating COMOS PDMS Integration for PDMS</td>
<td>75</td>
</tr>
<tr>
<td>3.4 Operating mode</td>
<td>77</td>
</tr>
<tr>
<td>3.5 Using interface operations</td>
<td>77</td>
</tr>
<tr>
<td>3.5.1 Calling an interface operation</td>
<td>78</td>
</tr>
<tr>
<td>3.5.2 Creating selection sets</td>
<td>79</td>
</tr>
<tr>
<td>3.5.2.1 Concept of the selection set</td>
<td>79</td>
</tr>
<tr>
<td>3.5.2.2 Selection set for interface operations started in COMOS</td>
<td>80</td>
</tr>
<tr>
<td>3.5.2.3 Selection set for in PDMS started interface operations</td>
<td>84</td>
</tr>
<tr>
<td>3.5.3 Interface operations in COMOS</td>
<td>85</td>
</tr>
<tr>
<td>3.5.3.1 &quot;Export&quot; operation</td>
<td>85</td>
</tr>
<tr>
<td>3.5.3.2 &quot;Refresh&quot; operation</td>
<td>90</td>
</tr>
<tr>
<td>3.5.3.3 &quot;Custom Refresh&quot; operation</td>
<td>91</td>
</tr>
<tr>
<td>3.5.3.4 &quot;Assign&quot; operation</td>
<td>92</td>
</tr>
<tr>
<td>3.5.3.5 &quot;Unassign&quot; operation</td>
<td>97</td>
</tr>
<tr>
<td>3.5.3.6 &quot;Check status&quot; operation</td>
<td>99</td>
</tr>
<tr>
<td>3.5.3.7 &quot;TopologyCheck&quot; operation</td>
<td>102</td>
</tr>
<tr>
<td>3.5.3.8 &quot;Rerun documents&quot; operation</td>
<td>104</td>
</tr>
<tr>
<td>3.5.3.9 3D view operations</td>
<td>105</td>
</tr>
<tr>
<td>3.5.3.10 &quot;Add&quot; operation</td>
<td>106</td>
</tr>
<tr>
<td>3.5.3.11 &quot;Remove&quot; operation</td>
<td>107</td>
</tr>
<tr>
<td>3.5.3.12 &quot;Mark&quot; operation</td>
<td>108</td>
</tr>
<tr>
<td>3.5.3.13 &quot;Zoom&quot; operation</td>
<td>109</td>
</tr>
<tr>
<td>3.5.3.14 &quot;Select&quot; operation</td>
<td>110</td>
</tr>
<tr>
<td>3.5.4 PDMS: &quot;Export to COMOS&quot; window</td>
<td>112</td>
</tr>
<tr>
<td>3.5.4.1 Working in the &quot;Export to Comos&quot; window</td>
<td>112</td>
</tr>
<tr>
<td>3.5.4.2 Configuring the &quot;Export to Comos&quot; window</td>
<td>115</td>
</tr>
<tr>
<td>3.5.5 PDMS: &quot;COMOS query&quot; window</td>
<td>117</td>
</tr>
<tr>
<td>3.5.5.1 Configuring the &quot;Query Comos&quot; window</td>
<td>117</td>
</tr>
</tbody>
</table>
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.5.5.2 Defining filters</td>
<td>117</td>
</tr>
<tr>
<td>3.5.5.3 Executing the COMOS query</td>
<td>118</td>
</tr>
<tr>
<td>3.5.6 PDMS-side interface operations</td>
<td>118</td>
</tr>
<tr>
<td>3.5.6.1 Operations on the current element</td>
<td>118</td>
</tr>
<tr>
<td>3.5.6.2 &quot;Navigate&quot; operation</td>
<td>118</td>
</tr>
<tr>
<td>3.5.6.3 &quot;Unassign&quot; operation at the CE</td>
<td>119</td>
</tr>
<tr>
<td>3.5.6.4 &quot;Reassign&quot; operation</td>
<td>120</td>
</tr>
<tr>
<td>3.5.6.5 Operations that are called in the &quot;Export to Comos&quot; window</td>
<td>121</td>
</tr>
<tr>
<td>3.5.6.6 &quot;Export&quot; operation</td>
<td>122</td>
</tr>
<tr>
<td>3.5.6.7 The &quot;Unassign&quot; operation in the &quot;Export to CE&quot; window</td>
<td>123</td>
</tr>
<tr>
<td>3.5.6.8 &quot;Check status&quot; operation</td>
<td>124</td>
</tr>
<tr>
<td>3.5.6.9 &quot;Query COMOS data&quot; operation</td>
<td>125</td>
</tr>
<tr>
<td>3.5.6.10 &quot;Import DocLinks&quot; operation</td>
<td>127</td>
</tr>
<tr>
<td>3.5.7 The Construction assistant</td>
<td>130</td>
</tr>
<tr>
<td>3.5.7.1 Starting the Construction assistant and opening</td>
<td>131</td>
</tr>
<tr>
<td>3.5.7.2 Overview: Components of the Construction assistant</td>
<td>131</td>
</tr>
<tr>
<td>3.5.7.3 The Documents area</td>
<td>131</td>
</tr>
<tr>
<td>3.5.7.4 Status information</td>
<td>132</td>
</tr>
<tr>
<td>3.5.7.5 Context menus</td>
<td>132</td>
</tr>
<tr>
<td>3.6 Using Cats&amp;Specs</td>
<td>133</td>
</tr>
<tr>
<td>3.6.1 PipeSpecs</td>
<td>133</td>
</tr>
<tr>
<td>3.6.1.1 General</td>
<td>133</td>
</tr>
<tr>
<td>3.6.1.2 Selectors</td>
<td>134</td>
</tr>
<tr>
<td>3.6.2 PipeSpec Designer</td>
<td>136</td>
</tr>
<tr>
<td>3.6.2.1 Characteristics of PDMS PipeSpecs</td>
<td>136</td>
</tr>
<tr>
<td>3.6.2.2 Creating a new PDMS PipeSpec</td>
<td>136</td>
</tr>
<tr>
<td>3.6.2.3 Adding Pipe Part Components to the PDMS PipeSpec</td>
<td>137</td>
</tr>
<tr>
<td>3.6.2.4 Tab &quot;Selector&quot;</td>
<td>138</td>
</tr>
<tr>
<td>3.6.2.5 Creating new selectors</td>
<td>139</td>
</tr>
<tr>
<td>3.6.2.6 Detail area</td>
<td>140</td>
</tr>
<tr>
<td>3.6.3 Working in the PDMS interface</td>
<td>140</td>
</tr>
<tr>
<td>3.6.3.1 General</td>
<td>140</td>
</tr>
<tr>
<td>3.6.3.2 Replacing pipe part information</td>
<td>141</td>
</tr>
<tr>
<td>3.6.3.3 Comparing pipe part catalog elements</td>
<td>142</td>
</tr>
<tr>
<td>3.6.3.4 Exporting a pipe part catalog element</td>
<td>142</td>
</tr>
<tr>
<td>3.6.3.5 Reading in pipe part information</td>
<td>142</td>
</tr>
<tr>
<td>3.6.3.6 &quot;Pipe specs&quot; tab</td>
<td>144</td>
</tr>
<tr>
<td>3.6.3.7 Reading in PipeSpecs and PipeSpecs elements</td>
<td>145</td>
</tr>
<tr>
<td>3.6.3.8 Display PipeSpecs</td>
<td>145</td>
</tr>
<tr>
<td>3.6.3.9 Filter PipeSpecs</td>
<td>147</td>
</tr>
<tr>
<td>3.6.3.10 Exporting PipeSpecs and PipeSpecs elements</td>
<td>148</td>
</tr>
<tr>
<td>3.6.3.11 &quot;PDMSInfo for pipe spec&quot; tab</td>
<td>149</td>
</tr>
<tr>
<td>3.6.3.12 Options</td>
<td>150</td>
</tr>
<tr>
<td>3.6.4 COMOS menu in the PDMS Paragon module</td>
<td>150</td>
</tr>
<tr>
<td>3.6.4.1 General</td>
<td>150</td>
</tr>
<tr>
<td>3.6.4.2 Functions in the &quot;Comos&quot; menu</td>
<td>151</td>
</tr>
<tr>
<td>3.6.4.3 Export settings</td>
<td>151</td>
</tr>
<tr>
<td>3.6.4.4 Monitoring the log entries</td>
<td>152</td>
</tr>
<tr>
<td>3.6.5 Import from PDMS to COMOS</td>
<td>153</td>
</tr>
<tr>
<td>3.6.5.1 General</td>
<td>153</td>
</tr>
<tr>
<td>3.6.5.2 Creating a PDMS PipeSpec</td>
<td>153</td>
</tr>
<tr>
<td>3.6.5.3 Importing catalog data</td>
<td>156</td>
</tr>
</tbody>
</table>
# Table of contents

3.6.5.4 Creating COMOS pipe specs and PPC objects ........................................................................ 157
3.7 Material management .................................................................................................................. 158

4 COMOS 3D viewing ....................................................................................................................... 159
  4.1 Overview .................................................................................................................................. 159
  4.2 Navigating ................................................................................................................................ 159
  4.2.1 From COMOS to the 3D viewer application ........................................................................... 159
  4.2.2 From the 3D viewer application to COMOS ........................................................................... 159
  4.3 "Comos Document View" window .............................................................................................. 160

5 COMOS NX - Routing Mechanical interface ................................................................................ 161
  5.1 Overview .................................................................................................................................. 161
  5.2 Starting and ending NX Schematics ............................................................................................ 161
  5.3 Status message in NX ............................................................................................................... 162
  5.4 Assigning .................................................................................................................................. 162
  5.4.1 Assigning a COMOS object to the NX object ......................................................................... 162
  5.4.2 Canceling an assignment ...................................................................................................... 163
  5.5 Navigating ................................................................................................................................ 163
  5.5.1 From the COMOS object to the NX object ............................................................................ 163
  5.5.2 From the NX object to the COMOS object ........................................................................... 164
  5.6 Routing ................................................................................................................................... 164
  5.6.1 Routing from COMOS to NX .................................................................................................. 164
  5.6.2 "Run Navigator" NX tab ......................................................................................................... 164
  5.6.2.1 Purpose .............................................................................................................................. 165
  5.6.2.2 Displaying information about a particular device tag .................................................... 165

6 References .................................................................................................................................... 167
  6.1 Plant Modeler ............................................................................................................................. 167
  6.1.1 User interface reference ......................................................................................................... 167
  6.1.1.1 Buttons on the "Pipe construction" toolbar ........................................................................ 167
  6.1.1.2 Buttons on the "Placeable objects" toolbar ......................................................................... 167
  6.1.1.3 Buttons on the "Change/Information" toolbar ................................................................... 169
  6.1.1.4 Buttons on the "Insulation" toolbar .................................................................................... 169
  6.1.1.5 Buttons on the "References" toolbar .................................................................................. 170
  6.1.1.6 Buttons on the "Change management" toolbar ................................................................. 170
  6.1.1.7 Buttons on the "Cell management" toolbar ......................................................................... 170
  6.1.1.8 "Plant Modeler" context menu .......................................................................................... 171
  6.1.1.9 Control elements on the "Plant Modeler" tab ................................................................ ...... 172
  6.1.1.10 "Pipe settings" window ..................................................................................................... 174
  6.1.1.11 "Center line routing" window ............................................................................................ 175
  6.1.1.12 "Place component" window .............................................................................................. 176
  6.1.1.13 "Object attributes" window ................................................................................................ 177
  6.1.1.14 "Object picker" window ..................................................................................................... 177
  6.1.1.15 "Create Connector" window .............................................................................................. 178
  6.1.1.16 "Select owner" window ..................................................................................................... 178
  6.1.2 Reference via keyboard inputs ............................................................................................. 180
  6.1.2.1 List of keyboard inputs ...................................................................................................... 180
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.2</td>
<td>COMOS PDMS Integration</td>
<td>181</td>
</tr>
<tr>
<td>6.2.1</td>
<td>User interface reference</td>
<td>181</td>
</tr>
<tr>
<td>6.2.1.1</td>
<td>&quot;Comos Custom Refresh&quot; PDMS window</td>
<td>181</td>
</tr>
<tr>
<td>6.2.1.2</td>
<td>&quot;Export to COMOS&quot; PDMS window</td>
<td>182</td>
</tr>
<tr>
<td>6.2.1.3</td>
<td>&quot;Query COMOS&quot; PDMS window</td>
<td>184</td>
</tr>
<tr>
<td>6.2.1.4</td>
<td>&quot;External 3D Interface&quot; tab</td>
<td>188</td>
</tr>
<tr>
<td>6.2.1.5</td>
<td>&quot;Selector&quot; tab</td>
<td>189</td>
</tr>
<tr>
<td>6.2.1.6</td>
<td>Construction assistant: Upper area</td>
<td>190</td>
</tr>
<tr>
<td>6.2.1.7</td>
<td>Options</td>
<td>191</td>
</tr>
<tr>
<td>6.2.2</td>
<td>List of interface operations and internal names</td>
<td>194</td>
</tr>
</tbody>
</table>
Trademarks

Registered trademark: COMOS®
2.1 Microstation publisher

The CAD software product MicroStation is a product of the Bentley Systems company and will hereafter be referred to simply as MicroStation.

2.2 Introduction

COMOS Plant Modeler module

COMOS Plant Modeler is an add-in for the CAD software product MicroStation which establishes a bidirectional interface between COMOS and MicroStation.

The aim of Plant Modeler is to enable COMOS to be used as a central integration platform for plant engineering in 3D detail and to provide a transition between P&ID engineering, 3D piping and layout engineering, and isometric drawings.

This allows you to use the P&IDs you create in COMOS as a basis for transferring your engineering data to MicroStation. By using Plant Modeler, you can create 3D piping and layout plans and make section models. In both applications, you use PipeSpecs that are defined in COMOS.

The handling and 3D display of the layout planning come from MicroStation, but are enhanced by Plant Modeler tools. The pipe routing is handled by COMOS.

The data stocks of both applications are interconnected and are updated automatically from MicroStation to COMOS as long the connection exists. You can detect and correct any inconsistencies arising from an interrupted connection between applications by performing a status comparison.

Once you have finished your piping planning, you can generate a complete isometric drawing based on the 3D model in COMOS.

Administrative activities

The following administrative activities are conducted in COMOS:

- Administration of PipeSpecs and pipe part catalogs
- Generation of Material Lists (MTOs), Bill of Materials (BOMs), and other documents that are relevant for 3D detail planning
- Status management
- Depending on the used license: Other functions, such as document management functions
Prerequisite

In order to properly understand this document, you must have experience in the operation of MicroStation.

2.3 Starting and shutting down Plant Modeler

2.3.1 Starting Plant Modeler in COMOS

Prerequisite

- COMOS Plant Modeler is installed.
- The project properties in the "Document management settings" and "Microstation settings" control groups are configured on the "Plant Modeler" tab.

Procedure

In order to start Plant Modeler, proceed as follows:
1. Open COMOS.
2. Open the desired project.
3. Select any object on the "Units" tab in the Navigator.
4. From the context menu, select the "Plant Modeler > Start Plant Modeler" command.

Result

Plant Modeler is automatically connected to COMOS and ready for use.

2.3.2 Starting Plant Modeler manually

Introduction

If you want to start the Plant Modeler manually, use the file "COMOSPlantModeler.V8i.dll" in the installation directory of MicroStation. You defined this folder during the installation. The "COMOSPlantModeler.V8i.dll" file is usually located in the "C:\Program Files\Bentley\...\mdlapps" folder.

Prerequisite

You know which directory contains the "COMOSPlantModeler.V8i.dll" file.
Procedure

In order to manually start the component of the Plant Modeler, proceed as follows:

1. Start COMOS.
2. Open the desired project.
3. Start MicroStation V8i.
4. Before you open the DGN file, open the "comosplantmodeler" entry from the "Interface" list in the "Open file" window.
5. On the MicroStation menu bar, click on "Extras > MDL Applications".
6. In the "MDL" window, click the "Browse" button.
   The "Select MDL Application" window is displayed.
7. Select the folder that contains the "ComosPlantModeler.V8i.dll" file.
8. Select the "COMOSPlantModeler.V8i.dll" file.
9. Click the "Open" button.

Result

Plant Modeler is loaded. The menus of the Plant Modeler are displayed in MicroStation.

Alternative procedure

To start Plant Modeler via the alternative method, proceed as follows:

1. Before you open the DGN file, open the "comosplantmodeler" entry from the "Interface" list in the "Open file" window.
2. In MicroStation, click on the "Utilities > Key-in" menu.
   The "Input" window opens.
3. In the "Input" window field, enter the "mdl load ComosPlantModeler.V8i.dll" command.

Note

If you have installed the DLL file in another directory, enter the path to this directory.

4. Press the <Enter> key to confirm the command.

Result

MicroStation searches for the "COMOSPlantModeler.V8i.dll" file in the MicroStation "mdlapps" directory or in the directory you specified. Plant Modeler is loaded. The menus of the Plant Modeler are displayed in MicroStation. COMOS and MicroStation are not connected automatically.
2.4 Structure of the user interface

2.4.1 Plant Modeler menus in MicroStation

Overview

The following table describes the COMOS Plant Modeler menus that are displayed in MicroStation.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;COMOS Plant Modeler&quot;</td>
<td>This menu controls the Plant Modeler and contains, among other things, the</td>
</tr>
<tr>
<td></td>
<td>toolbar for pipe components.</td>
</tr>
<tr>
<td>&quot;Applications*&quot;</td>
<td>This menu allows you to toggle between the MicroStation menu bar and the</td>
</tr>
<tr>
<td></td>
<td>Plant Modeler menu bar.</td>
</tr>
</tbody>
</table>

See also

Switching between the menus "Plant Modeler" and "Microstation" (Page 16)
Plant Modeler toolbars in MicroStation (Page 15)
"Plant Modeler" context menu (Page 171)
2.4.2 Plant Modeler toolbars in MicroStation

Overview
The individual Plant Modeler toolbars in MicroStation are located on the left-hand side, under "Tasks". "COMOS Plant Modeler" must be selected in this part of the window. To expand the required toolbar, click on the button. To collapse the toolbar, click on the button.

The toolbars must be displayed in the list view. The descriptive texts for the tools are only displayed in this mode.

See also
- Buttons on the "Pipe construction" toolbar (Page 167)
- Buttons on the "Placeable objects" toolbar (Page 167)
- Buttons on the "Change/Information" toolbar (Page 169)
- Buttons on the "Cell management" toolbar (Page 170)
- Buttons on the "Insulation" toolbar (Page 169)
- Buttons on the "References" toolbar (Page 170)
- Buttons on the "Change management" toolbar (Page 170)

2.5 Connecting

2.5.1 Connecting Plant Modeler to COMOS

Prerequisite
Plant Modeler and COMOS are not connected. You have already started COMOS and opened a project. You have started Plant Modeler.

Procedure
To connect Plant Modeler to COMOS, click on the "COMOS Plant Modeler > Connect to COMOS" menu.
2.6 Switching between the menus "Plant Modeler" and "Microstation"

Result

Plant Modeler is connected to the project you opened in COMOS. In the "COMOS Plant Modeler" menu, the "Disconnect from COMOS" command is enabled.

Note

Working with multiple instances

Always open only one instance of MicroStation and COMOS.

2.5.2 Disconnecting Plant Modeler from COMOS

Prerequisite

Plant Modeler and COMOS are connected.

Procedure

To break the connection between Plant Modeler and COMOS, click on the "COMOS Plant Modeler > Disconnect from COMOS" menu.

Result

Plant Modeler is now disconnected from COMOS. In the "COMOS Plant Modeler" menu, the "Connect to COMOS" entry is enabled.

2.6 Switching between the menus "Plant Modeler" and "Microstation"

Prerequisite

COMOS Plant Modeler is started.

Procedure

Select one of the following options to switch between the "Plant Modeler" and "MicroStation" menus:

- If you are in MicroStation and want to switch to Plant Modeler, click on the "Applications > COMOS Plant Modeler" menu.
- If you are in Plant Modeler and want to switch to MicroStation, click on the "Applications > MicroStation" menu.
2.7 Status help for user guidance

Plant Modeler tools

As soon as you have selected a tool in Plant Modeler, a status help telling you how to use the tool is displayed at the bottom left of the application window. Status help is structured as follows:

<Name of tool> > <action triggered by left-clicking> / <action triggered by right-clicking>

Once you have completed the current step, the next step is automatically displayed in the status help.

Example

If you have selected the "Create Connector" tool, the following instruction for the first sub-step is shown in the status help:

Once you have executed the first step, here teh selection of an object via a mouse click, the instruction for the second step is displayed.

2.8 Placing equipment in Plant Modeler

Overview

Completing the P&ID planning. In Plant Modeler, place the equipment specified in the P&ID planning. Do this, for example, by using the cells included in the "COMOSPlantModelerDemo.cel" cell library and follow the same procedure as you are used to in MicroStation.
2.9 Assigning

2.9.1 Assigning COMOS object to a cell

All cells placed in MicroStation which you wish to use for processing purposes in Plant Modeler must be connected to their counterparts in COMOS. The connections to the vessels are represented by the placed nozzles.
### Procedure

To assign a cell to a COMOS object, proceed as follows:

1. In COMOS, select the desired object either on the P&ID or in the Navigator.
2. Right-click the selected object.
3. In the context menu, click "Plant Modeler > Assign".
4. Switch to Plant Modeler.
5. Select the corresponding cell. The cell must be a Plant Modeler cell. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Cell library and placed cells".

### Result

The cell and the COMOS object are assigned to one another.

In COMOS, a 3D object is created underneath the object in the Navigator.

When you move the mouse pointer over the cell in Plant Modeler, the path to the linked COMOS object is displayed as a tooltip.

The 3D data is exchanged with one another across applications. You now have the option to navigate from MicroStation to the COMOS object and vice versa.

### See also

- Navigating from cells to COMOS objects (Page 20)
- Navigating from COMOS objects to cells (Page 21)

### 2.9.2 Unassigning COMOS objects from cells

#### Prerequisite

The COMOS object and the cell are assigned to one another.

#### Procedure

To unassign a COMOS object from a cell, proceed as follows:

1. In COMOS, select the desired object either on the P&ID or in the Navigator.
2. Right-click the selected object.
3. In the context menu click "Plant Modeler > Unassign".

#### Result

The 3D object is moved underneath the node specified as the default location in the project properties. The 3D object is no longer displayed in the Navigator.
You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Project properties: Setting the default location for pipes and equipment".

Alternative procedure

Alternatively, you can remove the assignment from the 3D application by using the "Reset" button. You can find more information about this topic under Resetting components (Page 42).

2.10 Navigating

2.10.1 Navigating from cells to COMOS objects

Prerequisite

The COMOS object and the cell are assigned to one another.

Procedure

To navigate from the cell to the assigned COMOS object, proceed as follows:

1. Expand the "Change/Information" toolbar in Plant Modeler.
2. Click on the "Navigate to COMOS" tool.
   The "Navigate..." window opens.
3. Select one of the following options:
   - If you want to navigate to the object in the Navigator, select the "COMOS object" option.
   - If you want to navigate to the object on the P&ID, select the "P&ID object" option.
4. Click the desired cell.
5. Switch to COMOS.

Result

If you selected the "COMOS object" option, the corresponding object is highlighted in the Navigator.

If you selected the "P&ID object" option, the corresponding object is highlighted in the Navigator.
2.10.2 Navigating from COMOS objects to cells

Prerequisite
The COMOS object and the cell are assigned to one another.

Procedure
To navigate from a COMOS object to a cell in MicroStation, proceed as follows:
1. In COMOS, right-click the desired object in the Navigator or on the P&ID.
2. In the context menu click on "Plant Modeler > Navigate".

Result
The assigned cell is displayed in Plant Modeler. If you have selected a pipe branch in
COMOS, all pipes, elbows, flanges, and reducers associated with that pipe branch are
highlighted and displayed zoomed-in in Plant Modeler.

The pipe branch is the P&ID object for these cells. Since valves are an own P&ID object,
they are not marked in this case.

2.11 Pipe routing

2.11.1 Overview
Routing always takes place based on the pipe spec. This means that the cells you generate
by routing in the MicroStation always originate from the same pipe spec for pipes and inline
pipe components. You always use the preselected components of the class set for the
routing.

The preselected components are predefined in the pipe spec. You do not usually make any
changes here, unless other preselected components are to be used in the current session.
See also chapter Changing PipeSpec or nominal diameter (Page 52).

Routing is conducted in sections, from equipment item to equipment item.

Example
Routing takes place from the nozzle of a vessel to the inlet of a pump and from the outlet of
the pump to the nozzle of a second vessel.
Routing types

You can choose to route pipes manually or automatically.

The pipe route is calculated in COMOS. The 3D geometry of the pipe route also comes from COMOS.

In both manual and automatic routing, you can always undo the last design step.

See also

- Automatic routing (Page 29)
- Manual routing (Page 22)

2.11.2 Manual routing

2.11.2.1 Overview

**Manual routing workflow**

In manual routing, you define the center line of the pipe route between two connectors. The MicroStation AccuDraw and AccuSnap functions are available as construction aids.

You can choose whether to use the pipe spec settings from COMOS P&ID for the 3D pipes to be generated or whether to specify user-defined variations.

If you have placed inline components on the pipe branch to be routed on the P&ID in COMOS, you can place these inline components automatically in the 3D model once you have specified the starting connector. In Plant Modeler, a dialog is displayed for this purpose in which all the 3D components still to be placed for this pipe are listed. These can then be inserted sequentially into the model during routing.

See also

- Placing implementations (Page 27)
2.11.2.2 Manually routing a pipe branch

Prerequisite

- You have conducted a pipe spec mapping for the inline components in COMOS. The 3D implementations are then available.
- You have defined a pipe spec and the nominal diameter.
  
  For this you have the following options:
  
  - Select a list entry in the "Pipe settings" window
    See also chapter "Pipe settings" window (Page 174).
  
  - In the "Object picker" window, apply the pipe spec and nominal diameter of an existing pipe
    See also chapter "Object picker" window (Page 177).

Procedure

To manually route a pipe branch, proceed as follows:

1. Expand the "Pipe construction" toolbar in Plant Modeler.
2. Click on the "Center line routing" tool.
   The "Centerline routing" window opens.
3. Move the mouse pointer over the 3D model.
   As soon as you touch a connector in a cell, the cell is highlighted. If you touch a point in the cell for which no connector is defined, you will see the following symbol: ☞
4. Click the desired connector.
   The pipe settings from COMOS are read out. Information is displayed in the "Implementation Objects" field. The content of the "Centerline routing" window is expanded. You can insert inline components that are available on the P&ID in COMOS but are not in Plant Modeler.
5. Specify the pipe route by using data points to define the required location in space. You can define as many intermediate points as you wish. The pipe can also end in an empty space. You can continue drawing and complete it at a later time.

6. If you do not want to apply the default settings from COMOS, change the pipe spec and the nominal diameter, if applicable, in the "Pipe settings" window. Make sure that the "User-defined PipeSpec" option is enabled.

7. If you want to use insulation, enable the "Use insulation" option in the "Pipe Settings" window and select the required insulation and thickness. You can only use insulations if the selected pipe spec has an insulation class as a pipe spec component and if you are using user-defined settings for routing purposes.

8. If applicable, implement the inline components displayed in the "Centerline routing" window in the pipe route. See also chapter Placing implementations (Page 27).

9. Click the desired connector.

The centerline only snaps at the connectors of a cell. The pipe spec information for routing is read out from COMOS and applied in Plant Modeler.
Snap connector

While you are defining the pipe route, a window is displayed which asks if you want to link the snapped-in connector to a pipe. Select one of the following options:

- To use the connector directly and start routing at this point, click "Yes".
- To use the connector for data point determination, click "No".

Result

The piping geometry is generated.
2.11 Pipe routing

2.11.2.3 Defining slopes for pipes

During the center line routing process, you can define the slope of pipes and the equipment placed on them in the "Center line routing" window.

Defining a slope value using AccuDraw shortcuts

1. In the "Center line routing" window, activate the option "Enable slope mode".
2. Enter a value in the "Slope" field. Here you can choose whether to specify the value in percent or degrees.
3. Activate AccuDraw.
4. Open the "AccuDraw Shortcuts" window by pressing the <?> key with AccuDraw activated.
   All key combinations you have defined thus far are displayed.
5. Select a connector or a point in the area from which you wish to begin center line routing.
6. Determine the construction direction either using the standard functionality or by aligning it at the mouse cursor.
   To align the construction direction at the mouse cursor, enter the shortcut for the Ipd Keyln.
   You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Plant Modeler KeyIns".
7. To determine the slope of the pipe, enter the shortcut for the sd Keyln.
   The slope changes in the direction of the X-axis according to the value you entered in the "Slope" field. The X-axis is marked red by default in AccuDraw.
8. Define the end of the pipe branch.
   The pipe branch is constructed in Plant Modeler.

Defining a slope value using the "Set" button

1. In the "Center line routing" window, activate the option "Enable slope mode".
2. Enter a value in the "Slope" field. Here you can choose whether to specify the value in percent or degrees.
3. Select a connector or a point in the area from which you wish to begin center line routing.
4. Determine the construction direction.
5. Click "Set".
   The sd Keyln is applied automatically. The slope changes in the direction of the X-axis. The X-axis is marked red by default in AccuDraw.
2.11.3  Placing implementations

2.11.3.1  Overview

Automatic placing of inline components

If you have placed inline components for the pipe branch to be routed on the P&ID in COMOS, you will be able to insert these inline components into the Plant Modeler 3D model automatically during manual routing.

In COMOS, 3D-capable implementations must be available for these inline components. You create implementations in COMOS by executing a pipe spec mapping on an interactive report. You can also create implementations in Plant Modeler during routing.

In the case of inline components, you can execute a pipe spec mapping in Plant Modeler outside the P&ID report at a later point and then place this implementation object.

Plant Modeler analyzes which pipe branch is to be routed and which components of the pipe branch already own 3D objects. These 3D objects are listed in the "Implementation objects" field of the "Centerline Routing" window: The listed objects are displayed in different colors.

<table>
<thead>
<tr>
<th>Font color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>These 3D objects are already assigned to cells in Plant Modeler.</td>
</tr>
<tr>
<td>Black</td>
<td>No cell was yet assigned to these 3D objects. You must place these objects in Plant Modeler. Only inline components for which you have completed a pipe spec mapping in COMOS are displayed.</td>
</tr>
</tbody>
</table>

2.11.3.2  Automatically implementing inline components

Introduction

If you have not yet carried out a 3D implementation using the pipe spec mapping for mounting parts in COMOS, you can subsequently implement the mounting parts in the Plant Modeler.

Procedure

To automatically implement inline components, proceed as follows:

1. Route the pipe branch manually.
2. As you define the route of the pipe branch, click the location where you want to implement the component.
3. Select the desired component from the "Implementation objects" field in the "Centerline routing" window.

If an implementation does not yet exist for the component in COMOS, the "Implementation objects" field shows the entry "No implementation defined" instead of the implementation.

To create an implementation, proceed as follows:
- Select the entry.
- Click the "Execute pipe spec mapping" button.
  In the "Pipe spec mapping" window, possible implementations are transmitted from COMOS and displayed.
- Select an implementation.
- Click the "Assign implementation" button.

4. In the "Center line routing" window, click the "Place implementation" button.

A preview of the implementation is displayed.

5. As an option, you can rotate the implementation about its main axis.

In the "Center line routing" window, enter the rotation angle in the "Angle" field. Execute the rotation by pressing the \( \text{ \text{ } } \) button.

See also chapter "Center line routing" window (Page 175).

Result

The inline component is inserted in the 3D model in Plant Modeler at the location you selected with the last mouse click. The 3D data originates from COMOS.

The pipe is routed using a right-click. When the pipe is generated, the flanges, gaskets, and any reducers defined in the pipe spec are also created in both COMOS and Plant Modeler. The geometry also comes from COMOS.

2.11.3.3 Placing implemented objects subsequently

You can also place implemented objects on the P&ID subsequently, once you have routed the pipes.

Requirement

You have routed the pipe branch. An implementation exists.

Procedure

To place implemented objects subsequently, proceed as follows:
1. In COMOS, select the desired object on the P&ID.
2. Right-click the selected object.
3. In the context menu, click on "Plant Modeler > Place Implementation".
4. Place the desired component.
5. To save your changes, click the "Save" button.

Result
You have subsequently placed inline components.

2.11.3.4 Implementing 3D components subsequently

Procedure
To implement 3D components subsequently, proceed as follows:
1. Select the required pipe spec and nominal diameter in the "Pipe settings" window.
   Make the appropriate changes to the tools in the "Placeable objects" toolbar.
2. Select the required component from the "Placeable objects" toolbar.
3. Select a connector on the pipe to which you wish to add the component.
4. Specify the position of the component and confirm it.

Result
Once you have placed the component, you can assign a component which has not yet been implemented in COMOS subsequently as an implementation. See also chapter Assigning COMOS object to a cell (Page 18).

2.11.4 Automatic routing

2.11.4.1 Overview
With the automated routes, you can rapidly connect two freely positioned connectors. Select the automatic routing if you want to make cost and time estimates. During automatic routing, you cannot make any user-defined pipe settings or place implementations installed in COMOS in the corresponding pipe branch.

Differences compared to manual routing
Following differences apply for the automatic routing when compared to manual routing.
- You must always set a connector as the starting point and end point.
- You define the end point with a left mouse click.
- The AccuDraw MicroStation function is not available.
2.11.4.2 Automatically routing pipe branches

**Prerequisite**

The pipe is assigned to a pipe spec and a nominal diameter in the P&ID.

**Procedure**

To automatically route pipe branches, proceed as follows:

1. Expand the "Pipe construction" toolbar in Plant Modeler.
2. Click on the "Autoroute" tool.
   
   The "Automatic Routing" window opens. The window is empty because you cannot make any settings during the automatic routing. The window indicates that the tool is enabled.
3. To define the starting point for the automatic routing, click the corresponding connector.
4. To define the end point for the automatic routing, click the corresponding connector.

**Result**

The pipe branch is routed automatically. Implemented objects are not placed in this working method, but rather have to be inserted subsequently into the pipe.

**See also**

- Placing implemented objects subsequently (Page 28)

2.11.5 Routing without P&ID information

**Overview**

Even if you have no P&ID information available, routing is still possible.

Start by specifying the required pipe spec and nominal diameter in Plant Modeler. While you are defining the pipe route, COMOS opens the "Select owner" window, where you can select and assign a pipe branch. If you select the pipe branch in advance in the Navigator, this makes it easier for you to find the correct object, as the selected pipe branch is displayed as the start node in the "Select owner" window. If no corresponding pipe section has been created, create the required structure in the "Select owner" window by using the "Create pipe" and "Create pipe section" buttons. Then select the owner.

COMOS generates the corresponding object under the selected owner. If a new pipe is generated, the pipe gets the previously defined pipe spec and nominal diameter.

After defining the owner, switch back to Plant Modeler and continue routing as usual.
2.12 Placing pipe hangers

Pipe hangers can be placed in various ways:

- As wildcards in the form of a sphere which you place on the center line of the pipe
- As the COMOS object which gets its geometry from the "PPC" node. For this purpose, the start node under which the base objects of the pipe hangers are located in the base project must be set in the "CPM" configuration file. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Settings in the COMOS configuration file for Plant Modeler".
- If a pipe hanger class is part of the pipe spec, you can also place these objects using the "Placeable objects" toolbar. See also section Placing components from the "Placeable objects" toolbar (Page 33).
- You can also place pipe hangers from a MicroStation cell library. See also section Using a user-defined cell as a marker for hangers (Page 32).

Requirement

You have routed the pipe.

Procedure

To place a pipe hanger, proceed as follows:

1. Expand the "Pipe construction" toolbar in Plant Modeler.
2. Click on the "Hanger & support" tool.
   
   The "Place hanger/support for pipe" window opens.
   
   If base objects for the hanger are defined in COMOS and the administrator has made the appropriate settings, you can select a specific hanger.
3. Select the pipe in which you want to place the support.
   
   The name of the hanger is displayed in the "Name" field in the "Place Hanger/Support" window.
4. To place the hanger, move the hanger to the desired location on the pipe and click the location.
Result

The hanger is placed.

If pipe hangers are defined in a Pipe Spec, you can also use the "Placeable Objects" toolbar to place the pipe hangers.

2.13 Using a user-defined cell as a marker for hangers

Requirement

You are using a cell library that contains defined hangers.

Procedure

To use a user-defined cell as a marker for hangers or supports, proceed as follows:

1. Expand the "Pipe construction" toolbar in Plant Modeler.
2. Open the desired cell library.
   
   Cells to be used as hangers do not necessarily require a COMOS connector. Connectors are generated when the cells are placed. However, when you create the connectors yourself you can determine the position of the connectors.

3. On the "Pipe construction" toolbar, click on the "Hanger & support" tool.
   
   The "Place hanger/support for pipe" window opens.

4. In the "Place hanger/support for pipe" window, enable the "Place cell" option.
   
   The cells of the open cell library are displayed in the "Place hanger/support for pipe" window.

5. To place the cell, double-click on the desired location of the pipe.

Result

The hanger is placed at the desired location.

Additional information

You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Cell library and placed cells".
2.14 Placing components from the "Placeable objects" toolbar

Which components are displayed on the "Placeable objects" toolbar depends on the pipe spec and nominal diameter you selected in the "Pipe settings" window.

Procedure

To place components from the "Placeable objects" toolbar, proceed as follows:

1. In the Plant Modeler menu, click on "COMOS Plant Modeler > Piping > Pipe components".
2. Select a tool from the "Placeable Objects" toolbar.
3. Enter the required information in the "Place component" window.
4. Move the mouse over the connector of the component at which you want to connect or install the new component.
   The object will be highlighted when the mouse runs over a connector.
5. To place the object, click where on the desired location.
   For components with fixed dimensions, the new component is connected at the corresponding connector. For components without fixed dimensions, the origin of the MicroStation AccuDraw tool is placed at the starting point you selected from the "Select Connector" list in the "Place Component" window. You can select the position of the AccuDraw in relation to the component at will using the <o> key.
6. For components without fixed dimensions, move the mouse to the desired position.
   The new component will move along with the mouse to the according position.
7. Click the desired position.

Result

COMOS recalculates the parts of the pipe route you changed by placing the component. If the you inserted the component into a pipe, the old pipe is deleted and two new pipes are created.

The 3D object of the pipe is created in COMOS underneath the pipe branch. The 3D object is moved as soon as you assign the placed component to an object in COMOS.

See also

"Place component" window (Page 176)
2.15 Placing a pipe as a branch

Requirement

The required pipe spec and nominal diameter have been set.

Procedure

1. On the P&ID report in COMOS, select the pipe branch you wish to place in Plant Modeler. This pipe branch is then assigned to the pipe branch in Plant Modeler.
   
   If you do not select a pipe branch, the "Select owner" window opens when you attempt to place a pipe branch; you can specify the object assignment in this window.

2. In the Plant Modeler menu, click on "COMOS Plant Modeler > Piping > Pipe components".

3. Select the "Place pipe" tool.

4. Select "Branch" from the "Distance calculation from:" list in the "Place component" window.

5. Select a connector for the pipe on which you wish to place the new pipe branch.

6. Specify the rotation angle and rotate the component if necessary.

7. Specify and confirm the tilting angle.
   
   So that you can specify the tilting and rotation angles, the corresponding attributes must be enabled in the report bar. You find additional information on this topic in the "P&ID" manual, keyword "Attributes in the report bar".

8. Save your settings.

9. Place the pipe branch in the required position in Plant Modeler.

Result

The pipe is generated as a branch.

You find additional information on this topic in the "P&ID" manual, keyword "Using P&ID".
2.16 Carrying out routing with HVAC components

Prerequisite

The "HVAC" add-in is installed.

Procedure

Proceed as follows in order carry out routing with HVAC components:

1. Open the "HLK and cable routings" toolbar in the Plant Modeler.
2. Click the "Center line routing" tool.
   The "Start routing" window opens.
3. From the "Class type" list, select the "HVAC type" entry.
4. Select the desired class of the HVAC component from the "Class" list.
5. Enter the width and height of the HVAC component.
6. In the "View" window, click the first position for routing with HVAC components.
   The "Select owner" window opens.
7. Enter the desired settings and click "OK".
8. In the "View" window, draw the desired course for routing with HVAC components.

See also

"Select owner" window (Page 178)

2.17 Place HVAC component

Prerequisite

The "HVAC" add-in is installed.

Additional information about installing and configuring the add-in is available in the documentation "3D Integration Administration" under "Plant Modeler > Configuration".

Procedure

Proceed as follows to place an HVAC component:

1. Open the Microstation Key-In.
2. Enter the "cpm startaddintool HVACCT PLACEPART" command.
   The "Place components" window opens.
3. From the "Class type" list, select the "HVAC type" entry.
4. Select the desired class of the HVAC component from the "Class" list.
5. From the "Components" list, select the desired HVAC component.
6. Enter the width and height of the HVAC component.
7. Click in a "View" window.
   The "Select owner" window opens.
8. Enter the desired settings and click "OK".
9. Place the HVAC component at the desired location in the "View" window.

Result

COMOS creates the HVAC objects and displays these in the Plant Modeler.

2.18 Status comparison and update

2.18.1 Status comparison

Overview

As you work with Plant Modeler, inconsistencies between the 3D models may arise. Inconsistencies will occur in the following cases:

- If you continue working in an application even though the connection to the other application has been interrupted (if you change the pipe model in Plant Modeler without first connecting Plant Modeler to COMOS, for example).
- If you forget to assign objects and cells to one another.
- If you generated an isometric drawing from the 3D model and continue working on the isometric drawing.

For this reason, Plant Modeler features a status comparison tool. The status comparison function allows you to compare the 3D models in COMOS and Plant Modeler with each other and lets you eliminate any inconsistencies.

Depending on the configuration, you can start the status comparison in COMOS, in Plant Modeler, or in both applications. If you only want to use a particular object amount as an entry, it makes sense to start the status comparison from just one application. Eliminate the inconsistencies in Plant Modeler or in COMOS dependent upon their type.

The following status checks are available by default:
### 2.18 Status comparison and update

#### Status check

<table>
<thead>
<tr>
<th>Status check</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Consistency check: P&amp;ID &lt;-&gt; 3D topology&quot;</td>
<td>A check is performed to determine whether the sequence of the objects is the same in COMOS and Microstation.</td>
</tr>
<tr>
<td>&quot;Consistency check: Pipe spec mapping (P&amp;ID)&quot;</td>
<td>Checking of the pipe spec mapping is determined by the database used. A check is performed to determine whether the implementations of the relevant inline components in COMOS and Microstation come from the same pipe spec.</td>
</tr>
</tbody>
</table>
| "Consistency check: P&ID 3D pipe spec/DN/object"                             | A check is performed to determine whether the following elements match in COMOS and Microstation:  
  - Pipe spec and nominal diameter  
  - Object type  
| "Consistency check: 3D level"                                                | A check is performed to determine whether the following elements match in COMOS and Microstation:  
  - Level assignment of pipes and of equipment  
| "Check COMOS-Microstation consistency"                                       | A check is performed to determine whether the following elements match in COMOS and Microstation:  
  - Positions of the connectors  
  - Pipe spec and nominal diameter  

Access to the status checks is defined in the "COMOS.CPM.config" configuration file. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Editing status entries in the configuration file in COMOS".

The status comparison contains specific status values, which are dependent upon the status check.

The following general status values are available in addition:

- "Status in subobject"
- "Not checked"
- "Irrelevant"

---

**See also**

[Eliminating inconsistencies](#) (Page 39)
2.18.2 Performing a status check in COMOS

Requirement

- Plant Modeler and COMOS are connected.
- You have placed the status checks you wish to use in the COMOS 3D status list.

You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Editing status entries in the configuration file in COMOS".

Procedure

To perform a status check, proceed as follows:

1. In the COMOS Navigator, select the node for which you want to perform a status comparison.
2. Open the context menu.
3. In the context menu, select the "Plant Modeler > <Check status>" command.

Result in COMOS

The objects in the Navigator are displayed in the color of their status. To find out which color corresponds to which status, refer to the legend, which you can call in the context menu of the Navigator using the "Legend" command.

Result in Plant Modeler

- Status check "Check COMOS-Microstation consistency":
  The objects in the Navigator are displayed in the color of their status.
  The "Update geometry status" window is displayed in Plant Modeler. The window displays all the cells and pipe parts from the current DGN model and arranges them underneath their respective statuses. See also Section Eliminating inconsistencies (Page 39).
  The number and color assignment of the statuses is the same as in COMOS.
- Other status checks:
  The objects in the Navigator are displayed in the color of their status.

See also

Displaying the status in Plant Modeler (Page 39)
2.18.3 Displaying the status in Plant Modeler

Requirement

COMOS and Plant Modeler are connected. Specific status queries have been stored in the COMOS configuration file. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Editing status entries in the configuration file in COMOS".

Procedure

To display the status, proceed as follows:
1. Expand the "Change management" toolbar.
2. Select the "Calculate status" tool.
   The "Status Calculation" window opens.
3. Select the desired status query from the list.
4. Click the "Start Calculation" button.
   The different statuses are displayed in the "Status Calculation" window as a result. The objects corresponding to the status are displayed underneath the status.
5. To navigate to a cell, double-click an object in the "Status Calculation" window.
   The object is magnified.

Result

The different statuses are displayed in the "Status Calculation" window as a result. See also section Status comparison (Page 36).

Exiting the tool

To exit the tool, click the "Exit Tool" button.

Additional information

You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Settings in the COMOS configuration file for Plant Modeler".

2.18.4 Eliminating inconsistencies

You can eliminate inconsistencies for all objects/cells at the same time or individually for each object/cell.
2.18 Status comparison and update

Requirement

COMOS and Plant Modeler are connected.
You have run a 3D consistency comparison between Plant Modeler and COMOS.

Procedure

To eliminate inconsistencies between COMOS and the DGN model in Plant Modeler, proceed as follows:

1. Select one of the following options:
   - If you want to eliminate an inconsistency for a specific object, select the desired object in the "Update geometry status" window.
   - If you want to eliminate inconsistencies for multiple objects, select multiple objects in the "Update geometry status" window.
   - If you want to eliminate inconsistencies for all objects, select the "Objects differ" node in the "Update geometry status" window.

2. Click the "Get COMOS Data" button.
   The COMOS 3D data is read into Plant Modeler and temporarily displayed in the 3D model.

3. Select one of the following options:
   - If you want to apply the 3D data from COMOS and discard the 3D data from Plant Modeler, click the "Apply COMOS Data" button.
   - If you want to apply the 3D data from Plant Modeler and discard the 3D data from COMOS, click the "Apply Plant Modeler Data" button.

Result

The inconsistencies are eliminated. The objects no longer appear in the "Update geometry status" window. The 3D model is adapted accordingly.

2.18.5 Updating the labelling

Cells whose geometry does not automatically originate from COMOS automatically take over the label of the P&ID object when assigned to a P&ID object. If you change the label in COMOS after assigning the cell, you must also update the label of the cell in MicroStation. Cells whose geometry does not originate from COMOS do not need to be updated.

Procedure

To update the labeling of a cell, proceed as follows:

1. In COMOS, select the desired object on the P&ID or in the Navigator.
2. Right-click the selected object.
3. In the context menu select the "Plant Modeler > Update" command.
2.19 More possible actions in the "Change/Information" toolbar

2.19.1 Retrieving object information

Procedure

To retrieve component information, proceed as follows:
1. Expand the "Change/Information" toolbar.
2. Select the "Component information" tool.
   The "Object information" window opens.
3. Select the object for which you want to retrieve information.

Result

Information about the object, e.g. the pipe spec, is listed in the "Object information" window.

Retrieving information for another object

To retrieve information for another object, leave the "Object information" window open and select another object.

2.19.2 Selecting multiple cells in the same pipe branch

Procedure

In order to select all cells that belong to the same pipe branch in one step in Plant Modeler, proceed as follows:
1. Expand the "Change/Information" toolbar.
2. Click on the "Select components" tool.
3. Click the desired cell.

Result

In Plant Modeler, all cells whose 3D objects in COMOS have the same owner as the 3D object of the selected cell (and, therefore, belong to the same pipe branch) are selected.
Example: Valves

A valve that is located underneath its P&ID request in COMOS is not selected. A valve that you have placed in Plant Modeler but have not yet assigned to a P&ID object is selected.

2.19.3 Resetting components

Procedure

To reset the assignment status of a component, proceed as follows:

1. Expand the "Change/Information" toolbar.
2. Select the "Reset component" tool.
   The "Object attributes" window opens.
3. Select the component you want to reset.
   The name of the selected component is displayed in the "Object attributes" window.
4. To assign a new ABO object, select the required base object in the "Object attributes" window.
5. Click the "Accept" button.

Result

A new ABO object is assigned to the component. The link between COMOS object and 3D cell is deleted. If a component has been assigned, the implementation is deleted. If you reassign the implementation, the new implementation is generated with the current data.

Note

If you reset a component, the connector information is lost. You must regenerate the connector information using the "Connect components" function. See also chapter Connecting components (Page 46).

Additional information

You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Settings for ABO objects".
2.19.4 Moving components

Procedure

To move objects, proceed as follows:

1. Expand the "Change/Information" toolbar.
2. Select the "Move component" tool.
   The "Move Object" window opens.
3. Select one of the following options:
   - If you only want to move one object, click the according object.
   - If you want to move multiple objects, enable the "Multiple selection" option in the "Move Object" window. Then click the desired object.
   If you only move one object, the selected object is highlighted.
   If you have enabled the "Multiple selection" option, all cells whose 3D objects in COMOS have the same owner as the cell you have selected are selected at once.
4. Move the mouse pointer over the user interface.
   Just as when placing objects from the cell library, you see the objects you move to another location.
5. Click on the desired location in order to place the objects.
   Take the degrees of freedom of the pipe into account. If you do not, the link to connected objects will be broken.

Result

The selected objects are moved to the desired location. When you move a pipe route, the position of the connected equipment does not change or the connection is broken. When you move equipment, the connected pipe is adapted within the limits of the degrees of freedom.
When you move objects, the pipe route is usually extended. In some cases, a gap may be created in the 3D model or the pipe route may be cut short.
Changes to the 3D data are passed to COMOS.

Moving the pipe geometry

The "Move Objects" tool also allows you to move the pipe geometry. You can move both individual pipe parts and complete pipe branches. To do so, follow the steps described above.
2.19 More possible actions in the "Change/Information" toolbar

Moving with MicroStation commands

Note
Do not use MicroStation handles to change the cells. If you do, the cells will lose their information.

You can use the "Move" command in MicroStation to move components.

2.19.5 Splitting pipe routes

You can split a pipe route into sections of the same size to split the pipe route into lengths for delivery, for example.

Prerequisite
The "Length" attribute does not prescribe a fixed length for the pipe route. The length is configured as a variable value with a default value. The attribute is enabled for processing for the Plant Modeler in the "GD.VSUI" attribute at the base object.

Procedure
To split a pipe routes, proceed as follows:
1. Expand the "Change/Information" toolbar.
2. Select the "Split pipe" tool.
   The "Split Pipe" window opens.
3. In the "Length" field of the "Split Pipe" window, enter the length of the parts you want to split the pipe into.
4. Select one of the following options:
   - If you want to split the complete pipe, enable the "Complete pipe route" option in the "Split pipe" window.
   - If you want to split a pipe branch, enable the "Individual pipe branch" option in the "Split pipe" window.
5. Click the desired pipe.
   The pipe is selected.
6. Click the selected pipe.

Result
The pipe is split into equal parts. Residual lengths might be shorter.
2.19.6 Closing gaps between pipes

Prerequisite

A gap exists between two pipe routes because you removed a component.

Procedure

To close a gap between pipe routes, proceed as follows:

1. Expand the "Change/Information" toolbar.
2. Select the "Close gap" tool.
3. Select the flange of the first pipe route.
4. Select the flange of the second pipe route.

Result

The pipe length of the object you selected last is adjusted, and the gap is closed. The position of the object you selected first remains unchanged.
2.19.7 Connecting components

Prerequisite

The connectors are on top of each another.

Procedure

To connect components, proceed as follows:
1. Expand the "Change/Information" toolbar.
2. Select the "Connect components" tool.
3. Click the connector of the desired component.
4. Click the connector of the component you want to connect to the already selected component.
5. Click the same connector again.

Result

The components are connected.

2.19.8 Dissolving connections between components

Procedure

To dissolve connections between two components, proceed as follows:
1. Expand the "Change/Information" toolbar.
2. Select the "Unlink components" tool.
3. Click on the desired connection point of the first component.
4. Click on the desired connection point of the second component.
5. Click the component again.

Result

The connection between the components is dissolved.
2.20 Files referenced

2.20.1 Moving cells into the referenced file

Procedure

To move cells from the current 3D model into another file, proceed as follows:

1. Expand the "References" toolbar in Plant Modeler.
2. Select the "Move to Reference" tool.
   The "Move to reference" window opens.
3. Select the desired cell.
   The connected objects are also selected and highlighted.
4. In the "Move to File" window, enable the "Move to external file" option.
5. Click the "..." button to enter the file in the "Path" field.
6. Select one of the following options:
   - If you want to select the complete pipe, enable the "Complete pipe route" option.
   - If you want to select a pipe branch, select the "Individual pipe branch" option.
7. In the "Move to file" window, click the "OK" button.

Result

The "Move to reference" window closes. The selected cells are moved to the specified file.

2.20.2 Deleting a referenced file

Procedure

To delete a referenced file, proceed as follows:

1. Expand the "References" toolbar.
2. Select the "Delete reference" tool.
   The "Delete Reference" window opens.
3. Select an object from the referenced file.
   All objects located in the reference are selected automatically.
4. Select one of the following options:
   - If you want to delete the referenced file and keep the COMOS data, enable the "Move object to master file" option in the "Delete reference" window.
   - If you want to delete the referenced file and the COMOS data, disable the "Move object to master file" option in the "Delete reference" window.

5. Click "OK".

Result

The referenced file is deleted.

2.20.3 Processing referenced cells

You can process cells directly from within the 3D model: Choose the "COMOS Plant Modeler" menu, point to Administration, and click "Settings". Then, on the "References" tab, enable the "Change references automatically" option. The setting takes effect once you enable this option. However, it will not be written to the configuration file until you close MicroStation.

Changes

You can make the following changes:

- Assign
- Move
- Change header attributes

Note

Once you have changed referenced cells, you can no longer undo the changes.

2.21 Insulation

2.21.1 Creating insulation

You can create insulation in the following ways:

- During pipe routing
  See also Section Manually routing a pipe branch (Page 23).
- Using the "Insulation" toolbar
Requirement

- COMOS and Plant Modeler are connected.
- The pipe spec used has an insulation class.
- The "Use insulation" option is activated in the "Pipe settings" window.

Procedure

1. Expand the "Insulation" toolbar.
2. Select the "Change insulation" tool.
   The "Edit insulation" window opens.
3. Click a pipe for which you want to create insulation.
4. In the "Edit insulation" window, define the thickness and/or insulation class of the insulation.
5. Click the pipe again.

Result

The insulation is created and is placed underneath the relevant pipe branch in the COMOS Navigator.

2.21.2 Changing insulation

Prerequisite

COMOS and Plant Modeler are connected. The pipe spec used has an insulation class. The insulation is being used.

Procedure

1. Expand the "Insulation" toolbar.
2. Select the "Change insulation" tool.
   The "Edit insulation" window opens.
3. If you only want to change a single component instead of a complete pipe course, activate "Select individual component".
4. Click the insulation you want to change.
5. In the "Edit insulation" window, change the thickness and/or insulation class of the insulation.
6. Click the insulation again.
Result

The insulation is changed accordingly. The new data is transmitted to COMOS and entered in the insulation properties.

2.21.3 Disconnecting insulation

Requirement

COMOS and Plant Modeler are connected. The pipe spec used has an insulation class. The insulation is being used.

Procedure

1. Expand the "Insulation" toolbar.
2. In Microstation, select the pipe whose insulation is to be disconnected.
3. Select the "Disconnect insulation" tool.
4. To confirm, click in the space.

Result

The pipe insulation is split down the center. Additional insulation is created underneath the relevant pipe branch in the COMOS Navigator.

2.21.4 Deleting insulation

Requirement

COMOS and Plant Modeler are connected. The pipe spec used has an insulation class. The insulation is being used.

Procedure

1. Expand the "Insulation" toolbar.
2. Select the "Delete insulation" tool.
3. Click the section of insulation that is to be deleted.

Result

The insulation is removed in Plant Modeler and then in COMOS.
2.21.5 Moving insulation

Requirement
COMOS and Plant Modeler are connected. The pipe spec used has an insulation class. The insulation is being used.

Procedure
1. Expand the "Insulation" toolbar.
2. Select the "Move insulation" tool.
3. Click the insulation you want to move.
   You can move the insulation in both directions on the pipe, right up to the point where the next insulation section starts.
4. Left-click to place the insulation.

Result
The pipe insulation is moved. The new coordinates are transmitted to COMOS and entered in the insulation properties.

2.21.6 Stretching insulation

Requirement
COMOS and Plant Modeler are connected. The pipe spec used has an insulation class. The insulation is being used.

Procedure
1. Expand the "Insulation" toolbar.
2. Select the "Stretch insulation" tool.
3. Click the insulation you want to move.
   The direction of stretching depends on whether you click to the right or to the left of the center point on the insulation.
   The end of the insulation is represented by an ellipse, which you can move along the pipe.
4. Left-click to define the stretching.
2.22 Change management

2.22.1 Changing PipeSpec or nominal diameter

Prerequisite

COMOS and Plant Modeler are connected.

Procedure

To change the PipeSpec, proceed as follows:
1. Expand the "Change management" toolbar.
2. Select the "Change pipe spec" tool.
   The "Change Pipe Properties" window opens. This window offers a filter that compresses identical parts into one entry. Valves are not filtered, since they differ on a case-by-case basis.
3. Select the desired component.
4. Select one of the following options:
   – If you want to change the PipeSpec for the entire pipe route, enable the "Complete pipe route" option.
   – If you want to change the PipeSpec for an individual pipe branch, select the "Individual pipe branch" option.
5. To change the PipeSpec, enable the "Change PipeSpec" option.
6. To change the nominal diameter, enable the "Change nominal diameter" option.
7. Select the pipe its PipeSpec and/or nominal diameter you want to change.
   The "PipeSpec" and "ND" lists will be displayed in the "Change Pipe Properties" window. These lists are enabled based on the selections you made for the "Change PipeSpec" and "Change nominal diameter" options.
8. From the appropriate list, select the desired PipeSpec and/or the desired nominal diameter.
9. Click the "Accept" button.
   The PipeSpec mapping is displayed for the selected PipeSpec in the "Change Pipe Properties" window.

Result

The length of the insulation is changed. The new coordinates are transmitted to COMOS and entered in the insulation properties.
10. Select the desired entry.
   All components for replacement are offered in the list.

11. Expand the desired node.
   The objects set as preselected components in the pipe spec are displayed in italics in the lists.

12. To use an object, double-click it.
   The selected components are highlighted in green. The processed node is also marked in green.
   When replacing components, the following order is recommended:
   - Bows for defining corner points
   - Fittings, T-pieces, reducers, valves
   - Flanges
   - Pipes
   Following the selection, the new components are loaded in the 3D construction so that the change can be checked.
   The "Filter" option compresses identical component types (i.e. base objects) into a single entry. This allows you, for example, to replace all bows of the same type at once.

13. Click the "Accept" button.

Result
The PipeSpec and/or nominal diameter is changed for the selected pipe. These changes are synchronized with COMOS. If you change the pipe spec and/or nominal diameter in 3D, the change does not affect the settings on the P&ID. Therefore, the changes create an inconsistency.

Recommendation
Make sure that the changes are accompanied by a controlled workflow. To check which data is inconsistent and whether you have to adapt the data in 2D or 3D, run a status check for the DN/pipe specs from 3D or PID.

See also
- Calculate status (Page 54)
- Status comparison and update (Page 36)
2.22.2 Calculate status

Prerequisite

Specific status queries have been set by default in the configuration file.

Procedure

To check the status from 3D, proceed as follows:

1. Expand the "Change management" toolbar.
2. Select the "Calculate status" tool.
   The "Status calculation" window opens.
3. Select the required status calculation.
4. Click on the "Start calculation" button.

See also

Status comparison and update (Page 36)

2.23 Cell management

2.23.1 "Cell library" and "Cell" toolbars

- Changes you make using the "Cell library" toolbar affect the active model from the cell library. Therefore, the changes are also applied when the model from the cell library is placed in another DGN file.
- Changes you make using the "Cell" toolbar only affect the cell selected in the DGN file.

2.23.2 Settings for attribute information and connectors

Cell libraries

In order to use a user-defined cell library or a cell from a cell library in Plant Modeler, you must add header information to the cell. In addition, the cell must have connectors that are compatible with COMOS. Cells whose geometry comes from COMOS automatically have connectors.

If you are in a cell library, make the necessary settings via the "Cell Data Processing" toolbar. If you have already placed a cell in a 3D model, but this cell does not yet have the necessary header information or connectors, make the necessary settings via the "Object Cell Data Administration" toolbar.
2.23.3 Creating attribute information in the cell library

Procedure

To create attribute information in the cell library, proceed as follows:

1. Open the desired CEL file in Plant Modeler.
2. Select the desired model or cell.
3. Expand the "Cell management" toolbar.
4. Expand the "COMOS cell library" toolbar.
5. Click on the "Create cell header" tool.
   The "Cell Attributes" window opens.
6. Enter the desired name in the "Name" field. You can enter the manufacturer name, for example.
7. If you want the cell to work exclusively with a specific pipe spec, enter the name of that COMOS pipe spec in the "Pipe spec" field.
8. To assign an object, select an entry from the list.
   The list features the objects you created under the "PLM > Y > ABO" node in the COMOS base project. ABO objects are objects that act as placeholders for MicroStation cells.
   You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Settings for ABO objects".
9. Click "Accept" to save your settings.

Result

The name and PipeSpec you entered are added to the cell. The name you entered in the cell library is applied into the DGN file. Once you have assigned the cell to a COMOS P&ID object, the value of attribute "E0003" is applied.

You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Structure of the 'PLM' node in the base data".

See also

- Creating attribute information in the cell library (Page 55)
- Creating attribute information for placed cells (Page 56)
- Buttons on the "Cell management" toolbar (Page 170)
2.23.4 Creating attribute information for placed cells

Requirement

The cell does not have the necessary attribute information.

Attribute information

A cell that has been placed in the 3D model usually already has the required attribute information if it has been prepared accordingly for processing in Plant Modeler. If you complete the steps described below, and the cell is already assigned to an engineering object from COMOS, the assignment will become invalid.

Procedure

To create attribute information for placed cells, proceed as follows:

1. In Plant Modeler, open the DGN file.
2. Expand the "Cell management" toolbar.
3. Expand the "COMOS cell" toolbar.
4. Click on the "Create cell header" tool.
   The "Object Attributes" window opens.
5. To assign a COMOS object to the cell as an option, select an entry from the "Assign implementation" list.
   The list features the objects you created under the "PLM > Y >ABO" node in the COMOS base project.
   You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Settings for ABO objects".
6. As an option, you can select an entry from the "Standards system" and "Flange standard" lists and enter a name. See also Section "Object attributes" window (Page 177).
7. Click the "Accept" button.

Result

Your settings are saved.
2.23.5 Creating connectors for cells

Requirement

The cell has no connectors.

Connectors

Plant Modeler creates the connectors in ascending order. When you create a new connector, the origin of the cell is generated first, followed by the inputs and outputs for connecting with other cells. You are therefore unable to freely define which connector is created first. Plant Modeler analyzes if and which connectors already exist and then creates the next connector in the sequence.

Procedure

To create a connector for cells in the cell library or for placed cells, proceed as follows:

1. Select one of the following options:
   - If you want to create a connector for a cell in the cell library, open the CEL file in Plant Modeler.
   - If you want to create a connector for a placed cell, open the DGN file in Plant Modeler.

2. Expand the "Cell management" toolbar.

3. Select one of the following options:
   - If you want to create a connector for a cell in the cell library, expand the "COMOS cell library" toolbar
   - If you want to create a connector for a placed cell, expand the "COMOS cell" toolbar

4. Select one of the following options:
   - If you want to create a connector for a cell in the cell library, click on the "Create connector" tool on the "COMOS cell library" toolbar
   - If you want to create a connector for a placed cell, click on the "Create connector" tool on the "COMOS cell" toolbar

The "Create Connector" window opens. See also Section "Create Connector" window (Page 178).

5. Click the desired cell.

The name of the new connector is generated and displayed in the "Create Connector" window. If the cell does not yet have an origin, the origin "CX0" is shown as the name. If the cell already has an origin, the name of connector "CX<n>" is displayed. If there is no origin involved, you can modify the control elements in the "Create Connector" window.
6. Enter the following connector properties in the control elements of the "Create Connector" window:
   - Nominal diameter
   - Nominal pressure
   - Connection type
   - Contact face
   - Flange standard

7. Specify the position of the connector in the cell by clicking on the desired position.

8. Define the orientation of the connector.
   The orientation of the connector is indicated by an arrow.

Result
The new connector is created. If you have created a new connector for a cell in the cell library, the connector is placed parallel to the geometry.

2.23.6 Calling connector information of a cell

Prerequisite
The cell has connectors.

Procedure
To call information about the connectors of a cell in the cell library or of a placed cell, proceed as follows:
1. Select one of the following options:
   - If you want to call information about the connectors of a cell in the cell library, open the CEL file in Plant Modeler.
   - If you want to call information about the connectors of a placed cell, open the DGN file in Plant Modeler.
2. Expand the "Cell management" toolbar.
3. Select one of the following options:
   – If you want to call information about the connectors for a cell in the cell library, expand the "COMOS cell library" toolbar
   – If you want to call information about the connectors for a placed cell, expand the "COMOS cell" toolbar

4. Select one of the following options:
   – If you want to call information about the connectors for a cell in the cell library, click the "Connector information" tool on the "COMOS cell library" toolbar
   – If you want to call information about the connectors for a placed cell, click the "Connector information" tool on the "COMOS cell" toolbar

The "Connector Info" window opens. It does not yet contain any information.

5. Click the desired cell.

The connectors of the cell are superimposed by means of a triad, providing a clear indication of the orientations and positions.

6. Click the desired connector.

Result

Information about the selected cell is displayed in the "Connector Info" window. The control elements of the window are grayed out. You cannot change the connector information in this window.
2.23.7 Changing the properties of a connector

Prerequisite

The cell has connectors.

Procedure

To change the properties of a connector of a cell from the cell library or of a placed cell, proceed as follows:

1. Select one of the following options:
   - If you want to change the connector properties of a cell in the cell library, open the CEL file in Plant Modeler.
   - If you want to change the connector properties of a placed cell, open the DGN file in Plant Modeler.

2. Expand the "Cell management" toolbar.

3. Select one of the following options:
   - If you want to change the connector properties for a cell in the cell library, expand the "COMOS cell library" toolbar
   - If you want to change the connector properties for a placed cell, expand the "COMOS cell" toolbar

4. Select one of the following options:
   - If you want to change the connector properties for a cell in the cell library, click the "Modify connector" tool on the "COMOS cell library" toolbar
   - If you want to change the connector properties for a placed cell, click the "Modify connector" tool on the "COMOS cell" toolbar

The "Modify Connector" window opens. The control elements are still unavailable.

5. Click the desired cell.

The connectors of the cell are superimposed by means of a triad, providing a clear indication of the orientations and positions. The control elements turn active in the "Modify Connector" window.
6. Select one of the following options:
   - If you want to change the attributes of the connector, enable the "Connector Attributes" option. Click the desired connector. In the "Connector Info" window, the control elements that display the attributes become available. Enter the desired changes.
   - If you want to change the position of the connector, enable the "Connector Position" option. Click the desired connector. Click the desired position.
   - If you want to modify the orientation of the connector, enable the "Connector Orientation" option. Click the desired connector. Change the orientation, which is indicated by an arrow.

7. To confirm your change, right-click in the MicroStation workspace.

Result

Your changes are saved.

2.23.8 Deleting the connectors of a cell

Prerequisite

The cell has connectors.

Rule

Connectors may only be deleted in the reverse order in which they were created. This means you must start by deleting the last connector you created.

Procedure

To delete connectors of cells in a cell library or connectors of placed cells, proceed as follows:

1. Select one of the following options:
   - If you want to delete a connector of a cell in the cell library, open the CEL file in Plant Modeler.
   - If you want to delete a connector of a placed cell, open the DGN file in Plant Modeler.

2. Expand the "Cell management" toolbar.

3. Select one of the following options:
   - If you want to delete a connector for a cell in the cell library, expand the "COMOS cell library" toolbar
   - If you want to delete a connector for a placed cell, expand the "COMOS cell" toolbar
4. Select one of the following options:
   - If you want to delete a connector of a cell in the cell library, click the "Delete connector" tool on the "COMOS cell library" toolbar
   - If you want to delete a connector of a placed cell, click the "Delete connector" tool on the "COMOS cell" toolbar

   The "Delete Connectors" window opens. This window indicates that the tool is enabled. You cannot enter information in this window.

5. Click the desired cell.

   The connectors of the cell are superimposed by means of a triad, providing a clear indication of the orientations and positions.

6. Click the last created connector.

**Result**

The connector is deleted.

**2.23.9 Special case: Mapping connectors in COMOS**

When a cell has more connectors than the number of CX connectors in allowed COMOS, the assigned COMOS object must have dynamic connectors. Any number of dynamic connectors is permitted.

The following table shows the connectors that are assigned to each other:

<table>
<thead>
<tr>
<th>Connector on the P&amp;ID</th>
<th>3D connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>I1</td>
<td>CX1</td>
</tr>
<tr>
<td>O1</td>
<td>CX2</td>
</tr>
<tr>
<td>O2</td>
<td>CX3</td>
</tr>
</tbody>
</table>

All further connectors are incremented:

<table>
<thead>
<tr>
<th>Connector on the P&amp;ID</th>
<th>3D connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>O3</td>
<td>CX4</td>
</tr>
<tr>
<td>O4</td>
<td>CX5</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

Implementations of dynamic connectors are only used after you have connected components to the newly created 3D objects.

Before you assign the P&ID object and the cell to one another, you must assign the connectors of the cell and the dynamic connectors manually on the P&ID.
To adjust the connectors, proceed as follows:
1. Open the P&ID in COMOS.
2. Select the desired object on the P&ID.
3. Right-click the selected object.
4. In the context menu, click "Options > Edit Symbol".
   The Symbol Designer opens. The dynamic connectors of the symbol are displayed.
5. Change the naming of the dynamic connectors, for example, calling the first connector "CX1", the second connector "CX2", etc.
6. To save your changes, click the "Save" button in Symbol Designer.

You have manually adjusted the connectors in COMOS.

To access tools by means of a keyboard input, proceed as follows:
1. Change from the "Plant Modeler" menu bar to the "MicroStation" view.
2. Call the Keyboard Input function.
   The "Input" window opens.
3. Enter the desired keyboard input.
4. Press <RETURN>.
   The window of the corresponding tool is displayed.
5. Go back to the "Plant Modeler" menu.

You can now use the corresponding tool.

Reference via keyboard inputs (Page 180)
2.25 Deleting and restoring

The Delete, Undo, and Restore functions for 3D data in Plant Modeler are synchronized with COMOS.

Example

If you delete a cell in Plant Modeler, and this cell has a valid assignment to a 3D object in COMOS, the 3D object is deleted in COMOS as well.

Keyboard shortcuts

The following table defines the keyboard shortcuts for the Undo and Restore commands in Plant Modeler and explains the effect these actions have in COMOS:

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Description</th>
<th>Effect in COMOS</th>
</tr>
</thead>
</table>
| <CTRL+Z>          | Undoes the last action.      | Actions that you performed in Plant Modeler and that have an effect in COMOS are undone not only in Plant Modeler, but also in COMOS. Examples of such actions are listed in the following:  
• Deleting a cell with an assigned COMOS object
• Move
• Routing |
| <CTRL+R>          | Restores the original state. | If restoring an original state affects the 3D objects in COMOS, then the original state is also restored in COMOS. |

2.26 Automatic generation of isometric drawings

2.26.1 Automatically generating interactive reports for isometric drawings

Prerequisite

The P&ID planning is complete. The 3D objects have been assigned.

Procedure

To automatically generate an interactive report for an isometric drawing, proceed as follows:
1. In COMOS, create an interactive report for an isometric drawing parallel to the pipe branches for which you want to automatically create an isometric drawing.
2. Open the interactive report you just created.
3. Right-click the interactive report.
4. In the context menu select the "Options > 3D > Iso" menu.

Result

COMOS places all 3D objects located underneath the pipe branch on the isometric drawing.

2.26.2 Drive display

Independently defined drive cells

In Plant Modeler, drives are defined either as standard geometry from COMOS or as independent drive cells. If you define drive cells independently, another implementation is specified on the P&ID for the drive component and it has a symbol script for display on the isometric drawing.

2.27 Locking objects

2.27.1 Basics

If you lock an object automatically for processing through an action or lock it manually for processing in the properties in the Plant Modeler, the Plant Modeler transmits this status automatically to COMOS. COMOS also locks this object for processing.

If, however, you lock an object for processing in COMOS, this status is not transmitted automatically to the Plant Modeler. This is only possible if you have installed the "Isometrics" module. Additional information about this topic is available in the "Isometrics" manual, keyword "Locking or activating 3D objects".

2.27.2 Locking objects for processing

Procedure

Proceed as follows to lock an object:

1. Select the desired object.
2. Click the "Element information" button.
The "Element information" window opens.
3. Open the "Extended" section.
4. From the "Locked" list, select the "Locked" entry.
Result

The object is locked for processing. The Plant Modeler transmits this status to COMOS. The corresponding objects in COMOS are also locked for processing.

2.28 Document management in the Plant Modeler

2.28.1 Basics about document management in the Plant Modeler

If you have installed the PQM module in COMOS, you can use the document management in the Plant Modeler.

Importing the documents into the PQM system

You have to import the documents that you want to manage in the Plant Modeler into the document management system (PQM) of COMOS.

Additional information about this topic is available in the "COMOS PQM" manual, keyword "Importing".

Checking documents in and out

You can check the documents in and out directly in Plant Modeler. The status of the document is transferred to COMOS and displayed in COMOS.

When you check a document out, the document is reserved for you and cannot be edited by any other user.

Displaying and editing documents

In the Plant Modeler, you can only display the documents for information purposes or open them for editing. You always edit the active document (Working-DGN).
See also

Status of the documents (Page 67)
Checking out a document (Page 68)
Displaying documents (Page 68)
Activating a document for editing (Page 69)
Checking in a document (Page 70)
Displaying the "Document management" window (Page 67)
Saving the view of the "Document management" window (Page 71)
Loading the view of the "Document management" window (Page 71)
Ending document management (Page 72)

2.28.2 Displaying the "Document management" window

When you start the Plant Modeler, the "Document management" window is opened. When you have closed the "Document management" window once, you can reopen the "Document management" window by using the "COMOS Plant Modeler > Display document management window" menu.

See also

Starting Plant Modeler in COMOS (Page 12)

2.28.3 Status of the documents

The Plant Modeler displays the current status of the respective document in the "Document management" window by means of the font color of the documents.

The following table shows the possible document statuses:

<table>
<thead>
<tr>
<th>Font color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>The document is checked in.</td>
</tr>
<tr>
<td>Yellow</td>
<td>The document is checked out for display.</td>
</tr>
<tr>
<td>Blue</td>
<td>The document is checked out for editing.</td>
</tr>
<tr>
<td>Violet</td>
<td>The checked-out document has been changed.</td>
</tr>
<tr>
<td>Orange</td>
<td>The checked-out document has been replaced.</td>
</tr>
<tr>
<td>Red</td>
<td>The checked-out document has been deleted.</td>
</tr>
<tr>
<td>Green</td>
<td>A new document has been created and has to be checked in.</td>
</tr>
</tbody>
</table>
2.28.4 Checking out a document

Prerequisite

- The document has been imported into the document management system of COMOS.
- The "Document management" window is displayed.

Procedure

To check out a document, proceed as follows:
1. Select the desired document in the "Document management" window under "COMOS project structure".
2. Select the "Check out" command in the context menu.

Result

The document is checked out and is displayed in the "Document management" window under "Checked out files". As long as the document is checked out, it cannot be edited by any other user.

You can display and edit checked-out documents in the Plant Modeler.

See also

- Displaying the “Document management” window (Page 67)
- Displaying documents (Page 68)
- Checking in a document (Page 70)

2.28.5 Displaying documents

Prerequisite

The "Document management" window is displayed.

Displaying a checked-out document

Proceed as follows to display a checked-out document:
1. Select the desired document in the "Document management" window under "Checked out files".
2. Select the command "Attach as reference" from the context menu.
3. If you want to display another checked-out document, repeat the preceding steps.
Displaying a checked-in document

Proceed as follows to display a checked-in document:

1. Select the desired document in the "Document management" window under "COMOS project structure".
2. Select the "Display document" command from the context menu.
   The "Select model" window opens.
3. Select the desired model for the display and click "Open selected model".
4. If you want to display another checked-in document, repeat the preceding steps.

Result

The document is displayed in the Plant Modeler.
The displayed documents are visible in the "Document management" window under "View" below the active document (Working-DGN).
You can activate checked-out documents that are displayed in the Plant Modeler for editing.

See also

- Activating a document for editing (Page 69)
- Displaying the "Document management" window (Page 67)

2.28.6 Activating a document for editing

Prerequisite

- The "Document management" window is displayed.
- The document is checked out.
- The document is displayed.

Procedure

Proceed as follows to activate a document for editing:

1. Select the desired document in the "Document management" window under "View".
2. Select the command "Make working DGN" in the context menu.

Result

You can edit the document in the Plant Modeler.
2.28 Document management in the Plant Modeler

See also

- Checking out a document (Page 68)
- Displaying documents (Page 68)
- Displaying the "Document management" window (Page 67)

2.28.7 Checking in a document

Introduction

After you have finished editing a checked-out document, check it back into the Plant Modeler.

Prerequisite

- The "Document management" window is displayed.
- A document is checked out.

Procedure

Proceed as follows to check a document back in:

1. Select the desired document in the "Document management" window under "Checked out files".
2. Select the "Check in" command in the context menu.

Result

The document is checked into the Plant Modeler. COMOS also automatically checks the document into the document management system (PQM).

See also

- Checking out a document (Page 68)
- Displaying the "Document management" window (Page 67)
2.28.8 Saving the view of the "Document management" window

Introduction
You can save the current view of the "Document management" window. In addition to the view, the Plant Modeler additionally saves the status of the documents, such as "checked out" or "displayed". When you load the saved view, the Plant Modeler automatically restores the status of the documents.

Prerequisite
The "Document management" window is displayed.

Procedure
Select the "Save view" command in the "File" menu to save the current view of the "Document management" window.

See also
Displaying the "Document management" window (Page 67)

2.28.9 Loading the view of the "Document management" window

Prerequisite
- The "Document management" window is displayed.
- No documents are checked out.

Procedure
Select the "Open view" command in the "File" menu to open a saved view of the "Document management" window.

Result
The Plant Modeler loads the saved view. The documents are set to the status that they had when the view was saved.

See also
Displaying the "Document management" window (Page 67)
Checking in a document (Page 70)
2.28.10 Ending document management

When you close the Plant Modeler, a check is carried out to determine whether any documents are still checked out. If there still are checked-out documents, the "Document management" window is opened automatically. In the "Document management" window, check the checked-out documents back in.

If you close the Plant Modeler without checking the checked-out documents back in, the documents are no longer managed in the document management when the Plant Modeler is started again.

See also

Checking in a document (Page 70)
3.1 General

Aim

COMOS PDMS Integration is an interface which provides you with the option of integrating P&ID data generated in COMOS seamlessly into the 3D planning model of AVEVA PDMS. PDMS pipe specs can already be used for P&ID planning.

The interface consists of two components:

- **Interface operations:**
  - You use this component to import and export your construction objects and synchronize your P&ID and 3D data.
  - On the COMOS side you use the COMOS Construction Assistant to work with the interface. The COMOS Construction Assistant is a limited version of COMOS.
  - On the PDMS side you use the commands from the "Comos" menu to operate the interface, working in the "Export to Comos" and "Query Comos" windows.
  - The configuration settings for the underlying data exchange are made in COMOS.

- **Cats&Specs:**
  - This component carries out the management of catalogs and pipe specs based on standards.
  - You use the COMOS "PDMS interface" plugin to import and export PDMS pipe specs.
  - In the COMOS PipeSpec Designer, you manage the catalogs and pipe specs centrally in COMOS. The PipeSpec Designer serves as a user interface for Paragon, the Cats&Specs tool from PDMS.

The implementation of the interface is based on several sophisticated and flexible algorithms with which you can adjust the default settings of the supplied COMOS DB to your company’s needs. This is done through the configuration of the data exchange details.

The PDMS interface is XML-based and is suitable for both local installation and installation in a Citrix environment.

**Functional scope of interface operations**

The interface operations component supports the following functionalities:

- Export of construction objects from COMOS to PDMS
- Import of construction objects from PDMS to COMOS
- Definition of rules for the owner restriction

These rules define precisely under which owner an object must be located in PDMS. The rules are then applied during the interface operations.
If you choose to carry out planning in COMOS or PDMS, the interface operations area offers many functions to make your work easier.

- Navigate between the COMOS objects and the corresponding PDMS objects
- Use various 3D view operations: Zoom, Add, Remove, Mark
- Carry out a status check for the objects in both applications.
- If a status check shows that new objects have been created or the attributes of objects that have already been connected have changed: Synchronize the data by importing missing objects or synchronizing existing objects.
- Assign objects to one another specifically or remove the assignment.

**Functional scope of Cats&Specs**

In the Cats&Specs area, the interface supports the following functionalities:

- Export of catalogs and pipe specs created in COMOS to PDMS
- Import from PDMS Cats&Specs to COMOS
- Central management of catalogs and pipe specs in COMOS, including modification of the imported pipe specs
- Use of AVEVA PDMS Cats&Specs in COMOS P&ID

### 3.2 Requirements

The following requirements have to be met in order to use COMOS PDMS Integration:

If one of the requirements is not met, contact your administrator.

**Software installed on the workstation**

- AVEVA PDMS 11.6 SP3 and higher
- Full version of COMOS Version 8.2 with AddOn B and higher
- Setup for COMOS PDMS Integration completed

**Citrix installation**

If a Citrix installation has been selected for COMOS and COMOS PDMS Integration, the following applies:

Every time you restart your computer you have to run the following macro before you can work with COMOS PDMS Integration:

"ComosCommandService.exe"
COMOS database

- All base data and standard tables required for the interfaces have been imported to the database.
- The configuration for the interface operations area has been completed.
- The configuration of the PDMS pipe specs has been completed.
- Please observe the following requirements for your project:
  - The project properties have been fully configured.
  - The interface has been activated for the project.
    If the interface was not activated, you can do this yourself. Information regarding this: see the link below.
  - By creating the construction objects and P&IDs you have starting the planning work.

In PDMS

The necessary UDAs are available.

See also

Activating COMOS PDMS Integration for PDMS (Page 75)

3.3 Activating COMOS PDMS Integration for PDMS

Activation of the interface is a basic requirement for working with COMOS-PDMS Integration.

Requirement

COMOS PDMS Integration has been activated in COMOS for the project. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Activating COMOS PDMS Integration for COMOS".
Procedure

To activate COMOS PDMS Integration for PDMS, proceed as follows:

- In the Design module:
  - Start the Design module.
  - Open the command line.
  - Enter the following call in the command line: "!!ITSetupComos()"
    Result: The "Comos" menu is available in the PDMS menu bar.
  - Activation COMOS PDMS Integration via the following command: "Comos > Interface > Start interface"

- In the Draft module:
  - Start the Draft module.
  - Continue as for the Design module.

- In the Paragon module:
  - Start the Paragon module.
  - Open the command line.
  - In the command line, enter the call "!!ITSetupComos()" or alternatively the call "!!CatsAndSpecs()".

Note

If you wish to use the additional functions, you must perform these steps every time you start PDMS or if you change a module.

Deactivating the interface

To deactivate the interface, proceed as follows:

In PDMS, in the Design and Draft modules:
1. Start the corresponding module.
2. Select the "Comos > Interface > Stop interface" command from the menu.
3.4 Operating mode

Online mode and offline mode

Two operating modes are available to you for COMOS PDMS Integration:

- **Online mode**
  - Both PDMS and the Construction Assistant or COMOS run in offline mode, and the interface is activated.
  - Full availability for the interface operations and Cats&Specs components.

- **Offline mode**
  - Only one of the applications runs in offline mode.
  - For Cats&Specs: Full availability.
  - For the interface operations component: No availability.

In both cases, COMOS and PDMS communicate via XML files that are stored in the communication path and in the exchange path and contain the necessary information.

In online mode the other program in each case is automatically informed that certain operations can be executed. In offline mode the user has to start these operations manually.

In this documentation

This documentation describes online mode.

3.5 Using interface operations

Availability of interface operations

Some interface operations are called within COMOS, others in PDMS. Some interface operations are available in both COMOS and PDMS.

The following section contains an overview of which interface operations exist and in which application they are available.

Interface operations that are called in COMOS

- "Export" and "Export to CE": Exports COMOS objects to PDMS.
- "Refresh" and "Custom Refresh": Refreshes the attributes of objects which are interconnected in COMOS and PDMS.
- "Assign": Connects objects that are available in both systems.
- "Add": Adds objects to the PDMS drawlist.
3.5 Using interface operations

- "Remove":
  Deletes objects from the PDMS drawlist.

- "Zoom":
  Performs a zoom operation for objects in PDMS.

- "Mark":
  Marks objects in PDMS.

- "Rerun documents":
  If the "Import DocLinks" operation could not be executed successfully for documents in PDMS: Repeats the import.

Interface operations that are called in PDMS

- "Export":
  Exports PDMS objects to COMOS.

- "Import DocLinks":
  Places COMOS objects from a PDMS draft drawing onto a COMOS document.

- "Query Comos data":
  Runs a query in COMOS and displays the result set in PDMS.

Interface operations that are called both in COMOS and in PDMS

- "Unassign":
  Releases existing connections between COMOS and PDMS objects.

- "Check status":
  Checks the status of connected objects.

- "Select"/"Navigate":
  Sets the current element in PDMS or navigates to the connected COMOS object.

3.5.1 Calling an interface operation

Application-specific

There are various procedures for calling an interface operation, depending on the respective application.

Calling an interface operation in COMOS

To call an interface operation in COMOS, select an interface object and select the required operation from the "PDMS > ..." context menu.

You can call this context menu from various places in COMOS.
• In the Navigator
• On a P&ID
• In a query

You can call the context menu for a single object (single selection) or for multiple objects (multiple selection).

Calling an interface operation in PDMS

In PDMS you can call interface operations from the following places:

• For the current element:
  Via the PDMS menu bar, "COMOS > CE > ..." menu.

• For one to any number of objects you specified in the "Export to Comos" window:
  Via the context menu in the result list in the "Export to Comos" window.

• The "Query Comos data" operation:
  Via the PDMS menu bar, "Comos > Interface > Query Comos data" menu, in the "Query Comos" window.

See also

Working in the "Export to Comos" window (Page 112)
Interface operations in COMOS (Page 85)
PDMS-side interface operations (Page 118)

3.5.2 Creating selection sets

3.5.2.1 Concept of the selection set

Definition

To create a selection set, call an interface operation. The interface operation is applied to the objects contained in the selection set.

Content of the selection set

Which objects belong to the selection set depends on whether you called the interface operation from COMOS or from PDMS.
3.5.2.2 Selection set for interface operations started in COMOS

Overview

If you call the interface operation from COMOS, the creation of the selection set depends on the point from which the context menu was called.

- In the Navigator
- On a P&ID
- In a query
- For a single object, i.e. using single selection
- For multiple objects, i.e. using multiple selection

In the Navigator at a single object

If you select a single object in the Navigator and select an interface operation in the context menu of the object, the selection set is created as follows:

- All objects located underneath the selected engineering object are processed recursively.
- All interface objects found during this run will be added to the selection set.
- If the in the Navigator selected object is also an interface object, it is also added to the selection set.
- If the in the Navigator selected object is a P&ID, all objects placed on the P&ID are added to the selection set. see further below.

Example:

If, as shown in the figure below, you select subunit T1 and select an interface operation there, the selection set shown on the right will be created. Requirement: Vessels, nozzles, pipes, and pipe branches are interface objects.
In the Navigator for multiple objects

If you select several objects in the Navigator and then select an interface operation in the context menu, the selection set is created as follows:

For every called engineering object, proceed as described in the previous paragraph.
Example:

On a P&ID for one or multiple objects

If you select one or more objects on a P&ID and then select an interface operation in the context menu, the selection set is created as follows:

- All interface objects from the selected objects are added to the selection set.
- If the selected object is a pipe segment and its pipe branch is an interface object, the pipe branch is added to the selection set.
  
  If the pipe branch belongs to the "Undef" class and the owner is an interface object, the owner is added to the selection set.
Example:

For a complete P&ID

If you select a P&ID in the Navigator and call the context menu, or call the context menu on an open P&ID without an object being selected on the P&ID, the selection set is created as follows:

It is assumed that all objects placed on the P&ID are selected. This means that all on the P&ID placed interface objects are added to the selection set.

In a query

If you use a query to perform an interface operation, select any number of objects in the query. Once you have selected the required objects, right-click to call the context menu and select the required interface operation.

This creates same selection set as when the objects in question are selected in the Navigator.

Location objects are handled separately. Depending on the operation, the objects are added to the selection set on the location or unit side. If an operation on the location view is called, the location objects are always inserted in the selection set.
3.5.2.3 Selection set for in PDMS started interface operations

Overview

Which objects are part of the selection set depends on where you called the interface operation:

- Via the "Comos > CE" menu:
  If the current element is an interface object, only the current element is part of the selection set.
- Via the context menu of the result list in the "Export to Comos" window.
- Via the "Comos > Interface > Query Comos data" menu.

Selection set via "Export to Comos"

The "Export to Comos" window appears if you have selected the "Comos > Interface > Export to Comos" menu.

In the window you define via the various settings which PDMS objects belong to the selection set.

Selection set via "Query Comos data"

The "Query Comos" window appears if you have selected the "Comos > Interface > Query COMOS data" menu.

In the window, make various settings to define the COMOS objects for which a query is to be started from PDMS.

See also

PDMS: "Export to COMOS" window (Page 112)
PDMS: "COMOS query" window (Page 117)
3.5.3 Interface operations in COMOS

3.5.3.1 "Export" operation

Purpose of the "Export" operation

The "Export" operation creates objects for the objects in the selection set in PDMS and connects them to the COMOS objects.

Call

To call the "Export" interface operation, select the "PDMS > Export" or "PDMS > Export to CE" command in the context menu.

Defining objects in the selection set

You can use the submenu of the context menu to select whether you want to export objects from the "TaggedItem" class only or from the "Pipe" class only.

- Submenu "... Export > TaggedItems":
  When you select this submenu, all objects in the selection set from the "TaggedItem" class are processed.

- "... Export > Pipes" submenu:
  When you select this submenu, all objects in the selection set from the "Pipe" class are processed.

If, after an initial verification, the selection set can only consist of objects from the "TaggedItem" or "Pipe" class, only the "... > TaggedItem" or "... > Pipes" command is offered in the context menu.

Furthermore, you can use the "Options > Export recursive" command in the context menu to define whether or not the interface objects located underneath interface objects in COMOS are also added to the selection set.

This functionality allows you, for example, to first export the pipes and then to transfer the pipe branches to PDMS via the P&ID at a subsequent point in time.
3.5 Using interface operations

Note

If the class of the pipe branch is "Undef", only pipes from the P&ID can be exported to PDMS.

Location objects

Location objects are only added to the selection set if the operation was started in the location view. If the "Export" operation is called for an object which is configured so that location objects are created, the following applies: Objects are only created in the location view if the corresponding PDMS object could be created. The object in the location view is connected with the PDMS object.

For example, if pipe Z001 creates location objects, the following situation will arise if the pipe has been created twice under different zones in PDMS:

Retaining the object structure

The "Export" operation preserves the structure, meaning that direct hierarchical relations in COMOS are mapped in PDMS.
For example, if vessels and nozzles are interface objects, when the vessel is exported, the nozzles of the vessel are exported as well. In PDMS, the nozzles are then also created underneath the PDMS object created for the vessel.

Insertion point in PDMS

When you run the "PDMS > Export to CE" command, the objects from the selection set are created below the current element in PDMS.

When you run the "PDMS > Export" command, the PDMS object below which the objects are to be created is determined as follows:

- If the object is to be created in PDMS underneath a zone, the name of the PDMS object is generated through a mapping defined in the configuration.
- If the owner is not a zone, the potential owner in PDMS can be determined by checking if the owner in COMOS is connected to a PDMS object.

If this is the case, the object is created underneath this PDMS object. This rule is not applied when the owner of the object is contained in the selection set. In that case the hierarchical relation in COMOS takes precedence.

Result in PDMS

- The corresponding PDMS objects are created if this is possible.
- The objects that were created in PDMS are connected to the corresponding COMOS objects.
- Data exchange is performed at attribute level for the objects that were just connected.
- If an object already exists in PDMS, it is not connected and no data exchange is carried out at attribute level either.
- Afterwards, the attributes of the connected objects which are relevant for a status check are compared with one another as specified in the configuration. See also section "Check status" operation (Page 99).
- A status is calculated for all objects in the selection set.
Preconditions in PDMS

- In order to create an object in PDMS, the following conditions must be met:
  - The corresponding owner restriction rules must be met.
  - You have write rights in PDMS which enable you to create an object underneath a specified object.
  - The object underneath which the object to be created is supposed to be generated must exist.
  - The object to be exported must not yet exist on the PDMS side.

- In the case of single selection, you can place the object in 3D space by determining a position point in PDMS (ID @) with the help of the cursor.
  For this, the following conditions must be met:
  - The object is not a pipe component
  - The object has a position (attribute position)

Note

The "Export" and "Export to CE" interface operations do not create any Sites in PDMS. However, zones are created if necessary when Export is called.
Flow diagram

The following diagram illustrates the sequence of the "Export" interface operation:
3.5.3.2 "Refresh" operation

Purpose of the "Refresh" operation

The "Refresh" operation updates already connected objects at the attribute level.

Call

To call the "Refresh" interface operation, select the "PDMS > Refresh" command from the context menu.

Note

Refresh attributes configuration

During configuration, if possible you should ensure that the object names and the connection information for this operation do not change. This is reserved for operations such as "Export" and "Assign", which function at the object level.

Selection set

The following objects are not included in the selection set:

- Interface objects which do not contain any connection information
  Reason: A corresponding PDMS object for attribute exchange cannot be found for these objects.
- Objects which do have connection information but for which a corresponding PDMS object cannot be determined
- COMOS objects which create location objects
  Reason: Only COMOS objects which are connected are considered for inclusion in the selection set. These objects are not. However, the location objects created by this object are inserted.

Result

- The attribute values are exchanged in both directions as specified in the configuration.
  Whether the attribute value of the COMOS object is written to an attribute of the corresponding PDMS object or vice versa is also set in the configuration.
- If the user has no write rights for a corresponding PDMS object, only the attributes on the COMOS object are updated.
- Once the data exchange is complete, the status of the objects in the selection set is checked. Here only attribute values that were either transferred from COMOS to PDMS or vice versa are considered. See also section "Check status" operation (Page 99).
Flow diagram

The following diagram illustrates the sequence of the "Refresh" interface operation:

![Flow diagram](image)

3.5.3.3 "Custom Refresh" operation

**Purpose of the "Custom Refresh" operation**

User-defined attribute values are exchanged with the "Custom Refresh" operation.

In the "Comos Custom Refresh" window you define which attributes are to be refreshed. Information regarding the configuration of the "Comos Custom Refresh" window: See also Section "Comos Custom Refresh" PDMS window (Page 181).

**Call**

To call the "Custom Refresh" interface operation, select the "PDMS > Custom Refresh" command from the context menu.

**Selection set**

The operation can only be performed for a single COMOS object. In other words, the selection set only contains one object.
Configuring the "Comos Custom Refresh" window

When you call the "Custom Refresh" operation in COMOS, the interface relinquishes control to PDMS. The "Comos Custom Refresh" window then opens automatically.

**Procedure**

To define which object attributes are updated, proceed as follows:

1. Select an attribute in the "Attribute" column.
2. Right-click in the list line of the required attribute to open the context menu.
   - Command "Update > Yes": The attribute is updated.
   - Command "Update > No": The attribute is not updated.
3. Repeat step 2 for all attributes whose update settings you want to define.
4. Click "OK".

**Result**

The attributes of the PDMS object and of the COMOS object are updated according to your settings.

### 3.5.3.4 "Assign" operation

**Purpose of the "Assign" operation**

You use the "Assign" operation to connect two objects that already exist in COMOS and PDMS. The operation sets the connection information at both objects and matches the names.
The operation is available in two variants:

- "PDMS > Assign> Match Names"
- "PDMS > Assign> Selected object"

The two variants differ according to the way in which a PDMS object is identified by a given COMOS object.

**Call**

To call the "Assign" interface operation, select the "PDMS > Assign" command from the context menu.

**Requirement**

In order to connect objects after identification of the PDMS object, the following conditions must be met:

- There must not yet be any connection information available at the PDMS object.
- The element type specified at the COMOS object must match the element type of the PDMS object.
- The owner restrictions must be met.
- The user who called the operation must have write rights for the PDMS object in PDMS.

**Result**

- The PDMS objects that are found are connected to the corresponding COMOS objects.
- Data exchange is performed at the attribute level for the objects connected.
- Afterwards, the attributes of interconnected objects that are relevant for a status check according to the configuration are compared.

"Assign> Match Names"

When the "Assign > Match Names" command is called, the connection to the PDMS object is established via the name generated by the subclass of the COMOS object.

If the interface finds an object with this name in PDMS, it tries to connect this PDMS object to the COMOS object. As the names have already been matched, the interface simply sets the connection information.
Example:

The name that is created via the subclass can contain name parts that are determined in PDMS. Depending on where this name part is taken from, many different names can be generated from this mask.

In this regard, two scenarios must be considered:

- **Case 1:** The COMOS object does not create location objects
  Details: See below.

- **Case 2:** The COMOS object does create location objects
  Details: See below.

"Assign> Match Names" without location objects

If the COMOS object at which the "Assign > Match Names" command was called does not create any location objects, the assignment via the generated name is not unique.

Consequence: The COMOS object is connected to the first PDMS object whose name matches the evaluated mask. This does not necessarily need to be the expected PDMS object.

The configuration is wrong at this point and must be corrected.

Example:

A COMOS object is configured in such a way that the name mask between the two name parts "B001-" and "-1" uses the value of the owner's "Function" attribute: "/B001-%Function%-1"
In the case described in the figure below, "%Function%" is replaced with the value of the Function attribute of the zone. As a result, the assignment is not unique. Both "/B001-K01-1" and "/B001-K02-1" fulfill the condition:

"Assign> Match Names" with location objects

If the COMOS object at which the "Assign > Match Names" command was called creates location objects, the following applies:

All PDMS objects that are found are connected to COMOS objects. These COMOS objects can be found in the Navigator on the "Locations" tab. If they do not yet exist, they are created. You are given a reference to the object on the "Units" tab for which you called the operation.

Example:

Pipes are configured in such a way that they create location objects and have the "Z001" and "/Z001-%function%-1" masks. This mask is sufficient in PDMS for pipes "/Z001-K1-1" and "/Z001-K2-1".

Two location objects are created when the "Assign > Match Names" command is called. The location objects are connected to the corresponding PDMS objects and each location object has a reference to the "Z001" pipe:

This is behavior intentional. For example, the name mask can be generated in such a way that a name part comes from the object underneath which the to be found object is located. This makes it possible to separate a pipe that passes through various zones in PDMS into multiple parts in COMOS.
In other words, for objects which create location objects, the following applies:

- If the operation was called in the unit view, the object is added to the selection set.
- If the operation was called in the location view, the name is not generated via the subclass; instead, the name of the COMOS object matches the name of the corresponding PDMS object.

**Note**

If the names of location objects and of the PDMS objects which are connected to them was only manipulated using interface operations, the names will match.

"Assign > Selected object"

You can call the "Assign > Selected object" command only for single-element selection sets. The command connects the COMOS object at which you called the operation to the current element in PDMS.

If the name of the current element does not match the name generated by the subclass of the COMOS object, you can choose to accept a change of the name at the PDMS object or to abort the process completely.
Flow diagram

The following diagram illustrates the sequence of the "Assign" interface operation:

3.5.3.5 "Unassign" operation

Purpose of the "Unassign" operation

You use the "Unassign" operation to release the connection between COMOS objects in the selection set and the connected PDMS objects.

This assumes that the COMOS objects in the selection set are exclusively those whose connection information is defined. Furthermore, this means that for COMOS objects that create location objects, the location objects are added to the selection set.
3.5 Using interface operations

Call

To call the "Unassign" interface operation, select the "PDMS > Assign> Unassign" command from the context menu.

Result

For all objects in the selection set, the connection information is deleted regardless of whether the counterpart is found in PDMS or not.

If the PDMS counterpart is found, the connection information at the PDMS object is also deleted.
Flow diagram

The following diagram illustrates the sequence of the "Unassign" interface operation:

3.5.3.6 "Check status" operation

Purpose of the "Check status" operation

When you select the "Check status" operation, the status of the objects from the selection set on the object level and attribute level is recalculated:

- At object level:
  A check is carried out to ascertain whether a connected PDMS object can be found for a given COMOS object.
- At attribute level:
  All attribute values designated for data matching via the configuration are compared in COMOS and PDMS.

The result of the status comparison is displayed in color in COMOS and in PDMS.

Call

To call the "Check status" interface operation, select the "PDMS > Check status" command from the context menu.
Result

- The status of the objects from the selection set is recalculated at the object level. The following results are possible:
  - The connection information is missing at the COMOS object:
    Status = "Not available in PDMS"
  - Connection information exists at the COMOS object, but no PDMS object can be identified via the connection information:
    Status = "Deleted in PDMS"

- Finally, the correctly connected objects are recalculated on the attribute level.
- During data matching at attribute level, all attribute values designated for data matching via the configuration are compared in COMOS and PDMS. The following results are possible:
  - One or a number of attribute pairs are found with different values:
    Status = "Inconsistent"
  - All to be compared attribute values match:
    Status = "OK"

- Once the status has been calculated for all COMOS objects, the calculated status is set in COMOS for each object. Finally, the status for the corresponding PDMS objects that were found is set to "UDA :ComosStatus".

- Finally, the status display is activated in COMOS.

The status display in COMOS

If the status display is activated in COMOS, the objects are displayed in COMOS with their color indicating their status. The status display of the objects provides a visual overview of the current status of the checked objects.

The same color display is also available on the P&ID on which the objects are placed.

Color-coded status display

In the COMOS DB, the following colors are set by default for the status display for COMOS PDMS Integration:

- Blue: Status = "Not available in PDMS"
- Yellow: Status = "Deleted in PDMS"
- Red: Status = "Inconsistent"
- Green: Status = "OK"

You have the option of modifying the color codes:
1. Right-click on an empty location in the Navigator.
2. Select the "Legend" command from the context menu.
   
   Result: The "Color settings" window opens. It shows the color assignment for the currently active status display.
3. On the "Color settings" tab, make settings to define which status value is represented by which color.

**Activating/Deactivating the status display**

To deactivate or reactivate the status display, proceed as follows:

1. Right-click on an empty location in the Navigator.
2. Select the "Status display > Switch off" command from the context menu.

To reactivate the status display, proceed as follows:

1. Right-click on an empty location in the Navigator.
2. Select the "Status display > 18 Comos <- XML -> PDMS > Complete" or "For current user" command from the context menu.

**Detailed status information in the status query**

To provide you with detailed information on the status of the objects, a query that describes the status of the objects in greater detail has been prepared in the COMOS DB. Proceed as follows to open this query:

1. Right-click on an empty location in the Navigator.
2. Select the "Status display > 18 Comos <- XML -> PDMS > Status per XML file" command from the context menu.

   Result: The query opens.

The query contains all objects that were checked in the last cycle.

The query has the following columns:

- "Object" column: The name of the checked object
- "Status value" column: The status value of the object
- "Description" column: The reasons that led to the status value
### Flow diagram

The following diagram illustrates the sequence of the "Check status" interface operation:

![Flow diagram](image)

#### 3.5.3.7 "TopologyCheck" operation

**Purpose of the "Topology Check" operation**

Where individual pipes including their pipe branches and components exist in both COMOS and PDMS, the "TopologyCheck" operation compares them to check their consistency.

A pipe is consistent if all its associated pipe branches plus connection information are available and consistent in PDMS.

A pipe branch is consistent if the sequence of the associated components matches that of the connected pipe branch.

**Relevant pipes**

Objects which satisfy the following conditions are defined as relevant pipes:

- The object is of type "Pipe".
- The object has an "E3D" tab.
The "PDMSElementType" of the object is "PIPE".

The object is linked to an object in PDMS.

Call

To call the "TopologyCheck" interface operation, proceed as follows:

1. In the Navigator context menu, select the "Status display > Topology check Comos <-> PDMS > Complete" command.
2. In the Navigator or on a P&ID document, select the objects for which you wish to perform a comparison.
3. Select the "Calculate status" command from the Navigator context menu.

Result

- Once the corresponding status display has been activated, the objects appear in the Navigator colored according to their status.
- The result of the comparison can be shown in a status query in the working area. Select the "Status display > Topology check Comos <-> PDMS > Status per XML file" command from the context menu.

Status values of calculated objects

After calculation, an object can adopt any of the following status values:

<table>
<thead>
<tr>
<th>Status value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;OK&quot;</td>
<td>The object under consideration and its counterpart are consistent.</td>
</tr>
<tr>
<td>&quot;Not available in PDMS&quot;</td>
<td>The object linked to the object under consideration is not available in PDMS.</td>
</tr>
<tr>
<td>&quot;Not available in Comos&quot;</td>
<td>An object with link information exists in PDMS but it has no counterpart in COMOS.</td>
</tr>
<tr>
<td>&quot;Inconsistent&quot;</td>
<td>For pipes: One or more of the pipe branches the pipe contains are inconsistent or unavailable in PDMS. For pipe branches: One or more of the components the pipe branch contains is inconsistent or unavailable in the counterpart. For components: The positioning of the component in the sequence defined in COMOS does not match the positioning defined by PDMS.</td>
</tr>
</tbody>
</table>
3.5.3.8 "Rerun documents" operation

Purpose of the "Rerun documents" operation

The "Rerun documents" operation is based on the "Import DocLinks" operation. The "Import DocLinks" operation is called in PDMS. It creates DocObjs for draft objects under a COMOS document specified in the draft structure.

If the "Import DocLinks" operation is called in PDMS, you cannot always be sure that the specified document already exists in COMOS. In this case the XML file remains in the documents folder which was entered in the project properties. Otherwise, it is moved to the "Imported" subfolder.

"Rerun documents" processes all in the documents folder remaining XML files again.

If you were not able to perform the "Import DocLinks" operation because the corresponding document did not yet exist in COMOS, you can create the document in COMOS and then call "Rerun documents" to import the missing DocLinks.

Call

To call the "Rerun documents" operation, select the "PDMS > Documents > Rerun" command from the context menu.

Result

The interface tries to localize the corresponding document for all XML files:

- The document is found: The DocLinks are created and the file is moved to the "Imported" folder.
- The document does not exist: The XML file remains in the documents folder.
Flow diagram

The following diagram illustrates the sequence of the "Rerun documents" interface operation:

See also

"Import DocLinks" operation (Page 127)

3.5.3.9 3D view operations

Call

To call a 3DView operation, select the required operation from the following context menu submenu: "PDMS > 3D-View > ..."
Here you will find the following operations:

- "Add"
- "Remove"
- "Mark"
- "Zoom"
- "Select"

See also

"Add" operation (Page 106)
"Remove" operation (Page 107)
"Mark" operation (Page 108)
"Zoom" operation (Page 109)
"Select" operation (Page 110)

3.5.3.10 "Add" operation

Purpose of the "Add" operation

You can use the "Add" operation to add objects to the PDMS Drawlist. This corresponds to the "Add" functionality in PDMS.

Selection set

Only objects with connection information are added to the selection set. If a COMOS object creates location objects, the object itself is not added to the selection set; only its location objects are added.

Result

For all objects in the selection set, the operation checks whether a connected PDMS object exists. If the operation finds the PDMS object, it is added to the Drawlist in PDMS.
**Flow diagram**

The following diagram illustrates the sequence of the "Add" interface operation:

![Flow diagram image]

### 3.5.3.11 "Remove" operation

**Purpose of the "Remove" operation**

You can use the "Remove" operation to remove objects from the PDMS Drawlist. It corresponds to the "Remove" functionality in PDMS.

**Selection set**

Only objects with connection information are added to the selection set. If a COMOS object creates location objects, the object itself is not added to the selection set; only its location objects are added.

**Result**

For all objects in the selection set, the operation checks whether a connected PDMS object exists. If the PDMS object is found, it is removed from the Drawlist in PDMS.
Flow diagram

The following diagram illustrates the sequence of the "Remove" interface operation:

3.5.3.12 "Mark" operation

Purpose of the "Mark" operation

You use the "Mark" interface operation to mark objects in PDMS. It corresponds to the "Mark" functionality in PDMS.

Selection set

Only objects with connection information are added to the selection set. If a COMOS object creates location objects, the object itself is not added to the selection set; only its location objects are added.

Result

For all objects in the selection set, the operation checks whether a connected PDMS object exists. If the PDMS object is found, it is marked in PDMS.
3.5.3.13 “Zoom” operation

Purpose of the “Zoom” operation

You use the “Zoom” interface operation to zoom to objects in PDMS.

Selection set

Only objects with connection information are added to the selection set. If a COMOS object creates location objects, the object itself is not added to the selection set; only its location objects are added.

Result

For all objects in the selection set, the operation checks whether a connected PDMS object exists. If the PDMS object is found, it is added to the Drawlist in PDMS. Then, the viewport in PDMS is set up so that the objects are visible and zooming is applied this area.
3.5 Using interface operations

Flow diagram

The following diagram illustrates the sequence of the "Zoom" interface operation:

3.5.3.14 "Select" operation

Purpose of the "Select" operation

The interface provides you with a number of variants on the "Select" operation, which you use to select a PDMS object from COMOS.

The variants differ in the manner in which the to be selected object is identified in PDMS.

- "... > Select > Connected object"
  
  If a PDMS object with corresponding connection information exists and also have same names, this PDMS object is selected.

- "... > Select > By RefNo"
  
  If a PDMS object with corresponding connection information exists, this PDMS object is selected.

- "... > Select > By Name"
  
  If a PDMS object with the same name is found, this PDMS object is selected.

Call

To call the "Select" interface operation, in the context menu, select a variant of the operation from the "PDMS > 3D View > Select" submenu.

Selection set

The operations are only available for single-element selection sets.
Result

When the corresponding PDMS object for a COMOS object is found, it is selected in PDMS (in other words, the object becomes the current element in PDMS).
3.5 Using interface operations

Flow diagram

The following diagram illustrates the sequence of the "Select" interface operations:

3.5.4 PDMS: "Export to COMOS" window

3.5.4.1 Working in the "Export to Comos" window

Purpose

In the "Export to Comos" window, you set various filters and options to define a set of PDMS interface objects. In a further step you then execute an interface operation.
Note

Only objects that meet one of the following conditions are considered here:

- **Objects to which a subclass has been assigned**
  
  This means that the ":ComosSClass" UDA must contain the name of a valid subclass as a value.
  
  Reason: The objects that are added to the selection set are filtered on the basis of their ":ComosSClass" UDA.

- **Objects whose PDMS element type is the same as one of the PDMS element types that were entered in COMOS at the subclass selected in the "Object Type" field.**

  During the operation, the interface automatically sets the ":ComosSClass" UDA at these objects.

Procedure

To work in the "Export to CE" window, proceed as follows:

1. Select the following menu in PDMS: "Comos > Interface > Export to CE"

   Result: The "Export to CE" window opens.

2. Configure the "Select" area.

   See also Section Configuring the "Export to Comos" window (Page 115).
3. Optionally: Configure the following filters:
   - The filters of the "Standard Filter" area
   - The filters of the "Filter Assigned" area
   See also Section PDMS: "COMOS query" window (Page 117).

4. Click the "Find" button in the "Select" area.
   Result:
   - Your entries and filters are evaluated.
   - A result list is displayed in the "PDMS Objects" area.

5. Optionally:
   - Right-click anywhere in the result list in the "PDMS Objects" area.
   - Select the "Filters > …" command from the context menu and filter the result list on the basis of the values offered in the submenus.
     Information regarding the configuration of these filters: see the link below.

6. Mark one or more objects in the result list and call the context menu.

7. Select one of the following commands from the context menu:
   - "Export"
   - "Unassign"
   - "Reassign"
   - "Check status"

Other functions of the "Export to Comos" window
If object are already displayed in the result list, the context menu of the list will also offer the following functions:
- "Select All":
  Selects all objects in the result list.
- "Navigate in PDMS":
  Activated: When you select an object in the result list, it is simultaneously selected in the Design Navigator in PDMS.
- "Navigate in COMOS":
  Activated: When you select an object in the result list, the "Select" interface operation is called simultaneously.
  Result: If the object is connected with a COMOS object, the connected COMOS object is also selected in COMOS.
- "Add to Drawlist":
  Adds the currently selected objects to the PDMS Drawlist.
This function makes it easier for you to work with the window or with the interface.
See also

"Export to COMOS" PDMS window (Page 182)

3.5.4.2 Configuring the "Export to Comos" window

The "Export to COMOS" window consists of the following control groups, in which you can make settings. See also Section "Export to COMOS" PDMS window (Page 182).

- "Select"
- "Standard Filter"
- "Filter Assigned"
- "PDMS Objects"

Procedure

1. In the "Select" control group, specify the basic settings for filtering the result list.
2. In the "Standard Filter" control group, filter the result list on the basis of specific texts.
3. In the "Filter Assigned" control group, filter the result list on the basis of the connection information.

4. In the "PDMS Objects" control group, filter the attribute columns of the result list on the basis of specific values.
   - Right-click on any location in the result list
   - Select the "Filter > ..." command from the context menu.
     Result: All attributes your administrator has set as filters are offered in the submenu.
   - Select an attribute.
     Result: The submenu displays the values that the currently in the list contained objects exhibit for the selected attribute.
   - Select one or more values.
   - Repeat steps 1 to 4 for any number of attributes.

Result:
Only the objects that have the attribute values you selected remain visible in the result list.

Example:
3.5.5 PDMS: "COMOS query" window

3.5.5.1 Configuring the "Query Comos" window

Procedure

To configure the "Query Comos" window, proceed as follows:

1. Select the "Comos > Interface > Query Comos data" command from the PDMS menu bar.
   Result: The "Query Comos" window opens.

2. Configure the "Query" tab.
   See also Section "Query COMOS" PDMS window (Page 184).

3. Configure the "Filters" tab.
   See also Section "Query COMOS" PDMS window (Page 184).
   See also Section Defining filters (Page 117).

4. Configure the "Execute" tab.
   See also Section "Query COMOS" PDMS window (Page 184).

3.5.5.2 Defining filters

Procedure

1. Open the "Filters" tab.

2. Select a line in the "Columns" area.

3. Select the "Add filter for this column" command from the context menu.
   Result: The "Filter" area is activated.

4. Select an operator from the "Operator" list in the "Filter" area and enter a filter criterion in the "Criteria" field.
   Information regarding operators: See below.

Result

- The filter is added to the "Filters" area:
  - "Column" column: The name of the column for which you defined a filter
  - "Operator" column: The operator you defined for this column
  - "Criteria" column: The criterion you defined for this column

- The operator and the criterion are applied to every line of the query. The line is not added to the result file if the value of the column entered in "Column" does correspond to the filter.
Removing filters

1. Open the "Filters" tab.
2. Select a line in the "Columns" area.
3. Select the "Remove filter for this column" command from the context menu.

Result

All filters defined for this column are removed.

3.5.5.3 Executing the COMOS query

Procedure

Information on how to start the COMOS query you have selected:
See also chapter "Query COMOS data" operation (Page 125).

Result

Once the query has been executed in COMOS, the result of the operation is displayed on the "Results" tab in the "Query COMOS" window. See also chapter "Query COMOS" PDMS window (Page 184).

3.5.6 PDMS-side interface operations

3.5.6.1 Operations on the current element

The following interface operations are available for the current element:
- "Navigate"
- "Unassign"
- "Reassign"

3.5.6.2 "Navigate" operation

Purpose of the "Navigate" operation

You can use the "Navigate" operation to navigate from the current element in PDMS to the object connected in COMOS.
Call

To call the "Navigate" operation, select the "Comos > CE > Navigate" command from the PDMS menu bar.

Requirement

The current element is connected to a COMOS object.

Complete connection information is not mandatory

The COMOS object is identified only via the system UID. During this operation, other connection information such as Name or RefNo is not considered.

When an object is found in COMOS, this does not necessarily mean that it is fully connected to the current element.

Flow diagram

The following diagram illustrates the sequence of the "Navigate" interface operation:

3.5.6.3 "Unassign" operation at the CE

Purpose of the "Unassign" operation

You can use the "Unassign" operation to release the connection between the current element and its connected COMOS object.

If the current element is potentially connected, its connection information is deleted regardless of whether or not a corresponding object is found in COMOS.

Call

To call the "Unassign" operation, select the "Comos > CE > Unassign" command from the PDMS menu bar.
3.5.6.4 "Reassign" operation

Purpose of the "Reassign" operation

The "Reassign" operation updates the location pointer of the connected COMOS object.

Call

To call the "Reassign" operation, select the "Comos > CE > Reassign" command from the PDMS menu bar.

Requirement

The current element must be connected to a COMOS object which has a reference to a location in the COMOS location tree.

Application example

The COMOS object "U1 > H1 > T1 > B001" is connected to the PDMS object "/U1H1T1B001".

The configuration of the subclasses specifies that the COMOS object has a reference to a location which corresponds to the SITE-ZONE structure in PDMS.

Once you have moved the PDMS object to a different ZONE in PDMS, call the "Reassign" operation.

Result: The reference of the COMOS object is updated so that it corresponds to the new SITE-ZONE structure.
The following figure illustrates this process:

Flow diagram

The following diagram illustrates the sequence of the "Reassign" interface operation:

3.5.6.5 Operations that are called in the "Export to Comos" window

In the "Export to Comos" window you can call the following interface operations for objects in the result list:

- "Export"
- "Unassign"
- "Reassign"
- "Check status"

The following commands are also available:

- "Select all"
- "Navigate in PDMS"
- "Navigate in Comos"
- "Add to Drawlist"
3.5.6.6 "Export" operation

Purpose of the "Export" operation

The "Export" operation in PDMS is the opposite of the "Export" operation in COMOS. If COMOS objects corresponding to PDMS objects are missing, these are created and connected.

Call

To call the "Export" operation, proceed as follows:

1. Select the following menu in PDMS: "Comos > Interface > Export to CE"
2. Configure the "Export to Comos" window so that a result list containing PDMS objects is displayed in the "PDMS-Objects" area. Information regarding configuration: see the link below.
3. Select the objects you want to export, then select the "Export" command from the context menu.

Result

- The corresponding COMOS objects are created whenever possible. In the configuration you can define where in COMOS the objects are created.
- The objects that were created in COMOS are connected to the corresponding PDMS objects. The objects are updated at the attribute level.
- If an object already exists in COMOS, it is not connected. No data exchange takes place either.
3.5 Using interface operations

Flow diagram

The following diagram illustrates the sequence of the "Export" interface operation:

![Flow diagram]

See also

Configuring the "Export to Comos" window (Page 115)

3.5.6.7 The "Unassign" operation in the "Export to CE" window

Purpose of the "Unassign" operation

The operation deletes the connection information for all objects in the selection set regardless of whether a corresponding object is found in COMOS.

It has the same effect as the operation which is called in the PDMS menu by selecting the "Comos > CE > Unassign" command. The only difference is that the operation is applied to all objects in the selection set.

Procedure

To call the "Unassign" operation, proceed as follows:

1. Select the following menu in PDMS: "Comos > Interface > Export to CE"

2. Configure the "Export to Comos" window so that a result list containing PDMS objects is displayed in the "PDMS-Objects" area. Information regarding configuration: see the link below.

3. Select the objects whose connection information you want to delete, then select the "Unassign" command from the context menu.
Flow diagram

The following diagram illustrates the sequence of the "Unassign" interface operation:

Purpose of the "Check status" operation

Unlike the "Check status" operation which is available in COMOS, the operation is called for a selection set of objects in PDMS. The operation also allows you to identify PDMS objects to which no COMOS object has been assigned.

The operation checks whether the objects in the selection set have connection information and performs a data matching at the attribute level for the connected objects.

Procedure

To call the "Check status" operation, proceed as follows:

1. Select the following menu in PDMS: "Comos > Interface > Export to CE"
2. Configure the "Export to Comos" window so that a result list containing PDMS objects is displayed in the "PDMS-Objects" area.
3. Select the objects whose status you wish to check, then select the "Check Status" command from the context menu.
Flow diagram

The following diagram illustrates the sequence of the "Check status" interface operation:

See also

"Check status" operation (Page 99)
Configuring the "Export to Comos" window (Page 115)

3.5.6.9 "Query COMOS data" operation

Purpose of the "Query Comos data" operation

From within PDMS, you can configure a query that was predefined in COMOS, start it, and view the result in PDMS.
Call

To call the "Query Comos data" operation, proceed as follows:
1. Select the "Comos > Interface > Query Comos data" command from the PDMS menu bar.
   Result: The "Query Comos" window opens.
2. Configure the following tabs in the window:
   - "Query"
   - "Filter"
   - "Execute"
3. Go to the "Execute" tab and click the "Run Query" button.
   The "Query Comos data" operation is executed.

Result

You can view the following:
- Results of the query in Excel or in a web browser.
- A preview of the results of the query in the "Query Comos" window.
- Save the results of the query in a file.
- Should errors occur during execution of the query: Error log in the "Query Comos" window.
Flow diagram

The following diagram illustrates the sequence of the "Query Comos data" interface operation:

See also

Configuring the "Query Comos" window (Page 117)

3.5.6.10 "Import DocLinks" operation

Purpose of the "Import DocLinks" operation

The "Import DocLinks" operation creates DocObjs in COMOS for draft objects with a DDNM attribute.

Requirement

- The DDNM attribute references a design object which is connected to a COMOS object.
- Your administrator has defined an attribute or a UDA at one or a number of objects in the draft structure in which the name or the system UID of the document for which DocObjs are to be created is entered.
**Procedure**

To call the "Import DocLinks" operation, proceed as follows:

1. Open the "Draft" module in PDMS.
2. In the draft structure, select one of the nodes at which the attribute or the UDA controlled by the "Import DocLinks" operation is available.
3. Enter one of the following values in the attribute or the UDA at the node:
   - The name of the COMOS document for which you want to import DocObjs.
   - The system UID of the COMOS document for which you want to import DocObjs.
   The search process speeds up when you enter the system UID.
4. Select the following menu in PDMS: "Comos > Interface > Export to Comos"
   Result:
   - The "Export to Comos" window opens.
   - The structure of the window is virtually identical to the "Export to Comos" window in the Design module. However, in certain places the interface has been adapted to the "Import DocLinks" operation.
5. Configure the "Export to Comos" window as described below.
6. In the "PDMS-Objects" area, select the draft objects for which you want to create DocLinks.
7. Select the "Export DocLinks" command from the context menu.

**Configuration of the "Export to Comos" window**

To configure the "Export to Comos" window for the "Import DocLinks" operation, proceed as follows:

1. "Select" area:
   - "Dept.", "Regi.", Drwg." fields:
     If the "Track CE" option is activated: Set automatically, depending on which node was selected when the window was called in the draft structure.
   - "Object Type" list:
     Select one of the subclasses of the here listed "Document" class. The "Import DocLinks" then uses the for the subclass specified settings.

2. "Standard Filter" and "Filter Assigned" areas:
   Define filters for the objects in the result list. Information regarding this: see the link below.
3. "Select" area: Click the "Find" button.

Result:
All draft objects located below the selected node and meeting the criteria you defined are displayed in the "PDMS Objects" area.
Depending on how the subclass you selected is configured, the following objects may be filtered out of the result list:
- Objects without names.
- Objects whose owners do not comply with the owner restriction rules defined in the subclass.

4. Optionally: "PDMS Objects" area: Define filters for attribute values in the result list.

5. In the "PDMS Objects" area, select the objects for which you want to create DocObjs.

6. Select the "Export DocLinks" command from the context menu.

Result of the "Import DocLink" operation
- The interface uses the subclass you selected to determine the name or the system UID of the COMOS document for which DocObjs are created.
- If the subclass defines filters, these are also taken into account when searching for the document.
- The operation is aborted in the following cases:
  - If the interface finds more than one document with this name
  - If the interface does not find any documents with this name

Consequence:
- The XML file with the selection set remains in the documents folder which was specified in the project properties on the "PDMS interface/construction assistant" tab.
- The "Rerun Documents" operation allows you to create the DocObjs from within COMOS at a later point in time.
- Once the interface has found the document, DocObjs are created for the objects in the selection set.
- The XML file is moved from the documents folder to the "Imported" subfolder.
Flow diagram

The following diagram illustrates the sequence of the "Import DocLinks" interface operation:

See also

Working in the "Export to Comos" window (Page 112)

3.5.7 The Construction assistant

The Construction Assistant is an independent application that offers a limited number of COMOS standard functions as well as all the functions that are necessary for synchronizing your P&ID and 3D data in COMOS and PDMS.

With the exception of data exchange operations, the Construction Assistant is write-protected. This has the following consequences:

- You are not able to create or modify objects, reports or queries yourself.
  You can only indirectly create or modify objects by executing an interface operation.

- The project configuration must be carried out in COMOS.
  This applies to the configuration of the interface specific objects such as the 
  "@PDMSMAP" folder or the subclass definition objects, but also the standard configuration of base objects, the engineering structure, standard tables and so forth, which is done for every engineering object.
3.5.7.1 Starting the Construction assistant and opening

Procedure

To start the Construction Assistant, proceed as follows:

1. Click "Start > Run" in the Windows task bar.
2. Enter the path to your COMOS directory in the "Run" window and type Comos.exe/MD:CA in the input line:
   Example: C:\Comos\PT001_Vega\Bin\Comos.exe/MD:CA

Result

The Construction Assistant opens.

Changing the database or project

To open or change a database or to switch projects or working layers, click the "Open project" button which is displayed on the menu bar of the Construction assistant.

3.5.7.2 Overview: Components of the Construction assistant

View directly after starting

After opening the project you see two areas in the Construction Assistant:

- Upper area: The toolbar of the Construction Assistant
  The toolbar features a number of buttons which you can use to operate the Construction Assistant.
- Lower area: The COMOS Navigator
  Various COMOS Navigator tabs are displayed here.

See also

Construction assistant: Upper area (Page 190)

3.5.7.3 The Documents area

Purpose

The "Documents" area is a separate window which displays the contents of a COMOS report, the properties of an object, or the contents of a query.
Opening the "Documents" area

The window opens when you open a report or a query, or the properties of an object.

Content of the "Documents" area

It is possible to display a report, the properties, and a query at the same time: Their contents are displayed on tabs so that you can switch between the contents.

However, it is not possible to simultaneously display more than one report, the properties of multiple objects, or multiple queries.

3.5.7.4 Status information

Show status

You can display status information for the COMOS objects in the Construction Assistant.

Procedure

To activate the status display in the Navigator, proceed as follows:

1. Right-click on an empty location in the Navigator.
2. Select the "Status display > 18 Comos <-> XML -> PDMS > Complete" command from the context menu.

Result

The status display is activated and color-codes the objects according to the default settings.

3.5.7.5 Context menus

You control the interface using the context menu which you can access in the Navigator, in reports, and in queries.

The context menu contains various commands:

- General commands as in the full version of COMOS
  These include "Navigate", "Properties".
- Interface-specific commands
Interface-specific commands

The interface-specific commands are listed in the "PDMS > ..." context menu.

The commands are:

- "... > Options > Select automatically":
  - If selected: When you select an object in an open report, it is automatically selected in the Navigator.
- Commands which start interface operations for data exchange
  - Detailed information about interface operations: see the link below.

See also

Interface operations in COMOS (Page 85)

3.6 Using Cats&Specs

3.6.1 PipeSpecs

3.6.1.1 General

The pipe specs are located in the base project in the following node:

"@VIPER > @SPEC PipeSpec"

Making pipe specs PDMS-capable

In order to make the pipe specs "PDMS-capable", they must be expanded by the selectors and additional attributes:

- The selectors of the pipe specs are managed in the PipeSpec Designer and are created underneath a pipe spec.
  - See section Selectors (Page 134) and "Selector" tab (Page 189).
- The additional attributes are created on the "Attributes > E3D External 3D Interface" tab of the pipe spec. The tab is inherited from the following node:
  - See also section "External 3D Interface" tab (Page 188).

See also

Creating a new PDMS PipeSpec (Page 136)
3.6.1.2 Selectors

Structure

Selectors in COMOS are used for PDMS pipe spec mapping and the pipe spec export. The selector structure defines a sequence of questions, on the basis of the answers to which you can get to the concrete pipe part (manufacturer device).

The selector structure is inherited from the following base object:

"@VIPER > @Y > SelectorTree > @Selector"

The answers to the questions of the selectors are created on the "E3D External 3D Interface" tab of the PPC object or of the pipe spec element. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Export settings".

Answers for selectors

A selector consists of the following attributes:

- "Type":
  The selector type
  Possible values:
  - "Numeric"
  - "Text"
  - "PBOR"

- "Answer":
  The answer

- "MaxAnswer":
  The maximum value of an answer if this contains two values such as attributes of type "Edit: [Min Max]". The Min value is managed in the "Answer" field.

- "Next question"
  References the following selector or the associated attribute that supplies the value for it, such as "E3D.STYP", for example.

- "Default answer"
  Defines the default answer for the question.
Creating a new selector

To create a new selector, proceed as follows:

- In the Navigator, select the selector below which the new selector is to be located.
- Select the "Create next selector" command from the context menu of the selector.

This functionality is implemented at the base object via the "OnMenuCreate" and "OnMenuExecute" script functions with the following script:

```vba
If ID = "CreateSelector" Then
    Set NewSele = OwnElements.CreateNewWithName(Elements.NextName("Sele"))
    Set NewSele.CDevice = Me.CDevice
End If
```

Alternatively, the script can also be executed through the object debugger. It is not possible to create selectors through the programming interface.

- The "Name" and "Description" properties of the new selector must match the value of the "Next Question" attribute of the selector below which the new selector was created.

Create branched selector structure

Within the selector structure you can also branch to different selectors:

```
  XX:YY
  XX
  "Next Question" of the superordinate selector
  YY
  "Answer" of the selector
```

The name of the selector into which the branching is to be done has the following form: "XX:YY"

- "XX"
  "Next Question" of the superordinate selector
- "YY"
  "Answer" of the selector

The "Description" property must match the value of the "Next question" attribute of the superordinate selector.
3.6 Using Cats&Specs

3.6.2 PipeSpec Designer

3.6.2.1 Characteristics of PDMS PipeSpecs

No preferred components

In contrast to the standard pipe specs in COMOS, there are no preselected components for PDMS pipe specs. Consequently, the preselected components are also missing in the PipeSpec Designer on the "Nominal diameters" and "Branch table" tabs. The pipe parts are structured according to their GTypes.

See also section PipeSpecs (Page 133).

3.6.2.2 Creating a new PDMS PipeSpec

Procedure

To create a PDMS pipe spec from scratch, proceed as follows:

1. Select the "Administrator > Base data > Pipe specs" menu command.
2. On the "Pipe spec management" tab, click the "..." button next to the "Pipe spec" field.
3. Select the "Engineering project" tab in the "Load pipe spec" window.
4. In the toolbar of the "Load pipe spec" window, click the arrow of the "New" button and select the "PDMS pipe spec" command in the menu.

Alternative method

In the "Load pipe spec" window, select the "@Spec > PDMS" node on the "Engineering project" tab, and select the "New > PDMS pipe spec" command in the context menu.

Result

The PDMS pipe spec is created.

You find additional information on this topic in the "PipeSpec Designer" Manual.

Differences from the COMOS pipe spec

When you create PDMS pipe specs, the following objects are created underneath the pipe specs in addition to the usual ones:

- Selectors
  See also section Selectors (Page 134).
- "E3D External 3D Interface" tab
  See also section "E3D External 3D Interface" tab (Page 188)
Creating a PDMS pipe spec from a COMOS pipe spec

To create a PDMS pipe spec from an existing COMOS pipe spec, copy the selector structure under the COMOS pipe spec and copy the "ED3 External 3D Interface" tab to the pipe spec.

3.6.2.3 Adding Pipe Part Components to the PDMS PipeSpec

Procedure

To add a pipe spec element to a PDMS pipe spec, proceed as follows:

- Open the PipeSpec Designer and switch to the "Components" tab.
- In the base data, navigate to the PPC object which is to belong to the pipe spec.
- Drag&drop the PPC object to the "Components" tab of the PipeSpec Designer:

Result

- The object becomes a pipe spec element.
- Object properties, "E3D External 3D Interface" tab, "E3D.PDMSList" attribute: Value = "1" (=Generate name): A window for the name generation opens. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Name generation window".

Note

A separate window for name generation appears for each pipe spec element that is created in the PDMS pipe spec.

Special case pipe (TUBE)

When you drag a pipe into the PDMS pipe spec, COMOS automatically creates two pipe spec elements. These differ in the "SHOP" selector:

- Once with the value "TRUE"
- Once with the value "FALSE"

If you only want to create one pipe in all cases (with selector "SHOP"="TRUE"), then you must manually add the following attribute to the pipe object in the PPC on the "E3D External 3D Interface" tab:

Attribute "E3D.SHOPSingle" with value = 1
3.6.2.4 Tab "Selector"

Procedure
To change the sequence of the selectors, move the columns of the selectors within the table using drag&drop. Proceed as follows:

1. Click on the column header of the selector you want to move.
   The column header is marked.
   
   **Note**
   You can also move several columns together:
   - Press and hold down the <Shift> key.
   - Click the column headers one after another with the left mouse button until all columns are selected.

2. Click on the marked column header and hold down the left mouse button.
   The column header sticks to the mouse pointer. An insertion mark appears.
3. Move the mouse pointer and hence also the insertion mark to the point to which you want to move the column.
   
   **Note**
   The marked columns must always be inserted behind the insertion mark.

4. Release the mouse button.
   The selector is moved to the desired point. The selector structure for the GType is updated accordingly in the pipe spec:

See also
"Selector" tab (Page 189)
3.6.2.5 Creating new selectors

Procedure

To create a new selector, proceed as follows:

1. Click in the selector column behind which the new selector is to be created and select the "Selector > New" command from the context menu.

   The "Define question for new selector" window opens.

2. Enter the question for the selector in the "Question" field. Specify the attributes tab and the attribute, e.g. "E3D.RADI".

3. Confirm your entry with "OK".

---

Note

If the selector exists already, the "OK" button is deactivated so that the selector cannot be created twice.

---

Deleting selectors

To delete a selector, click in the corresponding column of the selector table and select the "Selector > Delete" command from the context menu.

See also

"Selector" tab (Page 189)
3.6.2.6 Detail area

Structure of the detail area

When you click on a selector column in the table, the detail area under it is updated. The detail area contains the following fields:

- "Selector type" list
  Possible values:
  - "Numeric"
  - "Text"
  - "PBOR"
  For example, the value "PBOR" is to be set for the "PBOR0" default column.

- "Question" field
  Name of the tab and of the attribute for the selector of the following column, such as "E3D.RADI". This thus specifies the sequence of the relationship.

Note

The "Question" field of the column always relates to the following selector. In the "Name" column the "Question" field has, for example, the value "PBOR0", since the following column displays the nominal diameter. Consequently the "Question" field is blank for the last column.

- "Default answer" field
  This should only be set if a default answer is meaningful. Pipe parts with this answer are then preferred.

- "Selector" list
  Shows the path to the selector in the Navigator structure underneath the pipe spec.
  To navigate to the selector via the context menu, proceed as follows:
  - Select the "Navigate > Object" command.

See also

"Selector" tab (Page 189)

3.6.3 Working in the PDMS interface

3.6.3.1 General

Catalog data and the pipe specs based on it are exchanged between COMOS and PDMS via the COMOS PDMS interface.
Opening the plugin in Comos

Select the following command from the COMOS menu to load the plugin for PDMS in COMOS:

“Plugins > Basic > PDMS interface”.

Result

The "PDMS interface" tab opens in the working area.

3.6.3.2 Replacing pipe part information

Define source and target object

The pipe part information of an object can be replaced by that of another one. The pipe part information comes either from a COMOS PPC object or from an XML file.

Note

When the pipe part information is overwritten, no formulas for name generation are transferred. The names for the Cate and the details texts are rolled out completely.

1. Open the "Cates" tab
2. To specify the source object and the target object, enter a PPC object or a PDMS object in each of the two object fields. You are free to define the order of the source object and the target object.

Before you input an object in the lower field, you must first of all input an object in the upper field.

See also section Reading in pipe part information (Page 142) for details on how you can select objects in both fields.

The detail area displays the pipe part information of the upper object. Click the "Show Cate" button to display information regarding the lower object in a separate window.

Overwriting pipe part information

You can overwrite the pipe part information of either of the two objects (COMOS or PDMS) with that of the other object. Select one of the following buttons, depending on which one is the source object and which one is the target object:

- Assigns the Cate definitions of the first, meaning the upper object to the second, meaning the lower object.
  The old values are overwritten.

- Assigns the Cate definitions of the second, meaning the lower object to the first, meaning the upper object.
  The old values are overwritten.
3.6.3.3 Comparing pipe part catalog elements

Click the "Status Check" button on the "Cates" tab to compare the Cate definitions of two pipe parts with one another.

3.6.3.4 Exporting a pipe part catalog element

Procedure

- Click the "Export to XML" button on the "Cates" tab to export the selected pipe part to an XML file.
- Click the "Export to PDMS" button on the "Cates" tab to export the selected pipe part to PDMS.
  
The button is only active if PDMS is running and communication is taking place with COMOS.

Result

The Cate is saved under the name of the Cate as XML files in the "Export" subdirectory of the folder that had been specified as the "Exchange path" in the project options. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Project properties".

3.6.3.5 Reading in pipe part information

You can read the pipe part information of the pipe part catalog elements from various sources.

Reading in information from the COMOS object

1. Open the "Cates" tab.
2. Do this by enabling the option in front of the "Comos Object" field and drag the object (PPC object or pipe spec element) from the Navigator to the "Comos Object" field.
3. You can also use the button with the arrow to the right of the "Comos object" field to reselect already read in objects.

Result

The "E3D External 3D Interface" tab of the object is read out and displayed in the detail area below.
Reading information from the PDMS object

1. Open the "Cates" tab.
2. Enable the option in front of the "PDMS object" field and click the "..." button.
   The "Cates" window opens.
3. In the "Cates" window, select whether to load the PDMS object using the "Read from PDMS" option (PDMS must be online for this) or to specify the corresponding XML file in which the PDMS object has been saved.
4. Click "OK" to confirm your entries.
   Following this, the "Cate selection" window opens.

Result

The "Cate selection" window is displayed:

Filter criteria:

<table>
<thead>
<tr>
<th>&quot;Cate Name&quot; option:</th>
<th>You can select each Cate individually from the XML file in the list next to the option. If you activate the &quot;Filter&quot; button, only the selected Cate is displayed in the detail area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Search with pattern matching&quot; option:</td>
<td>You can filter all Cates for certain words, letters or numbers. Use the &quot;*&quot; character as a placeholder. Activate the &quot;Filter&quot; button to display the results in the detail area underneath.</td>
</tr>
</tbody>
</table>

1. Select the desired Cate from the window and click "OK".
   The name of the selected Cate is then displayed on the "Cates" tab next to the "PDMS object" field.
2. To display the pipe part information in the detail area, click the "Load Cate" button.

Detail area

The detail area displays the information of the upper object that is included in the Cate for all nominal diameters.

A separate object is created in PDMS for each individual nominal diameter or combination of nominal diameters. The COMOS object is "rolled out":
Followings belong to each PDMS object:

- A Cate element:
  When you click on a Cate element, all attributes of the Cate are displayed in the right-hand part of the window.

- Detail texts (SDTE):
  When you click on an SDTE element, all associated information is displayed in the right-hand part of the window.

  The detail texts are evaluated by nominal diameters.

  By default, COMOS uses the English description for the "RText" attribute and the German description for the "TText" attribute. The "SText" value remains unset (value "unset").

- Pipe part catalog elements (SCOMs):
  When you click on an SCOM element, all associated information is displayed in the right-hand part of the window.

  The SCOMs are "expanded" by nominal diameter and contain the attributes, parameters, and COCO information of a pipe part catalog element.

- Reference to templates for geometry sets, point sets, und data sets (DTSE, PTSE, GMSE):
  When you click on a Set element, all the associated information is displayed in the right-hand part of the window.

3.6.3.6 "Pipe specs" tab

The individual pipe specs and the pipe spec elements they contain are displayed on the "Pipe specs" tab. It is on this tab that you define which pipe spec elements are exported to PDMS.
3.6.3.7 Reading in PipeSpecs and PipeSpecs elements

Procedure

1. Open the "Pipe specs" tab.
2. Drag the pipe spec from the Navigator into the "Pipe spec" field.

Note
You can only drag pipe specs that have the "E3D External 3D Interface" tab to this field.

Alternative method

Click the button with the arrow next to the "Pipe spec" field and select the PDMS pipe specs.

Result

- The pipe spec is imported. This process can take a fair amount of time, depending on the scope of the to be imported pipe spec.
- The pipe spec is displayed in the detail area. See also section Display PipeSpecs (Page 145).

3.6.3.8 Display PipeSpecs

Structure of the detail area for pipe specs

The pipe spec and the pipe spec elements are displayed in the detail area of the "Pipe specs" tab:
The following elements belong to all pipe specs:

- **Pipe spec:**
  
  When you click on pipe spec, all attributes of the pipe specs are displayed in the right-hand part of the window.

- **Selectors:**
  
  The selectors are located underneath the pipe spec. When you click on a selector, all attributes of the selectors are displayed on the right-hand part of the window.
  
  The selector structure is based on the questions and answers that are included. See also section **Selectors (Page 134).**

- **Pipe spec elements (SPCOMs):**
  
  The individual SPCOMs are located underneath the selectors, on the last level. When you click on an SPCOM, all attributes of the SPCOM are displayed on the right-hand part of the window:

  - The SPCOMs contain the references and the UDAs in the "Tree structure" display type. In addition, the references to the bolting sets are set in the case of bolts. See also display mode "Tree structure" and display mode "Tables".

  You can use the SPCOM context menu to navigate to the attributes on the "E3D External 3D Interface" tab: Select the "Navigate > ..." command from the context menu.

### Changing the display type

Click the "Display mode" button to switch to the display mode for displaying the pipe spec information.

### Display type "Tree structure"

If the "Tree structure" display mode is active, the pipe spec, the selectors, and the SPCOMs are displayed in a tree structure: See the figures above.

The selector structure is read by the "Selector tree" selector structure object that is located directly underneath the pipe spec object:

See also section **Selectors (Page 134).**

The SPCOMs contain the references and the UDAs in the "Tree structure" display type.
"Tables" display type

If the "Tables" display mode is active, the pipe spec, the selectors, and the SPCOMs are displayed in tables.

SPCOMs are no longer displayed with their references but already with the values that had been calculated for them. Before you export the pipe spec to PDMS, you can check what the pipe spec elements will look like later in PDMS.

You determine which columns are to be displayed in the table in the options (see section Options group "PipeSpecs" (Page 192); column "Comos Report or Query").

3.6.3.9 Filter PipeSpecs

Procedure

You can exclude specific GTypes from the export and their updating within the COMOS PDMS interface.

To set GTypes to active or inactive, proceed as follows:

1. Open the "Pipe specs" tab.
2. Click the Filter by GTYPE button on the toolbar.
   The "Filter GTYPES" window opens. You see all GTypes of the pipe spec in the window.
3. To exclude a GType from an export or update operation, deactivate the corresponding option next to its entry.
   To reactivate a deactivated GType, enable the option next to its entry.

Once you have modified the filter, close the window by clicking the "X" button on the top right.

The changes that have been made by the filter can only be seen when you press the "Update" button. The "Pipe specs" tab is then updated.
3.6.3.10 Exporting PipeSpecs and PipeSpecs elements

Procedure

To export the pipe spec and its elements, proceed as follows:

1. If required: Configure the following export options as described in section Options group "PipeSpecs" (Page 192):
   - Option "Move unused SPCOMs to LIMBO"
   - "Delete empty selectors" option

2. Optionally: If you do not want to export certain SPCOMs (including selectors), deactivate the SPCOMS in the detail area by setting the according option. See also section Filter PipeSpecs (Page 147).

Note

Optimizing performance

For performance reasons, it is often advisable to export only those elements of a pipe spec from COMOS to PDMS that have been changed, rather than all of them.

3. Click the "Export to XML" button on the toolbar to export a pipe spec to an XML file.

4. Click the "Export to PDMS" button on the toolbar to export the pipe spec to PDMS.
   The button is only active if PDMS is running and communication is taking place with COMOS.

Result

- All pipe spec elements which are displayed in the detail area and are active, are exported.
- The pipe spec is stored under the name of the pipe spec as XML files in the "Export" subdirectory of the folder which had been specified as the "Exchange path" in the project options. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Project properties".

Export via the Navigator

If you want to export a pipe spec including all pipe spec elements directly into an XML file (or to PDMS), you can also initiate the export via the Navigator:

1. Select the pipe spec object in the Navigator.

2. Select the "PDMS > Pipespec > Export" command from the context menu.

Advantage: Unlike the "PDMS Interface" plugin, which only allows you to export one pipe spec at a time, you can use this method to export multiple pipe specs at once.

To call the "Pipe specs" tab for the "PDMS interface" plugin from the Navigator, proceed as follows:
1. Select the pipe spec object in the Navigator.
2. Select the "PDMS > Start Import/Export manager for PDMS pipe spec" command from the context menu.

3.6.3.11 "PDMSInfo for pipe spec" tab

Purpose
You can display the pipe specs from PDMS by means of the "PDMSInfo for pipe spec" tab. This view is used to monitor the results of the export operation.

Procedure
You can import the pipe spec information from PDMS or from an XML file. To do this, proceed as follows:

- Click the "Read from PDMS" button.
  The "Load PipeSpec information" window opens.
- Configure the window as described in the following sections.

Importing a pipe spec from PDMS
Requirement: Communication with PDMS is active.

1. Specify the pipe spec. Choose one of the following methods:
   - Enter the name of the pipe spec in PDMS in the "Information about pipe spec:" field.
   - Drag the PDMS pipe spec base object from COMOS to the field in front of the edit field.
     COMOS reads out the name of the pipe spec and transfers it into the edit field.
2. Click the "Read from PDMS" button.

Result
COMOS reads in the pipe spec from PDMS and displays it in the detail area.

Import pipe spec from XML file

1. Click the "Load from the file" button.
   A file explorer opens.
2. Define the path to the XML file in the file explorer and confirm this with "OK".
   Result: COMOS reads in the pipe spec from PDMS and displays it in the detail area.
3.6 Using Cats&Specs

Result

The pipe spec from PDMS is displayed in the detail area:

You can show and hide table columns. See also section "Configure PDMS SpecInfo" tab (Page 193); column "PDMS SpecInfo query".

Refresh the display

Click the "Update" button on the toolbar to update the display.

The options are then reevaluated and the objects read in again.

Options

Click the "Options" button on the toolbar to have the options displayed.

See also section Options (Page 191).

3.6.3.12 Options

Procedure

To open the options, click the "Options" button.

See also Options (Page 191)

3.6.4 COMOS menu in the PDMS Paragon module

3.6.4.1 General

The COMOS menu is a menu extension for the AVEVA Paragon module. It is used for calling the COMOS command entries. Alternatively, you can also enter the commands using the command line in Paragon.

Activating the Comos menu in Paragon

In order to initiate interaction between PDMS and COMOS, you must first activate COMOS PDMS Integration. See also section Activating COMOS PDMS Integration for PDMS (Page 75).
3.6.4.2 Functions in the "Comos" menu

The following commands are available in the "Comos" menu of Paragon:

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Start Interface&quot;</td>
<td>Starts communication between Paragon and COMOS.</td>
</tr>
<tr>
<td>&quot;Export &gt; CE&quot;</td>
<td>Exports the PDMS structure of the current element.</td>
</tr>
<tr>
<td>&quot;Export &gt; Spec Worlds list (current mdb)&quot;</td>
<td>Exports the PDMS structure of the Spec Worlds list.</td>
</tr>
<tr>
<td>&quot;Export &gt; CATALOG list (current mdb)&quot;</td>
<td>Exports the PDMS structure of the CATALOG list.</td>
</tr>
<tr>
<td>&quot;Export &gt; SPEC list (current mdb)&quot;</td>
<td>Exports the PDMS structure of the SPEC list.</td>
</tr>
<tr>
<td>&quot;Export &gt; CATEGORIES&quot;</td>
<td>Exports the PDMS structure of the CATEGORIES.</td>
</tr>
<tr>
<td>&quot;Export &gt; COCO Tables (current mdb)&quot;</td>
<td>Exports the PDMS structure of the COCO tables.</td>
</tr>
<tr>
<td>&quot;Export &gt; Spec Info (CE)&quot;</td>
<td>Exports the PDMS structure of the Spec Info.</td>
</tr>
<tr>
<td>&quot;Navigate&quot;</td>
<td>Navigates to the object in COMOS that corresponds to the current element (CE).</td>
</tr>
<tr>
<td>&quot;Log&quot;</td>
<td>Option for switching the visibility of the window to display log entries.</td>
</tr>
<tr>
<td>&quot;Display Component&quot;</td>
<td>The AVEVA viewer for viewing the CE is displayed.</td>
</tr>
<tr>
<td>&quot;PML Browser&quot;</td>
<td>The AVEVA PML browser is displayed.</td>
</tr>
<tr>
<td>&quot;Custom&quot;</td>
<td>Can contain user-defined menu items.</td>
</tr>
</tbody>
</table>

3.6.4.3 Export settings

After the command has been called from the "Comos > Export >" menu, the window "Export Settings" is called. Depending on the type of export selected, here you can not only select the target file but also specify the types to be exported.

"Export Destination" control group

When exporting without type selection, the following control elements are available:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Export filename&quot; field</td>
<td>Shows the path and the name of the target file. Pressing the &quot;…&quot; button selects the target file from the Explorer directory structure.</td>
</tr>
<tr>
<td>&quot;Recent files&quot; list</td>
<td>This list can be used to select a previously used target file.</td>
</tr>
<tr>
<td>&quot;OK&quot; button</td>
<td>Starts the export. If the target directory does not exist, the user is given the option to have it created. If the target file already exists, the user is asked whether he wishes to overwrite it.</td>
</tr>
<tr>
<td>&quot;Cancel&quot; button</td>
<td>Aborts the export process.</td>
</tr>
</tbody>
</table>
"Types to export" control group

For certain exports, it is also possible to select the types to be exported from a specified list of types:

- If you hold down the <Ctrl> or <Shift> key you can click on multiple elements to select them together.
- By right-clicking, you can select all elements or cancel the selection.

3.6.4.4 Monitoring the log entries

If you activate the "Comos > Log" option, the log entries can be filtered, displayed, and saved in the "Comos LOG" window.

"Filter settings" control group

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Show&quot;</td>
<td>Here the log entries of the classifications Error, Warning, Info, or Trace can be displayed, depending on which of the options is set. If an option is selected or deselected, the list is updated automatically.</td>
</tr>
</tbody>
</table>
| "Content filter"| This filter enables the log entries displayed to be filtered according to their content. Text field: The content intended for the log entries to be displayed is entered here. For this purpose the following special characters can be used as wild cards:  
  - ? for single characters  
  - * for any number of characters  
Example: If "occ?red" is specified as a filter, then only the fourth entry in the list of displayed log entries would remain. Pressing <Enter> in the text field updates the list. |
| "Apply" button  | Pressing this button updates the list of the log entries that are displayed. |
| "Case sensitive" option | If this option is selected, the upper/lower case used in the log entries that are displayed must satisfy the conditions of the filter that is specified. |

"Log entries" control group

All log entries that satisfy the conditions of the filter settings are shown in the list.

The list as well as all registered log entries can be deleted by right-clicking on the list. The user is then informed that all entries will be deleted, not just those displayed, and is given the option of canceling the deletion.
Log entries can, in principle, be linked to PDMS objects. This creates the facility to navigate from a log entry to the object concerned. Once you have selected a log entry from the list by clicking on it, you have the option of setting the current element accordingly:

- "CE" button
  If the selected log entry is linked to a PDMS object, the current element (CE) is set to the corresponding object.

- "Trace on selection" option
  If this option is active, the current element (CE) is automatically set to the PDMS object linked to the selected log entry (if it is set).

"Save" button
This enables all log entries made since the current Paragon session was opened, or since the list was most recently deleted, to be saved. A window opens in which a target file can be selected.

3.6.5 Import from PDMS to COMOS

3.6.5.1 General
If you want to work with PDMS pipe specs in COMOS, then these do not need to be created from scratch in COMOS but can instead be imported from PDMS.
Data is exchanged between COMOS and PDMS by means of XML files.

3.6.5.2 Creating a PDMS PipeSpec

Procedure
You can import pipe specs from PDMS to COMOS. In COMOS a base object that has already been provided with the attributes that are required for PDMS is created for the relevant pipe spec (without pipe spec elements).

Proceed as follows:
1. Go to the "Base objects" tab in the Navigator.
2. Select the following node:
   "@PDMS > @SPECWORLD > @PIPING PipeSpecs"
3. Select the following command from the context menu of the node:
   "PDMS > Pipespec/Nozzlespec > Show list"
   Result: The "Load Pipespec/Nozzlespec List" window opens.
4. Specify whether the pipe spec is read from PDMS or from an XML file.
   Details: See below.
5. Click "OK".
   The "Please select the required Pipespecs/Nozzlespecs" window opens.

6. Select the to be imported pipe specs in the window.
   Details: See below.

7. Click "OK".

Result

A base object with the "E3D External 3D Interface" tab is created for the selected pipe specs:

See also section "External 3D Interface" tab (Page 188) concerning the tab created for the pipe spec.

The created pipe specs, e.g. for COMOS P&ID, are now available. However, a pipe spec mapping cannot be conducted yet.

Read from PDMS

If the pipe spec is to be read from PDMS, configure the "Load Pipespec/Nozzlespec List" window as follows:

- Select the "From PDMS" option.
- If required: Change the XML code. The list of the available codings is created as a standard table in the system project, below the following node:
  "Character encoding for XML"
- Optionally: "Attribute purpose" field

You can filter the to be read pipe for the "Purpose" PDMS attribute.

To do this, configure the following attribute at the "@PDMS > @SPECWORLD" node on the "Attributes > External 3D Interface" tab: "PDMSPipePurpose Purpose for Pipespecs"

Enter the pipe spec types into the attribute you are importing.
Result: Only pipe specs with the corresponding types are imported.

Result

The pipe specs are requested from PDMS and the result is that the XML file is created or updated.
Loading from XML file

If the pipe spec is to be read from an existing XML file, proceed as follows in the "Load Pipespec/Nozzlespec List" window:

Click the "..." button and enter the file path to the XML file.

Result:
The pipe specs are imported from an existing XML file.

This option will only be available if COMOS and PDMS are running on the same computer or if COMOS is running on the Citrix server.

Configuring the "Please select the required Pipespecs/Nozzlespecs" window

The detail area of the window shows all pipe specs contained in the XML file.

- To select a pipe spec for the import to COMOS, enable the option next to the pipe spec in the detail area of the window.
- Grayed-out pipe specs have already been imported into COMOS.
- You have the option of defining filters. The window then only shows the pipe specs meeting your filter criteria.
  Details regarding defining filters: See below.

Filtering pipe specs

- "PipeSpec name" option:

  Click the button with the arrow to select each pipe spec individually from the XML file.

  Result: Only the selected pipe spec is offered for inclusion in the detail area of the window when you activate the "Filter" button:

- "Regular expression" option:

  You can search the pipe specs for specific words, letters or numbers. Use the "*" character as a placeholder. The search starts when you activate the "Filter" button. The results are displayed in the detail area.

- "Purpose" field:

  You can filter the pipe specs on the basis of the purposes stored in the XML file by means of the "Purpose" field.
More options

You can access the following options via the menu bar in the "Please select the required Pipespecs/Nozzlespecs" window:

- "Select all visible" button:
  Marks all visible pipe specs that are displayed in the detail window. All previously marked pipe specs remain marked.

- "Deselect all visible" button:
  Deselects all visible pipe specs that are displayed in the detail window. All pipe specs that were previously marked and are not visible remain selected.

- "Only display selected" button:
  Displays all pipe specs that were selected.

3.6.5.3 Importing catalog data

Procedure

Once you have created the PDMS pipe spec as a base object in COMOS, generate an XML file that contains the catalog data for the pipe spec.

To do this, proceed as follows:

1. Mark the base object of the PDMS pipe spec.
2. Select one of the following commands from the context menu of the base object:
   - "PDMS > Pipe spec/Nozzle spec > Import XML string for pipe spec including Cates": If you want to write out the pipe specs including PPC objects and pipe spec elements.
   - "PDMS > Pipe spec/Nozzle spec > Import XML string for pipe spec excluding Cates": If you want to write out the pipe specs without elements. This version is faster and is perfectly adequate for COMOS P&ID.

   Result: The "Load XMLString for pipespecs/nozzlespecs" window opens.
3. Configure the window as described below.

Configuring the "Load XMLString for pipespecs/nozzlespecs" window

1. Optionally:
   Click the "Change" button to convert the XML code.
2. "Attribute" area:
   The list shows the pipe specs you previously selected in the dialog.
   Select a pipe spec.
3. "File name" area:
   Click the "..." button and specify the path to the XML file containing the information regarding the pipe spec and the elements.
4. "Action" area:
   - With "Load from the file" you access the XML file that you specified in the "File name" column.
   - With "Load from PDMS", you access an XML file that you had specified in PDMS by means of direct communication with PDMS.
   - With "No Action" no import operation is triggered. See below: Signal colors

5. "State" area:
   You here see whether you have made all necessary settings for the import and whether the data can be imported:
   - Green circle: The data can be imported.
   - Yellow circle: Data is being imported, but may not necessarily be complete.
     For example, this is the case if an XML file does not contain any Cates but they were specified in the import options.
   - Red circle: No data can be imported.
     The data in the XML file does not match the settings or no XML file was specified. The "No action" entry is also displayed in the column.

6. To start the import, click on the "Execute" button.

Result
- The data is read from the XML file and written to an XML string below the pipe spec base object. The XML string is not visible in the Navigator.
- After having generated this XML string a pipe spec mapping is also possible.

3.6.5.4 Creating COMOS pipe specs and PPC objects

Procedure
You can create both, the PPC objects and a pipe spec completely with pipe spec elements.
Proceed as follows:
1. Go to the "Base objects" tab in the Navigator.
2. Mark the base object of the pipe spec.
3. In the context menu of the pipe spec base object, select the command "PDMS > Pipe spec/Nozzle spec > Generate pipe spec and catalog elements".
3.7 Material management

Material management is used to create lists of estimates and purchasing lists in COMOS. COMOS PDMS Integration provides all COMOS material management functions.

You can use the MTO options to transfer material from Aveva PDMS to COMOS and then create MTO objects from this material for the purpose of material management. For this purpose, all the required data from Aveva PDMS is written to an XML file, which you import into COMOS.

You can find additional information on this topic in the "COMOS Material Management Operation" and "COMOS Material Management Administration" manuals.

4. In the window that opens, specify whether you want to create the objects on a new working layer or the current one.

5. Start the import.

Result

- PPC objects:
  - A PPC object is generated for each Cate. The objects are created below the following node, sorted by GType:
    "@PDMS > @PPC devices"
    In other words, the PPC objects are not stored in the default node for COMOS PPC objects.
  - The PDMS attributes are transferred to the "E3D External 3D Interface" and "VDM Data sheet" tabs at the pipe part.
- Pipe spec and pipe spec elements:
  The pipe spec and the pipe spec elements are created in the node specified in the project properties in the "Pipe spec definition" field on the "Viper" tab.
  In the COMOS DB, this is the following node:
  "@VIPER > @SPEC PipeSpec"
4.1 Overview

The COMOS 3D viewer facilitates the use of COMOS P&ID and planning data with linked 3D models in a suitable 3D viewer.

The following functionalities are supported:

- Bidirectional navigation between COMOS and the 3D model.
- Transfer of planning documents to the 3D viewer for external display.

4.2 Navigating

4.2.1 From COMOS to the 3D viewer application

Requirement

The 3D data must be linked to the corresponding COMOS systemUIDs in the 3D model.

Procedure

1. Right-click on the required object to select it.
2. Select the "COMOS 3D Viewing > Navigate" command in the context menu.

Result

An enlarged version of the selected object is displayed in the 3D viewer application.

4.2.2 From the 3D viewer application to COMOS

Requirement

The 3D data must be linked to the corresponding COMOS systemUIDs in the 3D model.
4.3 "Comos Document View" window

Procedure

1. Right-click on the required object to select it.
2. Select the "COMOS > Select" command in the context menu.

Result

An enlarged version of the selected object is displayed in COMOS on the P&ID and in the Navigator.

4.3 "Comos Document View" window

Prerequisite

To transfer COMOS documents to the 3D viewer, PDF files must be located below the object. These may be linked files or revised and released documents. The 3D application accesses them to display the PDF files.

Procedure

To open documents in the 3D viewer application, proceed as follows:

1. Right-click on the required object to select it.
2. Click "COMOS > Open Document" in the context menu.

Result

After a prompt from the 3D viewer application, the PDF files are copied to the exchange folder. The "COMOS Document View" window opens. This window contains all the PDF files which have been created below the object in COMOS.
5.1 Overview
The COMOS NX - Routing Mechanical interface is used to link COMOS process planning with 3D model generation in the NX - Routing Mechanical design tool.

In order to support modeling in NX - Routing Mechanical, the COMOS P&ID and process data is made available for 3D modeling.

The planning is based on:
- The COMOS P&IDs for schematic process visualization
- The pipe specs available in COMOS and used on the P&ID

You transfer a COMOS pipe, including planning data, to NX - Routing Mechanical for further use by means of XML data exchange. You can then create a consistent 3D pipe stream in NX - Routing Mechanical.

Functions
- Direct link between 3D and P&ID objects, by means of a special identification attribute
- Free assignment of 3D objects to corresponding P&ID objects
- Bidirectional navigation between 2D process and 3D design objects
- Access to COMOS process data and to NX geometric data from COMOS

5.2 Starting and ending NX Schematics

Requirement
The NX Routing Mechanical module is installed. You have already logged in to COMOS.

Starting data/information exchange
1. Start NX.
2. Select the "Tools > Schematics > Connect" command in the menu bar.

Ending data/information exchange
Select the "Tools > Schematics > Disconnect" command in the menu bar.
5.3 Status message in NX

If you have logged in to NX, a status message appears in the NX menu bar. The following status messages can be displayed:

- "Successfully connected to the schematics application. Listening for messages."
  
  A connection to NX has been established. You are logged in.

- "Disconnected from the schematics application."
  
  The connection to NX has been canceled. You are logged out.

- "Waiting for connection response message from the schematics application..."
  
  A connection to NX has not yet been established. You are not yet logged in to NX.
  - Check if you are already logged in to COMOS.
  - You can use the "NX Viper" context menu in COMOS to check if the interface has been started.

If you have checked the above points and NX still does not start:

- Delete the "NXMessage.xml" file from the "C:\temp\ComosExchangeDir" exchange directory
- Restart NX. See also chapter Starting and ending NX Schematics (Page 161).

5.4 Assigning

5.4.1 Assigning a COMOS object to the NX object

Prerequisite

- The object has been placed in NX.
- The object has not yet been assigned in COMOS.

Procedure

1. In COMOS, select the desired object either on the P&ID or in the Navigator.
2. Select the "NX Viper > Assign" command in the context menu.
3. Switch to the NX Routing Mechanical module.
4. Select the required object.
5. The "Assign Component" window opens.
6. Click the "OK" button.
Result

- The COMOS object is assigned to the NX object.
- In COMOS, a 3D object is created underneath the object in the Navigator.
- It is possible to navigate between the objects.

5.4.2 Canceling an assignment

Prerequisite

The COMOS object and the NX object are assigned to one another.

Procedure

1. Select the object in NX.
2. Select the “Schematics > Unassign...” command in the context menu.

Result

The existing connection between the COMOS object and the NX object is canceled. The 3D object is no longer displayed in the Navigator.

5.5 Navigating

5.5.1 From the COMOS object to the NX object

Requirement

The COMOS object and the NX object are assigned to one another.

Procedure

1. In COMOS, right-click on the desired object on the P&ID.
2. Select the "NX Viper > Navigate" command in the context menu.

Result

An enlarged version of the selected object is displayed in NX.
5.5.2 From the NX object to the COMOS object

Requirement
The NX object and the COMOS object are assigned to one another.

Procedure
1. Right-click on the required object to select it.
2. Select the "Schematics > Navigate to..." command in the context menu.
3. Select one of the following options:
   – If you want to navigate to the object in the Navigator, select the "Navigate to 3D object..." command.
   – If you want to navigate to the object on the P&ID, select the "Navigate to PID symbol..." command.

Result
- If you have selected the "Navigate to 3D object..." command, the corresponding object is marked in the Navigator.
- If you have selected the "Navigate to PID symbol..." command, the corresponding object is marked in the P&ID.

5.6 Routing

5.6.1 Routing from COMOS to NX

General
When routing from COMOS to NX, you have the option of changing the pipe stream in the 3D view.

Requirement
You must have conducted pipe spec mapping for the inline components on the P&ID in COMOS, so that 3D-capable implementations are already available.

Procedure
1. In COMOS, right-click on the start object of the required pipe on the P&ID.
2. Select the "NX Viper > Route" command in the context menu.
5.6.2 "Run Navigator" NX tab

5.6.2.1 Purpose

Purpose

The "Run Navigator" tab in NX contains the following information:

- Which objects are placed on the pipe.
- The start and end points of the pipe.

The description takes the form of a device tag.

5.6.2.2 Displaying information about a particular device tag

Procedure

1. In NX, right-click on the required device tag on the "Run Navigator" tab.
2. Select the "Information" command in the context menu.

Result

The "Information" window opens.

The table below describes the most important attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;PIDUID&quot;</td>
<td>SystemUID of the request object</td>
</tr>
<tr>
<td>&quot;TAGGING&quot;</td>
<td>Device tag</td>
</tr>
<tr>
<td>&quot;DEVICEUID&quot;</td>
<td>SystemUID of the implementation object</td>
</tr>
<tr>
<td>&quot;DB_PART_NO&quot;</td>
<td>Identification from the implementation</td>
</tr>
</tbody>
</table>
6.1 Plant Modeler

6.1.1 User interface reference

6.1.1.1 Buttons on the "Pipe construction" toolbar

Tools

The following table describes the tools on the "Pipe construction" toolbar:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![image]</td>
<td>&quot;Center line routing&quot;</td>
<td>This tool is used for manual routing of pipe branches.</td>
</tr>
<tr>
<td>![image]</td>
<td>&quot;Auto routing&quot;</td>
<td>This tool is used for automatic routing of pipe branches.</td>
</tr>
<tr>
<td>![image]</td>
<td>&quot;Hanger &amp; support&quot;</td>
<td>This tool is used to place hangers.</td>
</tr>
</tbody>
</table>

6.1.1.2 Buttons on the "Placeable objects" toolbar

Component groups

The buttons on the "Placeable Objects" toolbar represent component groups. Components that belong to the same area of the function code are summarized in component groups. Which tools are displayed on the "Placeable Objects" toolbar depends on the PipeSpec and nominal diameter you have selected in the "Pipe Settings" window. A component becomes unavailable on the toolbar if its component type has no components defined in the PipeSpec.

Tools

The following table describes the tools on the "Placeable Objects" toolbar:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![image]</td>
<td>&quot;Place Nozzle&quot;</td>
<td>This tool is used to place nozzles.</td>
</tr>
<tr>
<td>![image]</td>
<td>&quot;Place Pipe&quot;</td>
<td>This tool is used to place pipes.</td>
</tr>
</tbody>
</table>
**References**

### 6.1 Plant Modeler

<table>
<thead>
<tr>
<th>Tool</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon 1]</td>
<td>&quot;Place Pipe Elbow&quot;</td>
<td>This tool is used to place pipe elbows.</td>
</tr>
<tr>
<td>![Icon 2]</td>
<td>&quot;Place tee&quot;</td>
<td>This tool is used to place tees.</td>
</tr>
<tr>
<td>![Icon 3]</td>
<td>&quot;Place Reducer&quot;</td>
<td>This tool is used to place reducers.</td>
</tr>
<tr>
<td>![Icon 4]</td>
<td>&quot;Place Two-Way Valve&quot;</td>
<td>This tool is used to place two-way valves.</td>
</tr>
<tr>
<td>![Icon 5]</td>
<td>&quot;Place Three-Way Valve&quot;</td>
<td>This tool is used to place three-way valves.</td>
</tr>
<tr>
<td>![Icon 6]</td>
<td>&quot;Place Angle Valve&quot;</td>
<td>This tool is used to place angle valves.</td>
</tr>
<tr>
<td>![Icon 7]</td>
<td>&quot;Place two-way safety device&quot;</td>
<td>This tool is used to place two-way safety devices.</td>
</tr>
<tr>
<td>![Icon 8]</td>
<td>&quot;Place Three-Way Safety Device&quot;</td>
<td>This tool is used to place three-way safety devices.</td>
</tr>
<tr>
<td>![Icon 9]</td>
<td>&quot;Place Angle Valve Safety Device&quot;</td>
<td>This tool is used to place angle safety devices.</td>
</tr>
<tr>
<td>![Icon 10]</td>
<td>&quot;Place pipe fastening&quot;</td>
<td>You use this tool to place hangers and supports.</td>
</tr>
<tr>
<td>![Icon 11]</td>
<td>&quot;Place coupling&quot;</td>
<td>This tool is used to place couplings.</td>
</tr>
<tr>
<td>![Icon 12]</td>
<td>&quot;Place Flange&quot;</td>
<td>This tool is used to place flanges.</td>
</tr>
<tr>
<td>![Icon 13]</td>
<td>&quot;Place weld&quot;</td>
<td>This tool is used to place welds.</td>
</tr>
<tr>
<td>![Icon 14]</td>
<td>&quot;Place gasket&quot;</td>
<td>This tool is used to place gaskets.</td>
</tr>
<tr>
<td>![Icon 15]</td>
<td>&quot;Place I&amp;C element&quot;</td>
<td>This tool is used to place I&amp;C elements.</td>
</tr>
<tr>
<td>![Icon 16]</td>
<td>&quot;Place All&quot;</td>
<td>This tool provides a list with all available objects you can mount in the selected PipeSpec.</td>
</tr>
</tbody>
</table>
6.1.3 Buttons on the "Change/Information" toolbar

Tools

The following table describes the tools on the "Change/Information" toolbar:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✡</td>
<td>&quot;Navigate to COMOS&quot;</td>
<td>This tool is used to navigate to a COMOS object.</td>
</tr>
<tr>
<td></td>
<td>&quot;Component information&quot;</td>
<td>This tool is used to call object information.</td>
</tr>
<tr>
<td></td>
<td>&quot;Select components&quot;</td>
<td>This tool is used to select multiple objects.</td>
</tr>
<tr>
<td></td>
<td>&quot;Reset component&quot;</td>
<td>This tool is used to reset components.</td>
</tr>
<tr>
<td></td>
<td>&quot;Move component&quot;</td>
<td>This tool is used to move objects.</td>
</tr>
<tr>
<td></td>
<td>&quot;Split pipe&quot;</td>
<td>This tool is used to split pipes into different segments.</td>
</tr>
<tr>
<td></td>
<td>&quot;Close Gap&quot;</td>
<td>This tool is used to close gaps between pipes.</td>
</tr>
<tr>
<td></td>
<td>&quot;Connect components&quot;</td>
<td>This tool is used to connect components.</td>
</tr>
<tr>
<td></td>
<td>&quot;Disconnect components&quot;</td>
<td>This tool is used to disconnect components.</td>
</tr>
</tbody>
</table>

6.1.4 Buttons on the "Insulation" toolbar

Tools

The following table describes the tools on the "Insulation" toolbar:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✡</td>
<td>&quot;Change insulation&quot;</td>
<td>This tool is used to change the insulation class and the thickness of the insulation.</td>
</tr>
<tr>
<td></td>
<td>&quot;Disconnect insulation&quot;</td>
<td>This tool is used to disconnect insulation.</td>
</tr>
</tbody>
</table>
6.1 Plant Modeler

6.1.1.5 Buttons on the "References" toolbar

Tools

The following table describes the tools on the "References" toolbar:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td>&quot;Move to Reference&quot;</td>
<td>This tool is used to move a cell to a referenced file.</td>
</tr>
<tr>
<td><img src="image2" alt="Image" /></td>
<td>&quot;Delete Reference&quot;</td>
<td>This tool is used to delete a referenced file.</td>
</tr>
</tbody>
</table>

6.1.1.6 Buttons on the " Change management" toolbar

Tools

The following table describes the tools on the " Change management" toolbar:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Image" /></td>
<td>&quot;Calculate status&quot;</td>
<td>If a status query has been saved in the configuration file, you use this tool to calculate the status.</td>
</tr>
<tr>
<td><img src="image4" alt="Image" /></td>
<td>&quot;Change pipe spec&quot;</td>
<td>This tool is used to change the pipe spec and nominal diameter used.</td>
</tr>
</tbody>
</table>

6.1.1.7 Buttons on the " Cell management" toolbar

The " Cell management" toolbar is divided into the following toolbars:

- "COMOS cell"
- "COMOS cell library"

The tools on the "COMOS cell" and "COMOS cell library" toolbars are used to perform the same actions on different cell types. See also Section "Cell library" and "Cell" toolbars (Page 54).

Cell library

The following table describes the tools on the "COMOS cell library" toolbar:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Image" /></td>
<td>&quot;Create cell header&quot;</td>
<td>Creates cell attributes.</td>
</tr>
<tr>
<td><img src="image6" alt="Image" /></td>
<td>&quot;Create Connector&quot;</td>
<td>Creates connectors.</td>
</tr>
<tr>
<td><img src="image7" alt="Image" /></td>
<td>&quot;Modify connector&quot;</td>
<td>Modifies connectors.</td>
</tr>
</tbody>
</table>
6.1 Plant Modeler

The following table describes the tools on the "COMOS cell" toolbar:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Tool" /></td>
<td>&quot;Create cell header&quot;</td>
<td>Creates object attributes.</td>
</tr>
<tr>
<td><img src="image" alt="Tool" /></td>
<td>&quot;Create Connector&quot;</td>
<td>Creates connectors.</td>
</tr>
<tr>
<td><img src="image" alt="Tool" /></td>
<td>&quot;Modify connector&quot;</td>
<td>Modifies connectors.</td>
</tr>
<tr>
<td><img src="image" alt="Tool" /></td>
<td>&quot;Delete Connector&quot;</td>
<td>Deletes connectors.</td>
</tr>
<tr>
<td><img src="image" alt="Tool" /></td>
<td>&quot;Connector information&quot;</td>
<td>Displays the connector properties.</td>
</tr>
</tbody>
</table>

6.1.1.8 "Plant Modeler" context menu

The "Plant Modeler" context menu available in COMOS contains the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Plant Modeler</td>
<td>Starts the Plant Modeler.</td>
</tr>
<tr>
<td>Assign</td>
<td>Assigns a COMOS object to a cell.</td>
</tr>
<tr>
<td>Unassign</td>
<td>Cancels the assignment of a COMOS object to a cell.</td>
</tr>
<tr>
<td>Navigate</td>
<td>Navigates from the selected COMOS object to a cell in MicroStation.</td>
</tr>
<tr>
<td>Place implementation</td>
<td>Places an implemented object subsequently.</td>
</tr>
<tr>
<td>&lt;Status check&gt;</td>
<td>Carries out a status comparison for the selected node.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Updates the identification of a cell.</td>
</tr>
</tbody>
</table>

See also

- Starting Plant Modeler in COMOS (Page 12)
- Assigning COMOS object to a cell (Page 18)
- Unassigning COMOS objects from cells (Page 19)
- Navigating from COMOS objects to cells (Page 21)
- Placing implemented objects subsequently (Page 28)
- Performing a status check in COMOS (Page 38)
- Updating the labelling (Page 40)
6.1.1.9 Control elements on the "Plant Modeler" tab

"Storage settings" control group

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Default location for pipes&quot;</td>
<td>The default location for pipes. All 3D objects that you unassign from cells in MicroStation are moved to the node specified here.</td>
</tr>
<tr>
<td>&quot;Default location for equipment&quot;</td>
<td>The default location for equipment. All 3D objects that you unassign from cells in MicroStation are moved to the specified node.</td>
</tr>
</tbody>
</table>

"Database settings" control group

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Plant Modeler start node&quot;</td>
<td>References the &quot;PLM&quot; node in the base data, providing you with the opportunity to move the node if necessary.</td>
</tr>
<tr>
<td>&quot;Pipe spec limit&quot;</td>
<td>References structure objects. If you do not make any of your own settings here, default objects are displayed automatically.</td>
</tr>
<tr>
<td>&quot;Part unit structure&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;KKS system count&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;PPC start node&quot;</td>
<td>References the &quot;PPC&quot; node in the base data, providing you with the opportunity to move the node if necessary.</td>
</tr>
<tr>
<td>&quot;Cell library start node&quot;</td>
<td>References the start node underneath which the cell libraries are located in the base data, providing you with the opportunity to move the node if necessary.</td>
</tr>
</tbody>
</table>
**"Document management settings" control group**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Default seed file"        | 3D standard seed file  
                             | The standard seed file is imported into the ComosDB. |
| "Auto backup on exit"      | Specifies that the last displayed status is stored in the backup folder when the Plant Modeler is closed.  
                             | You can also activate this option in the Plant Modeler in the "Document management" window. To do so, select the "Auto backup on exit" command in the "Options" menu.  
                             | You can find additional information on this topic in the "3D Integration Operation" manual, keyword "Document management in the Plant Modeler". |
| "Auto check-in of working DGN on exit" | When you have started the Plant Modeler through the checking-out and editing of a DGN file, COMOS tries to check the DGN file back in when the Plant Modeler is closed.  
                             | You can also activate this option in the Plant Modeler in the "Document management" window. To do so, select the "Auto check-in of working DGN on exit" command in the "Options" menu.  
                             | You can find additional information on this topic in the "3D Integration Operation" manual, keyword "Document management in the Plant Modeler". |

**"Microstation settings" control group**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Startup file commands"    | Reference to the start file "ComosPlantModeler.StartUp" of the Plant Modeler.  
                             | Example:  
                             | C:\Program Files\Bentley\Microstation V8i\MicroStation\mdlapps\ComosPlantModeler.StartUp |
| "Interface settings"       | Interface with which the Microstation program is opened.  
                             | Default: "comosplantmodeler" |
| Configuration file (optional)" | Configuration file with which the Microstation program is opened. |
6.1 Plant Modeler

"Plant Modeler" tab

The following table describes the buttons that are available in the project properties on the "Plant Modeler" tab:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="button" alt="..." /></td>
<td>&quot;Set Pointer&quot;</td>
<td>Opens a window where you select locations or other references.</td>
</tr>
<tr>
<td><img src="button" alt="x" /></td>
<td>&quot;Remove Pointer&quot;</td>
<td>Deletes the pointer.</td>
</tr>
</tbody>
</table>
| ![navigate](button) | "Navigate, Properties" | Depending on your selection, navigates:  
- To the object  
- To the object properties  
- To the base object  
- To the base object in the base project  
- To uses |
| "Reinitialize" | | Updates the default settings for the "Default location for pipes" and "Default location for equipment" fields. Also restarts Plant Modeler and reads out the configuration file again. |

6.1.1.10 "Pipe settings" window

"User-defined pipe spec" area

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button <img src="button" alt="p" /></td>
<td>Opens the &quot;Object picker&quot; window. See also Section &quot;Object picker&quot; window (Page 177).</td>
</tr>
<tr>
<td>Button <img src="button" alt="p" /></td>
<td>Loads the nominal diameters of the current pipe spec from COMOS and refreshes the &quot;ND&quot; list.</td>
</tr>
<tr>
<td>&quot;User-defined pipe spec&quot; list</td>
<td>Here you select the pipe spec you wish to use when drawing in Plant Modeler or during center line routing. The pipe specs offered are transmitted from COMOS.</td>
</tr>
<tr>
<td>&quot;ND&quot; list</td>
<td>Here you select the nominal diameter. The nominal diameters offered are transmitted from COMOS and are dependent upon the pipe spec selected.</td>
</tr>
<tr>
<td>&quot;Use insulation&quot; option</td>
<td>You can only activate this option if an insulation class is defined for the selected pipe spec. Activated: Insulation is used when drawing or routing pipes.</td>
</tr>
<tr>
<td>&quot;Insulation class&quot; list</td>
<td>Here you select the insulation class you wish to use when drawing in Plant Modeler or during center line routing. The insulation classes offered are transmitted from COMOS.</td>
</tr>
<tr>
<td>&quot;Insulation thickness&quot; field</td>
<td>Here you enter the insulation thickness.</td>
</tr>
</tbody>
</table>
"COMOS pipe spec" area

The "COMOS pipe spec" area displays pipe data that has been defined in COMOS for a pipe component. The following information is displayed:

- Pipe spec
- Nominal diameter
- Insulation class
- Insulation thickness

6.1.1.11 "Center line routing" window

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Create additional center line&quot; option</td>
<td>Activated: The component center line that was originally drawn is retained. It is maintained as a separate object in Microstation. The center line does not move when the component is moved.</td>
</tr>
<tr>
<td>&quot;Enable slope mode&quot; option</td>
<td>Activated: You can define the slope for pipes and the angle of inclination for implementations.</td>
</tr>
<tr>
<td>&quot;Slope&quot; field</td>
<td>Here you enter the slope for pipes. You can choose whether to specify it in percent or degrees.</td>
</tr>
<tr>
<td>&quot;Set&quot; button</td>
<td>If you click the &quot;Set&quot; button, your entry is applied in the &quot;Slope&quot; field.</td>
</tr>
<tr>
<td>&quot;Angle&quot; field</td>
<td>Here you enter the rotation angle by which you wish to rotate an implemented inline component. The component is rotated about its main axis. The rotation is executed when you click the button.</td>
</tr>
<tr>
<td>&quot;Implementation objects&quot; field</td>
<td>Here you select which implementation is to be placed. The implementations offered here are transmitted from COMOS.</td>
</tr>
<tr>
<td>&quot;Place implementation&quot; button</td>
<td>If you click the &quot;Place implementation&quot; button, the implementation you selected in the &quot;Implementation objects&quot; field is placed.</td>
</tr>
</tbody>
</table>
6.1.1.12  "Place component" window

Overview

The following tables describes the control elements of the "Place Component" window:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Calculate Distance From&quot; list</td>
<td>When inserting a component into an existing pipe, use this list to select the point from which the distance should be calculated.</td>
</tr>
<tr>
<td>&quot;Angle&quot; field</td>
<td>Enter an angle here. By clicking the button, you can rotate the object by the specified angle about its main axis.</td>
</tr>
<tr>
<td>&quot;Select Connector&quot; list</td>
<td>For components that can be connected by means of multiple connectors, use this list to choose which connector you want to connect the component to.</td>
</tr>
<tr>
<td>&quot;Weld shape&quot; list</td>
<td>This field is enabled once the associated COMOS attribute has been released in the VSUI options at the base object. You find the VSUI options on the &quot;GD&quot; geometry tab.</td>
</tr>
<tr>
<td></td>
<td>• Radial:</td>
</tr>
<tr>
<td></td>
<td>• Tangential</td>
</tr>
<tr>
<td></td>
<td>• Eccentric</td>
</tr>
<tr>
<td></td>
<td>• - Tangential</td>
</tr>
<tr>
<td>&quot;Eccentricity&quot; field</td>
<td>This field is enabled once the associated COMOS attribute has been released in the VSUI options at the base object. You find the VSUI options on the &quot;GD&quot; geometry tab. You enter the extent of the eccentricity in this field. Only active in the case of the &quot;Eccentric&quot; weld shape.</td>
</tr>
<tr>
<td>&quot;Tilting angle&quot; field</td>
<td>This field is enabled once the associated COMOS attribute has been released in the VSUI options at the base object. You find the VSUI options on the &quot;GD&quot; geometry tab. You enter the tilting angle of a component in this field.</td>
</tr>
<tr>
<td>&quot;Length&quot; field</td>
<td>This field is enabled once the associated COMOS attribute has been released in the VSUI options at the base object. You find the VSUI options on the &quot;GD&quot; geometry tab. You enter the length of a component in this field.</td>
</tr>
<tr>
<td>&quot;Accept&quot; button</td>
<td>All settings are accepted for placing the component.</td>
</tr>
</tbody>
</table>

Entries in the "Distance Calculation" list

The following table describes the entries in the "Distance Calculation" list:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Connector_Connector&quot;</td>
<td>The starting point here is the connector of the component where you want to connect or insert the new component. The end point is the connector of the new component.</td>
</tr>
<tr>
<td>&quot;Connector_Origin&quot;</td>
<td>The starting point here is the connector of the component where you want to connect or insert the new component. The end point is the origin of the new component.</td>
</tr>
</tbody>
</table>
### 6.1 Plant Modeler

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Origin_Connector&quot;</td>
<td>The starting point here is the origin of the component where you want to connect or insert the new component. The end point is the connector of the new component.</td>
</tr>
<tr>
<td>&quot;Origin_Origin&quot;</td>
<td>The starting point here is the origin of the component where you want to connect or insert the new component. The end point is the origin of the new component.</td>
</tr>
<tr>
<td>&quot;Branch&quot;</td>
<td>Select this entry if you want to create a branch when placing a pipe on an existing pipe.</td>
</tr>
</tbody>
</table>

#### Weld-on components

For weld-on components, additional control elements are displayed in the "Place Component" window. You can use these control elements to define placement attributes. The VSUI options in the base object of the to be placed component allow you to define which parameters can be changed. You find the VSUI options on the "GD" geometry tab at the base objects.

### 6.1.1.13 "Object attributes" window

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Assign implementation&quot; list</td>
<td>Here you select a COMOS object that is to be assigned to the cell. The list contains all the objects that have been created in the base data under &quot;PLM &gt; Y &gt; ABO Catalog of Assignable Objects&quot;.</td>
</tr>
<tr>
<td>&quot;Standards system&quot; list</td>
<td>Here you select the standards system.</td>
</tr>
<tr>
<td>&quot;Flange standard&quot; list</td>
<td>Here you select a flange standard.</td>
</tr>
<tr>
<td>&quot;Name&quot; field</td>
<td>Here you enter the name of the cell.</td>
</tr>
<tr>
<td>&quot;Accept&quot; button</td>
<td>This button saves the object attributes for the selected cell.</td>
</tr>
<tr>
<td>&quot;Cancel&quot; button</td>
<td>Closes the window.</td>
</tr>
</tbody>
</table>

### 6.1.1.14 "Object picker" window

The purpose of the "Object picker" window is to accept a pipe's data when the pipe is selected and use this data for pipe routing.

<table>
<thead>
<tr>
<th>Control elements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Pipe data&quot; field</td>
<td>In this field, the pipe spec and nominal diameter of a selected pipe are listed.</td>
</tr>
<tr>
<td>&quot;Use for routing&quot; button</td>
<td>When you click this button, the pipe spec and nominal diameter are transferred from the &quot;Pipe data&quot; field to the &quot;Pipe settings&quot; window.</td>
</tr>
</tbody>
</table>
6.1.1.15 "Create Connector" window

Call:

- Menu "Cell management > COMOS cell > Create connector"
- Menu "Cell management > COMOS cell library > Create connector"

"Connection basics" control group

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Name&quot; field</td>
<td>Shows the name of the connector. The name will be generated automatically.</td>
</tr>
<tr>
<td>&quot;Nominal diameter&quot; list</td>
<td>Can be selected from connector &quot;CX1&quot; onwards. Here you select the nominal diameter. See also Section Creating connectors for cells (Page 57).</td>
</tr>
<tr>
<td>&quot;Nominal pressure&quot; list</td>
<td>Can be selected from connector &quot;CX1&quot; onwards. Here you select the nominal pressure. See also Section Creating connectors for cells (Page 57).</td>
</tr>
</tbody>
</table>

"Connector type" control group

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Connection type&quot; list</td>
<td>Here you select the connection type.</td>
</tr>
<tr>
<td>&quot;Contact face&quot; list</td>
<td>Here you select the contact face.</td>
</tr>
<tr>
<td>&quot;Flange standard&quot; list</td>
<td>Can only be selected in the case of &quot;Flange finish&quot; connection type. Here you select the flange standard.</td>
</tr>
</tbody>
</table>

6.1.1.16 "Select owner" window

The "Select owner" window makes different control elements available depending on the placed object in the Plant Modeler.

Control elements for all objects

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Units&quot; tab</td>
<td>On the &quot;Units&quot; tab, you select the pipe section to which you want to assign the pipe section from the Plant Modeler.</td>
</tr>
<tr>
<td>&quot;Location&quot; tab</td>
<td>On the &quot;Location&quot; tab, you select the pipe section to which you want to assign the pipe section from the Plant Modeler.</td>
</tr>
</tbody>
</table>
Control elements for pipes

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Pipe            | Base object of the pipes.  
In order to insert a new pipe, select the desired position of the new pipe in the "Units" tab and click "Create". 
COMOS uses the settings that you specified in the fields "Default pipe spec", "Nominal diameter" and "Nominal pressure" for the pipe. |
| Section         | Base object of the pipe sections.  
In order to insert a new pipe section, select the desired position of the new pipe section in the "Units" tab and click "Create". 
COMOS uses the settings that you specified in the fields "Default pipe spec", "Nominal diameter" and "Nominal pressure" for the pipe section. |
| Default pipe spec | Defines the pipe spec of the pipe. |
| Nominal diameter | Defines the nominal diameter of the pipe. |
| Nominal pressure | Defines the nominal pressure of the pipe. |

Control elements for HVAC components

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Channel         | Base object of the channels.  
In order to insert a new channel, select the desired position of the new channel in the "Units" tab and click "Create". 
COMOS uses the settings that you specified in the fields "Channel class", "Width" and "Height" for the channel. |
| Channel section | Base object of the channel sections.  
In order to insert a new channel section, select the desired position of the new channel in the "Units" tab and click "Create". 
COMOS uses the settings that you specified in the fields "Channel class", "Width" and "Height" for the channel section. |
| Channel class   | Specifies the channel class of the channel. |
| Width           | Specifies the width of the channel. |
| Height          | Specifies the height of the channel. |
6.1.2  Reference via keyboard inputs

6.1.2.1  List of keyboard inputs

Overview

The following table describes the keyboard inputs you can use to call and execute various actions in Plant Modeler:

<table>
<thead>
<tr>
<th>Keyboard input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;cpm assign&quot;</td>
<td>Calls the &quot;Assign&quot; function on the Plant Modeler side.</td>
</tr>
<tr>
<td>&quot;cpm autoroute&quot;</td>
<td>Calls the &quot;Auto routing&quot; tool for automatic routing.</td>
</tr>
<tr>
<td>&quot;cpm cell connectorinformation&quot;</td>
<td>Calls the &quot;Connector information&quot; tool from the &quot;COMOS cell library&quot; toolbar.</td>
</tr>
<tr>
<td>&quot;cpm cell createconnector&quot;</td>
<td>Calls the &quot;Create connector&quot; tool from the &quot;COMOS cell library&quot; toolbar.</td>
</tr>
<tr>
<td>&quot;cpm cell deleteconnector&quot;</td>
<td>Calls the &quot;Delete connector&quot; tool from the &quot;COMOS cell library&quot; toolbar.</td>
</tr>
<tr>
<td>&quot;cpm cell editattributes&quot;</td>
<td>Calls the &quot;Create cell header&quot; tool from the &quot;COMOS cell library&quot; toolbar.</td>
</tr>
<tr>
<td>&quot;cpm cell manipulateconnector&quot;</td>
<td>Calls the &quot;Modify connector&quot; tool from the &quot;COMOS cell library&quot; toolbar.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;cpm centerlineroute&quot;</td>
<td>Calls the &quot;Center line routing&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm changemanager&quot;</td>
<td>Starts the &quot;Change pipe spec&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm changeslope&quot;</td>
<td>Calls the &quot;Change Slope&quot; window.</td>
</tr>
<tr>
<td>&quot;cpm closegap&quot;</td>
<td>Calls the &quot;Close gap&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm configure&quot;</td>
<td>Calls the &quot;Settings&quot; window.</td>
</tr>
<tr>
<td>&quot;cpm connect&quot;</td>
<td>Connects Plant Modeler to COMOS.</td>
</tr>
<tr>
<td>&quot;cpm connectparts&quot;</td>
<td>Calls the &quot;Connect component&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm deletereference&quot;</td>
<td>Calls the &quot;Delete Reference&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm disablestatus&quot;</td>
<td>Disables the status view.</td>
</tr>
<tr>
<td>&quot;cpm disconnect&quot;</td>
<td>Disconnects COMOS from Plant Modeler.</td>
</tr>
<tr>
<td>&quot;cpm disconnectparts&quot;</td>
<td>Calls the &quot;Disconnect components&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm dynplace&quot;</td>
<td>Calls the &quot;Place from COMOS&quot; function.</td>
</tr>
<tr>
<td>&quot;cpm equipmentmodeler&quot;</td>
<td>Calls the &quot;EquipmentModeler&quot; window.</td>
</tr>
<tr>
<td>&quot;cpm exit&quot;</td>
<td>Quits Plant Modeler.</td>
</tr>
<tr>
<td>&quot;cpm insulation change&quot;</td>
<td>Starts the &quot;Change insulation&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm insulation manipulate&quot;</td>
<td>Calls the &quot;Change insulation&quot; function.</td>
</tr>
<tr>
<td>&quot;cpm insulation split&quot;</td>
<td>Calls the &quot;Split insulation&quot; function.</td>
</tr>
<tr>
<td>&quot;cpm insulation stretch&quot;</td>
<td>Calls the &quot;Stretch insulation&quot; function.</td>
</tr>
<tr>
<td>&quot;cpm insulation delete&quot;</td>
<td>Calls the &quot;Delete insulation&quot; function.</td>
</tr>
<tr>
<td>&quot;cpm move&quot;</td>
<td>Calls the &quot;Move component&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm movetoreference&quot;</td>
<td>Calls the &quot;Move to Reference&quot; tool.</td>
</tr>
<tr>
<td>&quot;cpm navigate&quot;</td>
<td>Calls the &quot;Navigate to&quot; function.</td>
</tr>
</tbody>
</table>
6.2 COMOS PDMS Integration

6.2.1 User interface reference

6.2.1.1 "Comos Custom Refresh" PDMS window

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Name&quot; field</td>
<td>The name of the PDMS object. It is connected to the COMOS object that you called using the &quot;Custom Refresh&quot; operation. The field is automatically set.</td>
</tr>
<tr>
<td>&quot;Description&quot; field</td>
<td>The description of the PDMS object. The field is automatically set.</td>
</tr>
</tbody>
</table>
6.2 COMOS PDMS Integration

### 6.2.1.2 "Export to COMOS" PDMS window

The "Export to COMOS" window has the following control areas:

- "Select"
- "Standard Filter"
- "Filter Assigned"
- "PDMS Objects"

### "Select" control group

In this control group, you specify the basic settings for filtering the result list.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Site&quot; field</td>
<td>Displays the site currently selected in PDMS. If the &quot;Track CE&quot; option is</td>
</tr>
<tr>
<td></td>
<td>deactivated: Enter the site below which the objects are searched and for</td>
</tr>
<tr>
<td></td>
<td>which you want to execute an interface operation.</td>
</tr>
<tr>
<td>&quot;Zone&quot; field</td>
<td>Displays the zone currently selected in PDMS. If the &quot;Track CE&quot; option is</td>
</tr>
<tr>
<td></td>
<td>deactivated: Enter the zone below which the objects are searched and for</td>
</tr>
<tr>
<td></td>
<td>which you want to execute an interface operation.</td>
</tr>
<tr>
<td>&quot;Object Type&quot; list</td>
<td>Contains all available subclasses. Select a subclass to define the subclass</td>
</tr>
<tr>
<td></td>
<td>to which the objects in the selection set belong.</td>
</tr>
<tr>
<td>&quot;Track CE&quot; option</td>
<td>Default setting: Activated. When you activate this option, the &quot;Site&quot; and</td>
</tr>
<tr>
<td></td>
<td>&quot;Zone&quot; fields are set automatically depending on the Current Element in the</td>
</tr>
<tr>
<td></td>
<td>Design Navigator.</td>
</tr>
<tr>
<td>&quot;Auto Find&quot; option</td>
<td>When you activate this option, the result list is refreshed automatically</td>
</tr>
<tr>
<td></td>
<td>once a filter is set.</td>
</tr>
<tr>
<td>&quot;Find&quot; button</td>
<td>Refreshes the result list.</td>
</tr>
</tbody>
</table>
"Standard Filter" control group

In this control group, you can choose to filter the result list on the basis of specific texts:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Name" field    | Here you define a name mask. The objects in the result list are filtered on the basis of the name mask. Enter a specific name or replace name parts with placeholders:  
  - "?" stands for a letter  
  - "***" stands for multiple letters  
  Examples:  
  - "BO***" would display all objects whose names begin with BO and meet the remaining filter criteria.  
  - "**1?N0**" would display all objects whose names contain the letter group "1 + any letter + N0" (e.g. B001/N01) and meet the remaining filter criteria. |
| "Description" field | Similar to the "Name" field but applied to the description of the objects. |
| "Display Text" field | In a similar way to the name filter, here you can filter a row in the list using the entire display text. |

"Filter Assigned" control group

In this control group, you can choose to filter the result list on the basis of connection information:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Assigned&quot; option</td>
<td>Activated: Only objects which are potentially connected are displayed in the list. In the case of potentially connected objects, the &quot;Assigned&quot; column has the value &quot;TRUE&quot;.</td>
</tr>
<tr>
<td>&quot;Unassigned&quot; option</td>
<td>Activated: Only objects which are not connected are displayed in the result list. For these objects, the &quot;Assigned&quot; column has the value &quot;FALSE&quot;.</td>
</tr>
<tr>
<td>&quot;Both&quot; option</td>
<td>Activated: The connection information is not taken into account during filtering.</td>
</tr>
</tbody>
</table>

"PDMS Objects" control group

The result list is displayed in this control group. The result list is structured as follows:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Name&quot;</td>
<td>The name of the object in PDMS</td>
</tr>
<tr>
<td>&quot;Description&quot;</td>
<td>The description of the object in PDMS</td>
</tr>
</tbody>
</table>
6.2 COMOS PDMS Integration

### 6.2.1.3 "Query COMOS" PDMS window

**"Query" tab**

On this tab, select the COMOS query you wish to execute.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Query&quot; list</td>
<td>In this list, you find all queries that were defined in advance by your administrator in the form of subclass definition objects. Select a query. Result: The remaining control elements of the &quot;Query&quot; tab are filled with values from the subclass.</td>
</tr>
<tr>
<td>&quot;Description&quot; field</td>
<td>The description text of the selected query.</td>
</tr>
<tr>
<td>&quot;Start Object&quot; field</td>
<td>The start object of the query defined in the COMOS query.</td>
</tr>
<tr>
<td>&quot;Has start query&quot; option</td>
<td>Indicates whether or not a start query was predefined.</td>
</tr>
<tr>
<td>&quot;Output format&quot; field</td>
<td>The file format of the result file.</td>
</tr>
<tr>
<td>&quot;Delimiter&quot; field</td>
<td>If the output format is CSV: The character separating the data in the result file.</td>
</tr>
</tbody>
</table>

**"Filters" tab**

The "Filters" tab is where you configure filters for the query. Only objects that meet all filter conditions are included in the result file.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Columns" area | Lists all columns that were defined for the COMOS query. Each row corresponds to one column. The following column data is displayed:  
  - "Columns" column: The column name  
  - "Label" column: The description text of the column in the query  
  - "Type" column: The data type of the column value |
| "Filters" area | This area shows which filters you have defined for the columns of the query. It is possible to define multiple filters for a column. |
Operators on the "Filters" tab

The following table describes which operators are available for selection and how they interact with the criterion entered in "Criteria":

<table>
<thead>
<tr>
<th>Operator</th>
<th>Criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;eq&quot;</td>
<td>The cell value must match the value specified in the &quot;Criteria&quot; field.</td>
</tr>
<tr>
<td>&quot;neq&quot;</td>
<td>The cell value must not match the value in the &quot;Criteria&quot; field.</td>
</tr>
<tr>
<td>&quot;gt&quot;</td>
<td>The first character of the cell value that is different from the corresponding value in the &quot;Criteria&quot; field must be greater than the corresponding character in the &quot;Criteria&quot; field.</td>
</tr>
<tr>
<td>&quot;lt&quot;</td>
<td>The first character of the cell value that is different from the corresponding value in the &quot;Criteria&quot; field must be smaller than the corresponding character in the &quot;Criteria&quot; field.</td>
</tr>
</tbody>
</table>
| "like"   | The cell value must correspond to a mask specified in the "Criteria" field. In this mask, the following characters are used as placeholders:  
  * "?"  
  * "*" |

Example of a filter on the "Filters" tab

The filter set in the figure above returns "true" for all rows that meet the following condition:
Object like "*001"

Thus, the row with the value "B001" in the "Object" column will be inserted in the result file, but not the row with the value "B002".

If you also set the filter Object lt "Z", the row with the value "B001" in the "Object" column will be inserted into the result file, but not the row with the value "Z001".
The following applies:

- "Z001" like "*001" = True
  "Z001" lt "Z" = False
- "B001" like "*001" = True
  "B001" lt "Z" = True

"B001" is not sufficient for the "Z001" filters.

"Execute" tab

The "Execute" tab is where you define the start object of the query.

If you do not define a start object, the start object predefined by your administrator in the subclass definition object is used.

"Start Object" area

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;System UID&quot;</td>
<td>The start object is identified on the basis of its system UID.</td>
</tr>
<tr>
<td>&quot;Name&quot;</td>
<td>The start object is identified on the basis of its name.</td>
</tr>
<tr>
<td>&quot;Label&quot;</td>
<td>The start object is identified on the basis of its description.</td>
</tr>
<tr>
<td>&quot;System full name&quot;</td>
<td>The start object is identified on the basis of its SystemFullName.</td>
</tr>
<tr>
<td>&quot;Start query&quot;</td>
<td>The start object is selected from a range of objects which are identified by means of a start object query.</td>
</tr>
</tbody>
</table>
"Start Object" field

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Start object&quot; field</td>
<td>Depending on which option you set in the &quot;Start object&quot; area, here you enter the system UID, the name, etc. If you selected the &quot;Start query&quot; option:</td>
</tr>
<tr>
<td></td>
<td>If your administrator has prepared a start object query, this is executed automatically by activating the option. The start object query returns a range of possible start objects, which you can select in the &quot;Start Object&quot; list.</td>
</tr>
</tbody>
</table>

"Results" tab

This tab shows the results of a query.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Number of rows&quot; field</td>
<td>Indicates the number of rows in the result file.</td>
</tr>
<tr>
<td>&quot;Error code&quot; field</td>
<td>Indicates whether the operation was performed successfully or not. Value = &quot;0&quot;: The query has been executed successfully.</td>
</tr>
<tr>
<td>&quot;Error Text&quot; field</td>
<td>Describes an error that has occurred. Remains empty if no errors have occurred.</td>
</tr>
</tbody>
</table>

"Result" area

Use the buttons in this area to select how you wish to proceed with the result file for the "Query Comos data" operation:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Depending on the output format: Have the result displayed in one of the following applications:</td>
</tr>
<tr>
<td></td>
<td>- In Microsoft Excel</td>
</tr>
<tr>
<td></td>
<td>Output format: CSV</td>
</tr>
<tr>
<td></td>
<td>- In a web browser</td>
</tr>
<tr>
<td></td>
<td>Output format: XML</td>
</tr>
<tr>
<td></td>
<td>Save the result in a file.</td>
</tr>
<tr>
<td></td>
<td>The format in which the result is saved corresponds to the output format.</td>
</tr>
<tr>
<td></td>
<td>View a preview of the result in the &quot;Result&quot; area.</td>
</tr>
</tbody>
</table>
6.2 COMOS PDMS Integration

6.2.1.4 "External 3D Interface" tab

**Purpose**

The PipeSpec Designer displays the "External 3D Interface" tab of the pipe spec. You here make the settings that are required to successfully export the pipe specs to PDMS.

"Import/export attributes" control group

- "SPWL" list:
  Specworld (Owner)
  By using the Specworld you can indirectly specify the database to which the export is to be made. In PDMS you can define which Specworld has been assigned to which database.
  The Specworld can also be read from a stored XML file.

- "Nominal pressure (rating)" list:
  Nominal pressure (rating) in PDMS.
  This field stores the standard table for pressures:
  "@3D > 01 > 04 PN-pressure nominal"

- "Purpose" field
  Purpose in PDMS, such as "PIPING" or "NOZZLE"
  This should be set and should match the settings on the "Application limits" tab of the pipe spec.

- "Standard" field:
  Standard: "DIN" or "ANSI"

- "Bore unit" field:
  Nominal diameter unit: "INCH" in the case of ANSI and "MM" for DIN.
  Should be set.
● "Distance unit" field:
  Unit of length: "INCH" in the case of ANSI and "MM" for DIN.

● "Other attributes and UDAs" control group
  You can add UDAs (user defined attributes) and parameters in the table for this control group. These are then exported to PDMS as well.
  – "Name" column:
    Name of the UDAs
    Must have a preceding ":" character, as in ":Test", for instance.
  – "Value" column:
    Value of the attribute or parameter
    You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Mapping PDMS attributes to COMOS".
  – Texts are referenced without quotation marks.

"Naming for pipe spec elements" control group

● "Default mask" field:
  Defines the basis of which rule the names of the PCOMs (= SPCOMs) are to be generated. This is only used if no value has been stored for the "PCOMDefaultName Mask for PCOM name generation" attribute on the "E3D External 3D Interface" tab at a pipe part.

● "Don't create names" list:
  – "Create SPCO name on pipe spec element" value:
    As soon as you drag a PPC object to the "Components" tab in the COMOS PipeSpec Designer, a window appears in which you can modify the stored naming rule. All PCOMs (=SPCOMs) on the "PDMSName" tab of the pipe spec element are exported.
    You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Naming conventions" and keyword "PDMS PipeSpec elements" tab".
  – "Do not generate SPCO name when pipe spec element is created" value:
    The above window does not appear and the PCOMs (=SPCOMs) are not rolled out and automatically named. The user can trigger the naming process at a later point in time.

6.2.1.5  "Selector" tab

General

The selectors of a PDMS pipe spec are displayed in the PipeSpec Designer on the "Selector" tab.
On the tab, the pipe parts of a pipe spec are arranged according to GType. See also section Selectors (Page 134).

The answers to the selectors are read from the "E3D External 3D Interface" tab at the pipe part of the pipe spec - either at the PPC object or at the pipe spec element. You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Answers for selectors".

First of all, the pipe parts are arranged according to their GType. The individual GTypes are displayed on the tabs.

Additional selectors for all pipe parts of the GType from the relevant pipe spec are displayed on each of these tabs in addition to information such as the name and the nominal diameter.

The number, types, and designations of the selectors can be chosen freely.

The order of the selectors is defined by the selector structure of the pipe spec. Underneath the pipe spec there is the "SelectorTree Selector" node for this purpose. See also section Display PipeSpecs (Page 145).

The "Selector type", "Question", and other attributes are updated in the detail area below the table according to the selected column. For information regarding the detail area, see also section Detail area (Page 140).

### PDMS-side interface operations

#### Structure

The table is structured as follows in the COMOS DB:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Name&quot;</td>
<td>The name of the pipe part.</td>
</tr>
<tr>
<td>&quot;PBOR0&quot;</td>
<td>The nominal diameter for pipe parts with one or the same nominal diameter (&quot;PBOR1&quot; for nominal diameter1, &quot;PBOR2&quot; for nominal diameter2, etc.)</td>
</tr>
<tr>
<td>&quot;BDIA&quot;</td>
<td>For bolts only: The BDIA (bolt dimension).</td>
</tr>
</tbody>
</table>

#### 6.2.1.6 Construction assistant: Upper area

The area at the top contains the following buttons:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>📦</td>
<td>&quot;Open database&quot;</td>
<td>Opens the &quot;Open database&quot; window</td>
</tr>
<tr>
<td>📦</td>
<td>&quot;Open project&quot;</td>
<td>Opens the &quot;Open database&quot; and &quot;Open project&quot; windows</td>
</tr>
<tr>
<td>✅</td>
<td>&quot;Construction Assistant Log&quot;</td>
<td>Hides/shows the log in the lower area of theConstruction Assistant. The Construction Assistant log outputs the log text and error messages of the interface operations.</td>
</tr>
<tr>
<td>🌐</td>
<td>&quot;Print&quot;</td>
<td>Opens the COMOS Print Manager.</td>
</tr>
</tbody>
</table>
6.2.1.7 Options

Calling options

Procedure
You can call the options of the PDMS interface from any tab.
Do this by clicking the "Options" button on the toolbar of the active tab.

"Cat&Specs" tab
On the "Cat&Specs" tab you find the options for the "Cates" and "Pipe specs" tabs of the PDMS interface.

Options group "Cates"

Purpose
The "Name verification" control group is where you define the name verification procedure for Catrefs, Detrefs, and SPCOs.
A name check can be useful if objects have been created by copying. It should not be activated permanently, since a check can be very time-consuming.

Possible settings
You can choose from the following settings for Catrefs, Detrefs, and SPCOs:

- "Do not check": The name is not checked.
- "Check and correct":
  - "Catrefs" list: It is checked if the Catref for the SCOMs matches those that should be there according to the formula for the name generation.
  - "Detrefs" list: A check is carried out to ascertain whether the Detrefs match those which should be there according to the formula for name generation.
  - "SPCOs" list: It is checked if the names of the SPCOs match those which should be there according to the formula for the name generation.

If there are deviations, the values are automatically recalculated using the formulas and the old values are overwritten.

- "Check and only correct after inquiry": Like "Check and correct", although the values are only recalculated and the old values are overwritten if you explicitly authorize the change.

You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Mapping PDMS attributes to COMOS".
Save settings

You can save the settings you made for various project types and users. Do this by clicking the "Save settings in profile" button.

You find additional information on using the dialog window in the "Basic Operation" manual.

Options group "PipeSpecs"

Purpose

The "Export options" control group is where you specify details for the exporting of pipe specs.

Possible settings

Select one of the following settings from the list:

- "Export pipe specs with Cates":
  The pipe part catalog elements (Cates) and the pipe specs including the pipe spec elements (SPCOMs) are exported during the export operation.
  This setting should be selected if you are exporting for the first time or if changes have been made to the catalog objects.
  You can find additional information on this topic in the "3D Integration Administration" manual, keyword "PDMS pipe spec elements" tab.

- "Export pipe specs only (without Cates)":
  Only the pipe specs and the pipe spec elements are exported during the export operation, but not the individual catalog objects (Cates).
  The export operation is faster since less data needs to be exported.
  Requirement: The catalog objects must already exist in PDMS.

Option "Delete empty selectors"

If you activate this option, any blank selectors are deleted in PDMS after a prompt.

See also option "Move unused SPCOMs to LIMBO".

Option "Move unused SPCOMs to LIMBO"

When you enable this option, all pipe spec elements that are not included in the export and only available in PDMS are moved to the "LIMBO" pipe spec after confirmation.

This requires that the SPCOs that are not used exist in the pipe spec in PDMS.

You must check carefully to ensure that you no longer need the SPCOs in the pipe spec.

Background:
If you only export a part of the pipe spec elements that are included in the pipe spec, COMOS cannot tell if you are doing this because you want to save time or because the elements that are not exported are not to be included (any longer) in the pipe spec in PDMS.

You decide how COMOS is to deal with the pipe spec elements that exist in PDMS but are not a constituent part of the stock of data that is to be imported.

Example for cases in which this option makes sense:

- The number of pipe spec elements differs, for example, as a result of deleting or copying pipe spec elements.
- Pipe spec elements were renamed

Save settings

You can save the settings you made for various project types and users. Do this by clicking the "Save settings in profile" button.

You find additional information on using the dialog window in the "Basic Operation" manual.

"Configure PDMS SpecInfo" tab

Purpose

The "Configure PDMS SpecInfo" tab is where you specify which columns are visible in the table on the "Pipe specs" tab.

Column "Columns for 'PDMS Info' query"

You can activate/deactivate the columns of the tables on the "Pipe specs" tab using the individual options.

See also section Display PipeSpecs (Page 145); display mode "Tables".

Save settings

You can save your settings for various project types and users. Do this by clicking the "Save settings in profile" button.

You find additional information on using the dialog window in the "Basic Operation" manual.

"Interface paths" tab

On the "Interface paths" tab, you can use the "ExchangePathOffline" attribute to specify the "!PATH" variable for CatSpec macros in offline mode.
6.2 COMOS PDMS Integration

6.2.2 List of interface operations and internal names

Names of interface operations in the software

The following table provides you with an overview of how the interface operations are named in the software.

Background: Whenever you implement a pre/post executable, you transfer the name of the interface operation before or after the function is executed in the InterfaceOp parameter.

<table>
<thead>
<tr>
<th>Interface operations that start in COMOS</th>
<th>Name in documentation</th>
<th>Name in software</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Export&quot;</td>
<td>&quot;Export&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Refresh&quot;</td>
<td>&quot;Refresh&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Custom Refresh&quot;</td>
<td>&quot;CustomRefresh&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Assign&quot;</td>
<td>&quot;Assign&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Unassign&quot;</td>
<td>&quot;Unassign&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Check status&quot;</td>
<td>&quot;CheckStatus&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Rerun documents&quot;</td>
<td>&quot;RerunDocuments&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Add&quot;</td>
<td>&quot;Add&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Remove&quot;</td>
<td>&quot;Remove&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Mark&quot;</td>
<td>&quot;Mark&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Zoom&quot;</td>
<td>&quot;Zoom&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Select&quot;</td>
<td>&quot;Select&quot;</td>
<td></td>
</tr>
</tbody>
</table>

Interface operations that start in PDMS

<table>
<thead>
<tr>
<th>Name in documentation</th>
<th>Name in software</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Export&quot;</td>
<td>&quot;Import&quot;</td>
</tr>
<tr>
<td>&quot;Navigate&quot;</td>
<td>&quot;Navigate&quot;</td>
</tr>
<tr>
<td>&quot;Unassign&quot;</td>
<td>&quot;Unassign&quot;</td>
</tr>
<tr>
<td>&quot;Reassign&quot;</td>
<td>&quot;Reassign&quot;</td>
</tr>
<tr>
<td>&quot;Check status&quot;</td>
<td>&quot;CheckStatus&quot;</td>
</tr>
<tr>
<td>&quot;Query Comos data&quot;</td>
<td>&quot;QueryComosData&quot;</td>
</tr>
<tr>
<td>&quot;Import DocLinks&quot;</td>
<td>&quot;ImportDocLinks&quot;</td>
</tr>
</tbody>
</table>

You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Using pre/post executables".